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About this document

Audience
The intended audience for this document includes the following groups:

• maintenance technicians and experienced installers

• network administrators

Required reading
Before using this book, you should be familiar with the Release Notes for the
Universal Edge 9000 element management system (uEMS). The Release
Notes are provided on the uEMS software CD-ROM.

If you have limited experience with Hewlett Packard’s™ HP OpenView™

How to use t
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Network Node Manager™ graphical user interface software, you should read
Appendices A and B before using this guide.

his guide
This guide is designed to be used after the following events have occurred:

• uEMS software is operational; that is, it has been installed and connected
to the network

• The Universal Edge 9000 (UE9000) digital multiple switch (DMS) is
installed; cables and power are connected

This guide should be used with the Hewlett Packard HP OpenView Network
Node Manager documentation.
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For information on the AccessN
following documents:

• UE9000 Pre-installation Qu
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• UE9000 LED Quick Refere
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The following documentation is
element management system (
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• uEMS Release Notes
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Radio-frequency emissions notice
The following regulatory notice applies to UE9000-DMS equipment:

“This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference when
operated in a commercial environment. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance
with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area may cause
harmful interference, in which case the user will be required to correct the
interference at his own expense.”

About the UE9000-DMS
The UE9000-DMS is a line concentrating module (LCM) variant peripheral
for the DMS-100. It consists of a bayframe, UE9000 DMS shelf, and circuit
packs that provide voice and data services on residential and business loops.
The UE9000-DMS supports the following circuit packs:

• ATM core cards (asynchronous transfer mode)

• TDM core card (time division multiplexing)

• SI card (system interface)
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

• Power I/O card

• Multi-circuit line cards (MLCs)

The UE9000 element management system (uEMS) is the software program
that controls the UE9000-DMS. You use uEMS to provision and monitor data
and voice services independently from one another. The uEMS runs on a
Hewlett-Packard (HP) OpenView workstation and uses a graphical user
interface.
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Provisioning data services 1-

This chapter contains information on:

• provisioning the Universal Edge 9000 (UE9000) using the UE9000
element management system graphical user interface (uEMS GUI)

• updating a UE9000 component’s provisioning information

• removing a UE9000 component from the uEMS database

Note 1: This book does not contain information on the initial setup and
commissioning of the UE9000 data network. For this information, see the
UE9000 Data System Setup Guide.

Note 2: For detailed information on how to engineer the UE9000 data
network and Nortel Networks’ recommended configurations for the
UE9000 data network, see theUE9000 Data Network Design Guidelines.

Chapter con
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

tents
This chapter contains the following topics:

• Provisioning order on page 1-4

• Navigation aids on page 1-5

• Removing hardware on page 1-62
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ing tasks.

See

or Procedure 1-1 on page 1-7

ors Procedure 1-2 on page 1-13

Procedure 1-3 on page 1-22

Procedure 1-4 on page 1-25

Procedure 1-5 on page 1-28

Procedure 1-6 on page 1-34

Procedure 1-7 on page 1-38

cards Procedure 1-8 on page 1-40

uits Procedure 1-9 on page 1-45

Procedure 1-10 on page 1-52

Procedure 1-11 on page 1-55

Procedure 1-12 on page 1-58

Procedure 1-13 on page 1-60

Procedure 1-14 on page 1-64

Procedure 1-15 on page 1-67

line Procedure 1-16 on page 1-70

Procedure 1-17 on page 1-73
This chapter contains the follow

Task

Provisioning ATM service descript
groups

Provisioning ATM service descript

Provisioning a network element

Provisioning a UE9000 shelf

Provisioning an ATM core card

Provisioning DS1 carriers

Verifying DS3 carrier provisioning

Provisioning xDSL multi-circuit line

Provisioning xDSL subscriber circ

Verifying data service

Checking ADSL circuit capabilities

Updating provisioning information

Force provisioning

Unprovisioning subscriber
cross-connects

Unprovisioning subscriber circuits

Unprovisioning xDSL multi-circuit 
cards

Unprovisioning DS1 carriers
UE9000 DMS 297-8391-302 NA015

Unprovisioning ATM core cards Procedure 1-18 on page 1-75

Unprovisioning a UE9000 shelf Procedure 1-19 on page 1-77

Unprovisioning a network element Procedure 1-20 on page 1-78

Unprovisioning ATM service descriptors Procedure 1-21 on page 1-79

—continued—
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Unprovisioning ATM service descriptor
groups

Procedure 1-22 on page 1-80

Viewing service descriptors Procedure 1-23 on page 1-81

Opening a temporary read-write map Procedure 1-24 on page 1-82

—end—

Task See
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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order for provisioning UE9000 components
ing must be done in the order specified in

quipment that has not been installed, a “No
 the equipment icon.

See

up Procedure 1-1 on page 1-7

Procedure 1-2 on page 1-13

Procedure 1-3 on page 1-22

Procedure 1-4 on page 1-25

Procedure 1-5 on page 1-28

Procedure 1-6 on page 1-34

Procedure 1-7 on page 1-38

Procedure 1-8 on page 1-40

Procedure 1-9 on page 1-45

Procedure 1-10 on page 1-52
Provisioning order
Table 1-1 describes the correct 
using the uEMS GUI. Provision
Table 1-1.

Note: If you pre-provision e
Hardware” alert appears on

Table 1-1
UE9000 provisioning order

Step Task

1 ATM service descriptor gro

2 ATM service descriptor

3 Network element

4 UE9000 shelf

5 ATM core card

6 DS1 carrier

OR

DS3 carrier

7 xDSL Multi-circuit line card

8 xDSL Subscriber circuit

9 Verify data service
UE9000 DMS 297-8391-302 NA015
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Maintenance
Use the following procedures for maintenance purposes.

Navigation aids
This section contains aids to help you navigate the uEMS GUI.

Figure 1-1shows the buttons in the tool bar that are used to navigate between
different submaps.

Figure 1-1
Tool bar navigation buttons

UE-1017

Table 1-2
UE9000 provisioning maintenance procedures

Task See

Checking ADSL circuit capabilities Procedure 1-11 on page 1-55

Updating provisioning information Procedure 1-12 on page 1-58

Force provisioning Procedure 1-13 on page 1-60

UE-1017
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Figure 1-2 on page 1-6 shows:

• the uEMS GUI submap hierarchy

• which symbols are provisioned in each submap

• how to navigate between different submaps

For more information about the uEMS submap hierarchy, seeuEMS submap
hierarchy on page 4-7.

ATM SD Config

Close
submap

Go to
Root

submap

Home
submap

Quick
Navigator

HP-OV
version

Go to parent
submap 

Go to service
descriptor

group submap
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UE-1073

ubmap
elf 1

LC2LC1 LC3

UE-1073

NE1

HSTP-Network
submap

NE2 NE3

Shelf 1

NE submap
for NE3

Shelf 2

CCT1

LC submap
for LC1

CCT2 CCT3 CCT4
Figure 1-2
Submap navigation chart

Internet HSTP-
Network

Default SDG1

ATMSD
Root submap

Atmif A

Shelf S
for Sh

SD1 SD2

ATM SD
Config Submap

Click on ATM 
SD Config tool
bar button

SDG Submap
for SDG1

Carrier 1

DS1 IMA 
DAC submap
for Atmif A

Carrier

DS3

DS3 DAC
submap
for Atmif A

Carrier 2 Carrier 3 Carrier 4

Carrier 5 Carrier 6 Carrier 7 Carrier 8
UE9000 DMS 297-8391-302 NA015

Subscriber Loop
submap for CCT3

Atmif A LC1 CCT3 CPE

8160/8160
640/640
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Procedure 1-1
Provisioning ATM service descriptor groups

Use this procedure to provision service descriptor groups (SDG) using the
UE9000 element management system (uEMS). If you wish to use the
provided default SDG, then you may skip this procedure.

Note: Service descriptors (SD) must be provisioned before the
subscriber circuits cross-connects (virtual circuits) are provisioned.

When an SD is provisioned, it must be provisioned within an SDG. An SDG
can contain any number of SDs. For more information about service
descriptors, seeProcedure 1-2, “Provisioning ATM service descriptors” on
page 1-13.

Note 1: The uEMS software automatically provisions one SDG when a
map is created. This is the default SDG.

Note 2: Virtual paths (VP) and SD names within the same SDG cannot
have the same value. VPs and SD names with the same value can be
provisioned in different SDGs.

Before you begin
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Make sure you have all the information required for the provisioning fields
shown inTable 1-3 on page 1-12.

Verify the following:

• the uEMS software is running (seeProcedure 5-1, “Starting the uEMS
graphical user interface” on page 5-2).

Note: For information on installing the uEMS software, see theUE9000
Data System Setup Guide.

• VPs are provisioned in the ATM network

• the VP names on the ATM core card and the ATM switch match

—continued—
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ee Figure 1-2 on page 1-6).

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

 button in the tool bar.

ap with the Default symbol appears.

e default SDG, stop now and go to
ing ATM service descriptors” on page 1-13.

enu, select Add Object .

ialog appears.

g, click once on the UE9000 symbol class.

9000 symbol class appear in the bottom

ialog, drag the SdGroup symbol subclass
g the middle mouse button (see Figure 1-3
ursor is in the submap screen, release the

pears.
Procedure 1-1 (continued)
Provisioning ATM service descriptor groups

Action

Step Action

1 Go to the Root submap (s

2 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

3 Click the ATM SD Config

The ATM SD Config subm

Note: If you wish to use th
Procedure 1-2, “Provision

4 From the Edit pull-down m

The Add Object Palette d

5 In the top field of the dialo

The subclasses for the UE
field of the dialog.

6 In the bottom field of the d
to the submap screen usin
on page 1-9). When the c
middle mouse button.

The Add Object dialog ap

—continued—
UE9000 DMS 297-8391-302 NA015
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Procedure 1-1 (continued)
Provisioning ATM service descriptor groups

Step Action

Figure 1-3
Adding an object

UE-1074

NE/Shelf

Add Object Palette

Symbol Classes:

UE9000

Symbol Subclasses for Class UE9000:

UE-1074

1

2

UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

7 In the Label field, type the name you want to appear under the SDG
symbol.

Note: The Label field is optional. If nothing is entered in this field, the
uEMS assigns a label, using the name entered in the Name field (see
step 12 on page 1-10).

—continued—

CAUTION
Risk of database corruption
Do not enter a label that is already in use, or the
uEMS database will become corrupted.

3
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 Application in the Object Attributes field.

ibutes dialog appears.

le field for the SDG using Table 1-3 on

click the Verify button and follow any
uring verification.

lete, click the OK button.

pears.

ee Figure 1-4).

n Name button.

me dialog appears.

k once on the first name in the list.

g appears.
Procedure 1-1 (continued)
Provisioning ATM service descriptor groups

Step Action

8 Double-click UE9000 Map

The Add Object - Set Attr

9 Complete the provisionab
page 1-12.

10 When you have finished, 
instructions that appear d

11 When verification is comp

The Add Object dialog ap

12 Set the selection name (s

a. Click the Set Selectio

The Set Selection Na

b. In the Name field, clic

c. Click the OK button.

The Add Object dialo

—continued—
UE9000 DMS 297-8391-302 NA015
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Procedure 1-1 (continued)
Provisioning ATM service descriptor groups

Step Action

Figure 1-4
Setting the selection name

UE-1019

Add Object

Set Selection Name
LC2. Midtown

LC2. Midtown

NE.node/SHELF.1/LC.1

NE.node/SHELF.1/LC.2

Name:

Selection Name:

Selection Name:

LC2. Midtown  Set Selection Name

2

OK

UE-1019
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

13 Click the OK button.

The Add Object Palette appears.

14 Click the Close  button.

The SDG symbol appears in the submap.

Note: You can leave the Add Object Palette open when adding
multiple objects.

—end—

1 3
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ption

 of the service descriptor group
Table 1-3
Service descriptor group fields

Field Parameter values Descri

HSTP-Name for
SD Group

This is not a provisionable field.

SD Group name text string

Note: Illegal characters
include slashes, spaces,
semicolons, or periods. This
field is case-sensitive.

name
UE9000 DMS 297-8391-302 NA015
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Procedure 1-2
Provisioning ATM service descriptors

Use this procedure to provision service descriptors (SD) using the UE9000
element management system (uEMS).

Note: SDs must be provisioned before the subscriber cross-connects
(virtual circuits) are provisioned.

SDs are used by the uEMS to define and identify each virtual path (VP)
between the ATM core card and the ATM edge switch. Each VP on the
network side of the ATM core card is associated with a SD. An SD contains
virtual path identifier (VPI), traffic, and quality of service (QoS) information.
When you provision the first subscriber circuit on a shelf with an SD, the
uEMS provisions a VP on the network side of the ATM core card using that
SD’s provisioned values.

SDs simplify the provisioning of subscriber cross-connects. Using SDs, you
can define the traffic and QoS characteristics for each subscriber’s
cross-connects by entering one word, rather than a long list of values.

Defining service descriptors
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

The main approaches to defining SDs are:

• an SD may be associated with service provider and QoS values. The VP
on the network side of the ATM core card transports data traffic with a
specific QoS to one service provider.

An example SD name with this approach is Nortel-Gold. This example
VP transports all data traffic addressed to Nortel using the best quality of
service.

• an SD may be associated with only QoS values. The VP on the network
side of the ATM core card transports all data traffic with a specific QoS.
Because no service provider is defined, a service gateway on the other
side of the ATM network must route the data traffic to each service
provider.

An example SD name with this approach is Gold. The example VP
transports all data traffic using the best quality of service no matter what
service provider the data traffic is addressed to.

—continued—
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, you must do the following:

rovisioning ATM service descriptor groups”

 information required for the provisioning
efer toTable 1-4 on page 1-16. For DS3
age 1-18. Default values are in bold type.

or group (SDG) submap (see Figure 1-2 on
ng on the SDG symbol.

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

he Edit pull-down menu.

ialog appears.

g, click the UE9000 symbol class.

9000 symbol class appear in the bottom

ialog, drag the Sd symbol subclass to the
 middle mouse button (see Figure 1-3 on
or is in the submap screen, release the

pears.
Procedure 1-2 (continued)
Provisioning ATM service descriptors

Requirements
Before beginning this procedure

• CompleteProcedure 1-1, “P
on page 1-7.

• Make sure you have all the
fields. For DS1 IMA ATM, r
ATM, refer toTable 1-5 on p

Action

Step Action

1 Go to the service descript
page 1-6) by double-clicki

2 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

3 Select Add Object  from t

The Add Object Palette d

4 In the top field of the dialo

The subclasses for the UE
field of the dialog.

5 In the bottom field of the d
submap screen using the
page 1-9). When the curs
middle mouse button.

The Add Object dialog ap

6 In the Label field, type the
UE9000 DMS 297-8391-302 NA015

 name you want to appear under the SD
symbol.

Note: The Label field is optional. If nothing is entered in this field, the
uEMS assigns a label, using the name entered in the Name field (see
step 11 on page 1-15).

—continued—
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Procedure 1-2 (continued)
Provisioning ATM service descriptors

Step Action

7 Double-click UE9000 Map Application in the Object Attributes field.

The Add Object - Set Attributes dialog appears.

8 Complete the provisionable fields for the SD using Table 1-4 on

CAUTION
Risk of database corruption
Do not enter a label that is already in use, or the
uEMS database will become corrupted.

CAUTION
Loss of service
The values provisioned for each SD must match
the values provisioned for the corresponding VP
in the ATM network. If the SD and VP values do
not match, ATM traffic from the UE9000 shelf will
not be passed through the network.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

page 1-16 for DS1 IMA and Table 1-5 on page 1-18 for DS3.

9 When you have finished, click the Verify button and follow any
instructions that appear during verification.

10 When verification is complete, click the OK button.

The Add Object dialog appears.

11 Set the selection name (see Figure 1-4 on page 1-11).

a. Click the Set Selection Name button.

The Set Selection Name dialog appears.

b. In the Name field, click once on the first name in the list.

c. Click the OK button.

The Add Object dialog appears.

12 Click the OK button.

The Add Object Palette appears.

—continued—
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n the submap.

dd Object Palette open when adding

, select:

ription

e of the service descriptor

 alphanumeric and symbol characters.
s, spaces, semicolons, or periods. This

ual path identifier. This is the address of
 virtual path that the SD is
ss-connected to.

 before the number you enter in the VPI
0” before the number, an incorrect VPI is
“0” before a number identifies the number
re a number identifies the number as a
workstation then converts the number to
Procedure 1-2 (continued)
Provisioning ATM service descriptors

Step Action

13 Click the Close  button.

The SD symbol appears i

Note: You can leave the A
multiple objects.

14 To close the SDG submap

Map -> Close Submap

—end—

Table 1-4
DS1 Service descriptor fields

Field Parameter values Desc

HSTP-Name for
Service Descriptor

This is not a provisionable field.

SD name text string nam

Note: This parameter can have
Illegal characters include slashe
field is case-sensitive.

VPI 0 to 255 virt
the
cro

Note: Do not add a “0” or “0x0”
field. When you add a “0” or “0x
provisioned and service is lost. A
as an octal number. A “0x0” befo
hexadecimal number. The uEMS
UE9000 DMS 297-8391-302 NA015

its decimal equivalent. For example, when you enter 012, the uEMS
workstation reads this number as an octal number and converts the
number to its decimal value of 10.
Correct: 12, 255
Incorrect: 012, 0255, 0x012

—continued—
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(Downstream/
Upstream) Service
Category

service class for the downstream/upstream virtual path

Unset not available

ubr unspecified bit rate

(Downstream/
Upstream) Traffic
Descriptor

quality of service (QoS) parameter

Unset not available

atmNoClpTaggingNoScr no cell loss priority tagging, no sustained cell
rate (used with ubr Service Category value
only) = does not attempt to manage the ATM
traffic flow.

atmNoClpNoScrCdvt no cell loss priority tagging, no sustained cell
rate, cell delay variation tolerance

(Downstream/
Upstream) Peak cell
rate (cells/s)

1 to 28744 defines the peak cell rate in cells per second
(specify for both upstream and downstream).
This value is calculated based on the
bandwidth of the DS1.

Table 1-4
DS1 Service descriptor fields (continued)

Field Parameter values Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

(Downstream/
Upstream) CDVT
(microseconds)

0 cell delay variation tolerance (specify for both
upstream and downstream)

—end—
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ription

e of the service descriptor

phanumeric and symbol characters. Illegal
s, semicolons, or periods. This field is

ual path identifier. This is the address of
virtual path that the SD is cross-connected

fore the number you enter in the VPI field.
e the number, an incorrect VPI is
“0” before a number identifies the number
e a number identifies the number as a
orkstation then converts the number to its
hen you enter 012, the uEMS workstation

ber and converts the number to its decimal

upstream virtual paths

 available

pecified bit rate

pecified bit rate with peak cell rate

pecified bit rate with minimum cell rate
Table 1-5
DS3 Service descriptor fields

Field Parameter values Desc

HSTP-Name for
Service Descriptor

This is not a provisionable field.

SD name text string nam

Note: This parameter can have al
characters include slashes, space
case-sensitive.

VPI 0 to 255 virt
the
to.

Note: Do not add a “0” or “0x0” be
When you add a “0” or “0x0” befor
provisioned and service is lost. A
as an octal number. A “0x0” befor
hexadecimal number. The uEMS w
decimal equivalent. For example, w
reads this number as an octal num
value of 10.
Correct: 12, 255
Incorrect: 012, 0255, 0x012

(Downstream/
Upstream) Service
Category

service class for the downstream/

Unset not

ubr uns

ubrPcr uns

ubrMcr uns
UE9000 DMS 297-8391-302 NA015

cbr constant bit rate

rtVbr real-time variable bit rates

—continued—
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UBR Service Category traffic parameters

(Downstream/
Upstream) Traffic
Descriptor

quality of service (QoS) parameter

Unset not available

atmNoClpTaggingNoScr no cell loss priority tagging, no sustained cell
rate; does not attempt to manage the ATM
traffic flow

atmNoClpNoScrCdvt no cell loss priority tagging, no sustained cell
rate, cell delay variation tolerance

(Downstream/
Upstream) Peak
cell rate (cells/s)

1 to 28744 defines the peak cell rate in cells per second

(Downstream/
Upstream) (CDVT)
(microseconds)

100 - best effort cell delay variation tolerance (it is not
recommended to change from the default
value)

UBR-PCR and UBR-MCR Service Category traffic parameters

Table 1-5
DS3 Service descriptor fields  (continued)

Field Parameter values Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

(Downstream/
Upstream) Traffic
Descriptor

quality of service (QoS) parameter

Unset not available

atmClpNoTaggingMcr cell loss priority tagging with minimum cell
rate guaranteed

(Downstream/
Upstream) Peak
cell rate (cells/s)

1 to 28744 defines the peak cell rate in cells per second

(Downstream/
Upstream) (CDVT)
(microseconds)

100 - best effort cell delay variation tolerance (it is not
recommended to change from the default
value)

(Downstream/
Upstream)
Minimum cell rate
(cells/s)

0 to 100604 defines the minimum guaranteed cell rate by
network

—continued—
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r

 available

formance measurement is done through
 use of a continuous state leaky bucket
orithm at the ATM network access node.

ines the peak cell rate in cells per second

 delay variation tolerance (it is not
ommended to change from the default
e)

r

 available

formance measurement is done through
 use of a continuous state leaky bucket
orithm that measures the cell traffic coming

 the user against the parameters
cified for a particular service contract.

ines the peak cell rate in cells per second

 delay variation tolerance (it is not

ription
CBR Service Category traffic parameters

(Downstream/
Upstream) Traffic
Descriptor

quality of service (QoS) paramete

Unset not

atmClpTransparentNoScr Con
the
alg

(Downstream/
Upstream) Peak
cell rate (cells/s)

1 to 28744 def

(Downstream/
Upstream) (CDVT)
(microseconds)

100 - best effort cell
rec
valu

rt-VBR Service Category traffic parameters

(Downstream/
Upstream) Traffic
Descriptor

quality of service (QoS) paramete

Unset not

atmClpTransparentScr Con
the
alg
from
spe

(Downstream/
Upstream) Peak
cell rate (cells/s)

1 to 28744 def

(Downstream/ 100 - best effort cell

Table 1-5
DS3 Service descriptor fields  (continued)

Field Parameter values Desc
UE9000 DMS 297-8391-302 NA015

Upstream) (CDVT)
(microseconds)

recommended to change from the default
value)

—continued—
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(Downstream/
Upstream)
Sustainable cell
rate (SCR) (cells/s)

0 to 100604 defines the upper edge of the average cell
rate that will be transmitted

(Downstream/
Upstream)
Maximum burst
size (MBS) (cells)

0 to 100604 used with the SCR to specify the number of
cells per second that can be transmitted at the
peak rate and still be in conformance with the
traffic management algorithm

—end—

Table 1-5
DS3 Service descriptor fields  (continued)

Field Parameter values Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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a network element using the UE9000 element

ormation required for the provisioning fields

submap (see Figure 1-2 on page 1-6).

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

enu, select Add Object .

ialog appears.

g, click once on the UE9000 symbol class.

9000 symbol class appear in the bottom

ialog, drag the NE symbol subclass to the
 middle mouse button (see Figure 1-3 on
or is in the submap screen, release the

pears.

 name you want to appear under the NE
Procedure 1-3
Provisioning a network element

Use this procedure to provision
management system (uEMS).

Before you begin
Ensure that you have all the inf
shown inTable 1-6 on page 1-24.

Action

Step Action

1 Go to the HSTP-Network 

2 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

3 From the Edit pull-down m

The Add Object Palette d

4 In the top field of the dialo

The subclasses for the UE
field of the dialog.

5 In the bottom field of the d
submap screen using the
page 1-9). When the curs
middle mouse button.

The Add Object dialog ap

6 In the Label field, type the
symbol.
UE9000 DMS 297-8391-302 NA015

Note: The Label field is optional. The uEMS assigns a label if this
field is empty.

—continued—
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Procedure 1-3 (continued)
Provisioning a network element

Step Action

7 Double-click UE9000 Map Application in the Object Attributes field.

The Add Object - Set Attributes dialog appears.

8 Complete the provisionable fields for the NE you are provisioning.
See Table 1-6 on page 1-24.

9 When you have finished, click the Verify button and follow any
instructions that appear during verification.

10 When verification is complete, click the OK button.

The Add Object dialog appears.

11 Set the selection name (see Figure 1-4 on page 1-11).

a. Click the Set Selection Name button.

CAUTION
Risk of database corruption
Do not enter a label that is already in use, or the
uEMS database will become corrupted.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

The Set Selection Name dialog appears.

b. In the Name field, click once on the first name in the list.

c. Click the OK button.

The Add Object dialog appears.

12 Click the OK button.

The Add Object Palette appears.

13 Click the Close  button

The symbol for the NE appears in the submap.

Note: You can leave the Add Object Palette open when adding
multiple objects.

—continued—
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9000 component symbol for a shadow.

00 component was added to the uEMS
incorrectly.

the symbol by selecting Delete symbol
 right-click menu.

n the UE9000 component again.

or uEMS trouble events. See the UE9000
sting and Troubleshooting Guide for more
tion.

nished with this procedure.

scription

me of the NE
Procedure 1-3 (continued)
Provisioning a network element

Step Action

Troubleshooting
14 Check the provisioned UE

—end—

If the
symbol is Then

shadowed The UE90
database 

• Delete 
from the

• Provisio

• Check f
Data Te
informa

not
shadowed

You are fi

Table 1-6
Network element fields

Field Parameter values De

HSTP-Name for
the NE

This is not a provisionable field.

Network Element
ID

text string

Note: This parameter can have
alphanumeric and symbol
characters. Illegal characters

na
UE9000 DMS 297-8391-302 NA015

include slashes, spaces,
semicolons, or periods. This
field is case-sensitive.

Network Element
Type

• UE-DMS

• AccessNode

• for UE9000 shelf in UE9000-DMS

• for UE9000 shelf in AccessNode (digital
loop carrier)
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Procedure 1-4
Provisioning a UE9000 shelf

Use this procedure to provision a UE9000 shelf using the UE9000 element
management system (uEMS) graphical user interface (GUI).

Before you begin
Ensure that you have all the information required for the provisioning fields
shown inTable 1-7 on page 1-27.

Action

Step Action

1 Go to the NE submap (see Figure 1-2 on page 1-6).

2 Confirm that [Read-Write] appears in the lower left corner of the
submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.

3 From the Edit pull-down menu, select Add Object .

The Add Object Palette dialog appears.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

4 In the top field of the dialog, click once on the UE9000 symbol class.

The subclasses for the UE9000 symbol class appear in the bottom
field of the dialog.

5 In the bottom field of the dialog, drag the Shelf  symbol subclass to
the submap screen using the middle mouse button (see Figure 1-3
on page 1-9). When the cursor is in the submap screen, release the
middle mouse button.

The Add Object dialog appears.

6 In the Label field, type the name you want to appear under the
UE9000 component symbol.

Note: The Label field is optional. The uEMS assigns a label if this
field is empty.

—continued—
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 Application in the Object Attributes field.

ibutes dialog appears.

le fields for the UE9000 shelf you are
7 on page 1-27.

click the Verify button and follow any
uring verification.

lete, click the OK button.

pears.

ee Figure 1-4 on page 1-11).

n Name button.

me dialog appears.

k once on the first name in the list.

g appears.

ppears.

ppears in the submap.

ION
database corruption
enter a label that is already in use, or the
database will become corrupted.
Procedure 1-4 (continued)
Provisioning a UE9000 shelf

Step Action

7 Double-click UE9000 Map

The Add Object - Set Attr

8 Complete the provisionab
provisioning. See Table 1-

9 When you have finished, 
instructions that appear d

10 When verification is comp

The Add Object dialog ap

11 Set the selection name (s

a. Click the Set Selectio

The Set Selection Na

b. In the Name field, clic

c. Click the OK button.

The Add Object dialo

12 Click the OK button.

The Add Object Palette a

13 Click the Close  button

The symbol for the shelf a

CAUT
Risk of 
Do not
uEMS 
UE9000 DMS 297-8391-302 NA015

Note: You can leave the Add Object Palette open when adding
multiple objects.

—continued—
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Procedure 1-4 (continued)
Provisioning a UE9000 shelf

Step Action

Troubleshooting
14 Check the provisioned UE9000 component symbol for a shadow.

—end—

If the
symbol is Then

shadowed The UE9000 component was added to the uEMS
database incorrectly.

• Delete the symbol by selecting Delete symbol
from the right-click menu.

• Provision the UE9000 component again.

• Check for uEMS trouble events. See the UE9000
Data Testing and Troubleshooting Guide for more
information.

not
shadowed

You are finished with this procedure.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Table 1-7
UE9000 shelf fields

Field Parameter values Description

HSTP-Name for the
shelf

This is not a provisionable field.

Shelf ID text string

Note: This parameter can
have alphanumeric and
symbol characters. Illegal
characters include slashes,
spaces, semicolons, or
periods. This field is
case-sensitive.

name of the UE9000 shelf

HSTP name of the
Service Descriptor
Group for this shelf

text string HSTP name of the service descriptor
group assigned to the UE9000 shelf
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an ATM core card using the UE9000 element

rd (DS1 IMA or DS3) must be provisioned
E9000 shelf. The standby ATM core card
rovisioned in slot 11 (Atmif B).

ormation required for the provisioning fields
Default values are in bold type.

ee Figure 1-2 on page 1-6).

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

enu, select Add Object .

ialog appears.

g, click once on the UE9000 symbol class.

9000 symbol class appear in the bottom

ialog, drag the appropriate Atmif  (DS1 or
he submap screen using the middle mouse
 page 1-9). When the cursor is in the
he middle mouse button.
Procedure 1-5
Provisioning an ATM core card

Use this procedure to provision
management system (uEMS).

Note: The first ATM core ca
in slot 10 (Atmif A) of the U
(DS3 only), if installed, is p

Before you begin
Ensure that you have all the inf
shown inTable 1-8 on page 1-31. 

Action

Step Action

1 Go to the shelf submap (s

2 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

3 From the Edit pull-down m

The Add Object Palette d

4 In the top field of the dialo

The subclasses for the UE
field of the dialog.

5 In the bottom field of the d
DS3) symbol subclass to t
button (see Figure 1-3 on
submap screen, release t
UE9000 DMS 297-8391-302 NA015

The Add Object dialog appears.

6 In the Label field, type the name you want to appear under the
UE9000 component symbol.

Note: The Label field is optional. The uEMS assigns a label if this
field is empty.

—continued—
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Procedure 1-5 (continued)
Provisioning an ATM core card

Step Action

7 Double-click UE9000 Map Application in the Object Attributes field.

The Add Object - Set Attributes dialog appears.

8 Complete the provisionable fields for the ATM core card. See
Table 1-8 on page 1-31 (default values are in bold type).

9 When you have finished, click the Verify button and follow any
instructions that appear during verification.

10 When verification is complete, click the OK button.

The Add Object dialog appears.

11 Set the selection name (see Figure 1-4 on page 1-11).

a. Click the Set Selection Name button.

CAUTION
Risk of database corruption
Do not enter a label that is already in use, or the
uEMS database will become corrupted.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

The Set Selection Name dialog appears.

b. In the Name field, click once on the first name in the list.

c. Click the OK button.

The Add Object dialog appears.

12 Click the OK button.

The Add Object Palette appears.

13 Click the Close  button

The symbol for the ATM core card appears in the submap.

Note: You can leave the Add Object Palette open when adding
multiple objects.

14 Repeat steps 1 through 13 for the second DS3 ATM core card, if
applicable.

—continued—
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orts two DS3 ATM core cards (one “active”,
r shelf. Only one DS1 IMA ATM core card

n equipment that has not been installed, an
 the symbol to indicate that there is no

 System Setup Guide describes how to
art the ATM core card. If this process has
then the uEMS automatically discovers the
the ATM core card symbol to the submap.

s are installed in the shelf, the first card to
the “active” card, and the other will be the
by” DS3 ATM core card is indicated by an
 symbol.

een commissioned but not cold restarted,
ting and Troubleshooting Guide for the

9000 component symbol for a shadow.

00 component was added to the uEMS
incorrectly.

the symbol by selecting Delete symbol
 right-click menu.

n the UE9000 component again.

or uEMS trouble events. See the UE9000
Procedure 1-5 (continued)
Provisioning an ATM core card

Step Action

Note 1: The UE9000 supp
one optional “standby”) pe
is supported per shelf.

Note 2: If you pre-provisio
alert bubble appears near
hardware.

Note 3: The UE9000 Data
commission and cold rest
already been completed,
ATM core card and adds 

If two DS3 ATM core card
signal that is ready will be
“standby” card. The “stand
“S” label on the Atmif DS3

If the ATM core card has b
see the UE9000 Data Tes
restarting procedure.

Troubleshooting
15 Check the provisioned UE

If the
symbol is Then

shadowed The UE90
database 

• Delete 
from the

• Provisio

• Check f
UE9000 DMS 297-8391-302 NA015

—end—

Data Testing and Troubleshooting Guide for more
information.

not
shadowed

You are finished with this procedure.
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Table 1-8
ATM core card fields

Field Parameter values Description

HSTP-Name for the
ATMIF

These are not provisionable fields.

Physical Slot number
(for reference)

Provisioned Card Type

Actual Card Type

--------- Values to Provision--------
--------- Identity Category --------

Logical card ID the UE9000 logical card number that the ATM core card occupies

Unset not available

A active ATM core card (physical slot 10)

B standby (DS3 only) ATM core card
(physical slot 11)
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

IP Address IP address in decimal
format

Example: 192.67.8.35

IP address of the ATM core card (used by
uEMS t6o communicate with the card)

Atmif Load Name The provisioned ATM core
card software load.

Example: HW203bl

The ATM core card software load is stored
in this directory path on the uEMS
workstation:

/etc/opt/OV/share/loads/Nortel/HSTP/

Initial Administrative
State

state of the ATM core card at start-up

Unset not available

locked out-of-service

unlocked in-service

—continued—



1-32   Provisioning data services

assword for read access to the ATM core
ard

assword for read-write access to the ATM
ore card

mount by which connections provisioned
or constant bit rate (CBR) may be
versubscribed on a physical link

xample: a value of 2 means that twice the
mount of physical bandwidth may be
llocated by the provisioned connections.

mount by which connections provisioned
or real-time variable bit rate (rt-VBR) may
e oversubscribed on a physical link

xample: a value of 2 means that twice the
mount of physical bandwidth may be
llocated by the provisioned connections.

mount by which connections provisioned
or unspecified bit rate with minimum cell
ate (UBR-MCR) may be oversubscribed
n a physical link

xample: a value of 2 means that twice the
mount of physical bandwidth may be

escription
SNMP Read
Community

text string
(Default = public )

Note: This is a read-only
field.

p
c

SNMP Write Community text string
(Default = private )

Note: This is a read-only
field.

p
c

Additional fields for DS3 ATM core cards

Bandwidth
Oversubscription Factor
for CBR

1 to 100 a
f
o

E
a
a

Bandwidth
Oversubscription Factor
for rt-VBR

1 to 100 a
f
b

E
a
a

Bandwidth
Oversubscription Factor
for UBR-MCR

1 to 100 a
f
r
o

E
a

Table 1-8
ATM core card fields (continued)

Field Parameter values D
UE9000 DMS 297-8391-302 NA015

allocated by the provisioned connections.

—continued—
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Expected TxCell
Throughput
(cells/second)

0 to 2147483647

100000

maximum transmit bandwidth configured
for this interface for use with connection
admission control (CAC)

Expected RxCell
Throughput
(cells/second)

0 to 2147483647

100000

maximum receive bandwidth configured for
this interface for use with connection
admission control (CAC)

—end—

Table 1-8
ATM core card fields (continued)

Field Parameter values Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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 DS1 carriers using the UE9000 element

d is provisioned, eight DS1 symbols are
(DAC) submap but are not provisioned.

nd equipment does not have scrambling
e. Scrambling is an ATM parameter that
t support over the DS1 IMA links because it

s. If scrambling is enabled, the ATM cells
ion, resulting in CRC errors at the CPE.

ed through the local craft interface (LCI)
rd was commissioned will be
fter the ATM core card finishes rebooting and
. You may need to wait a few minutes for the
ning information to the uEMS. See the
ide, for more information on commissioning

ormation required for the provisioning fields
Default values are in bold type.

ee Figure 1-2 on page 1-6).
Procedure 1-6
Provisioning DS1 carriers

Use this procedure to provision
management system (uEMS).

When a DS1 IMA ATM core car
added to the data access card 

Note: Ensure that the far-e
enabled on the IMA interfac
UE9000 equipment does no
is not required at T1 speed
experience payload corrupt

The carriers that were provision
when the DS1 IMA ATM core ca
auto-provisioned on the uEMS a
starts communicating with uEMS
ATM to send the carrier provisio
UE9000 Data System Setup Gu
the DS1 IMA ATM core card.

Before you begin
Ensure that you have all the inf
shown inTable 1-9 on page 1-37. 

Action

Step Action

1 Go to the DAC submap (s
UE9000 DMS 297-8391-302 NA015

2 Confirm that [Read-Write] appears in the lower left corner of the
submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.

—continued—
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Procedure 1-6 (continued)
Provisioning DS1 carriers

Step Action

CAUTION
Loss of service
To avoid loss of or erratic service, always
provision the DS1s in sequential order, starting
with DS1 link number 1. DS1 link number 1 must
always be the IMA timing reference link due to
differences between the IMA protocol
implementation on the ATM IF card and the IMA
protocol implementation on other ATM devices.

If a loss of service occurs on DS1 link number 1,
the ATM IF card will transfer timing to another
link. However, users may see erratic behavior
because of a loss of timing synchronization
between the UE and the far-end ATM device.

Note: The current ATM IF card hardware and
software support IMA version 1.0.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

3 Right click the carrier symbol you want to provision. Select
Provision/Edit  from the symbol’s pop-up menu.

The Object Description dialog appears.

4 Double-click UE9000 Map Application  in the Object Attributes field.

The Add Object - Set Attributes dialog appears.

—continued—
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le fields for the DS1 you are provisioning.
37 (default values are in bold type).

click the Verify  button and follow any
uring verification.

lete, click the OK button.

alog appears.

ters are set.

 each DS1 carrier you want to provision.

ION
 service
lues provisioned for each DS1 facility
atch the DS1 values provisioned on the

dge switch and other DS1 inverse
exing over ATM (IMA) devices in the ATM
k. If these values do not match, ATM traffic
e UE9000 shelf is not passed through the
k.

If a mapping table exists at the ATM edge
 the values may not match, but the ATM
witch can still pass ATM traffic.
Procedure 1-6 (continued)
Provisioning DS1 carriers

Step Action

5 Complete the provisionab
See Table 1-9 on page 1-

6 When you have finished, 
instructions that appear d

7 When verification is comp

The Object Description di

8 Click the OK button.

The DS1 carrier’s parame

9 Repeat this procedure for

—end—

CAUT
Loss of
The va
must m
ATM e
multipl
networ
from th
networ

Note:
switch,
edge s
UE9000 DMS 297-8391-302 NA015
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Table 1-9
DS1 carrier fields

Field
Parameter
values

Description

HSTP-Name for the DS1
Link

This is not a provisionable field.

Initial Administrative State state of the DS1 carrier at start-up

Unset not available

locked out-of-service

unlocked in-service

Frame Format framing format of the DS1 path

Unset not available

dsx1ESF extended superframe

dsx1D4 D-4 framing

Line Coding DS1 line encoding

Unset not available
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

dsx1B8ZS bipolar with eight zero substitution

dsx1AMI alternate mark inversion

Transmit Clock Source primary synchronization clock for the DS1

Unset not available

loopTiming the transmit DS1 signal is derived from the
receive DS1 signal

localTiming in this mode, the DS1 signal is derived form an
oscillator on the ATM core card

throughTiming for the UE9000, there is no difference between
through timing and loop timing
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DS3 carrier provisioning. When a DS3 ATM
carrier symbol is added to the DAC submap.

through the local craft interface (LCI). The
-provisioned on the uEMS after the DS3
g and starts communicating with uEMS. You
for the ATM to send the carrier provisioning

he  for more information.

able 1-10 on page 1-39 are read only.

ee Figure 1-2 on page 1-6).

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

r symbol. Select Provision/Edit  from the

alog appears.

 Application  in the Object Attributes field.

ibutes dialog appears.

ists the provisionable fields for the DS3
 in bold type).These fields are read only
Procedure 1-7
Verifying DS3 carrier provisioning

Use this procedure to verify the
core card is provisioned, a DS3

The DS3 carrier is provisioned 
DS3 ATM core card will be auto
ATM core card finishes rebootin
may need to wait a few minutes
information to the uEMS. See t

Before you begin
The provisioning fields shown inT
Default values are in bold type.

Action

Step Action

1 Go to the DAC submap (s

2 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

3 Right click the DS3 carrie
symbol’s pop-up menu.

The Object Description di

4 Double-click UE9000 Map

The Add Object - Set Attr

Table 1-10 on page 1-39 l
carrier (default values are
UE9000 DMS 297-8391-302 NA015

through the uEMS. To change any of the fields, you must use the LCI.
See the UE9000 Data System Setup Guide for more information.

—end—
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Table 1-10
DS3 carrier fields

Field Parameter values Description

HSTP-Name for the DS3
Link

This is not a provisionable field.

Initial Administrative State state of the DS3 carrier at start-up

Unset not available

locked out-of-service

unlocked in-service

Carrier DS3
ConvSublayerMap

controls DS3 framing mode

phyLayerConvPr activates the transmission of 12 rows of ATM
cells every 125 microseconds

direct cell delineation is used to locate the cell
boundaries

Frame Format framing format of the DS3 path

Unset not available

dsx3CBITParity for ANSI T1.107a-1989
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

dsx3M23 for ANSI T1.107-1988

Line Coding DS3 line encoding

Unset not available

dsx3B3Z type of zero code suppression

Transmit Clock Source primary synchronization clock for the DS1

Unset not available

loopTiming the recovered receive clock is used as the
transmit clock

localTiming the internal free-running clock is used as the
transmit clock

throughTiming the recovered receive clock from another
interface is used as the transmit clock
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ards

 the xDSL multi-circuit line cards using the
system (uEMS).

start an ATM core card, uEMS automatically
he uEMS then adds the line card symbols on

lays symbols for voice-only line cards, you
elete voice-only line cards in uEMS. See the
r Guide for more information.

rmation required for the provisioning fields
3 Default values are in bold type.

ee Figure 1-2 on page 1-6).

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

following table.

Then go to

d symbol, such as when step 4
Procedure 1-8
Provisioning xDSL multi-circuit line c

Use this procedure to provision
UE9000 element management 

When you provision and cold re
discovers the data line cards. T
the shelf submap.

Note: Although uEMS disp
cannot move, provision, or d
UE9000 Voice OAM&P Use

Before you begin
Make sure you have all the info
shown inTable 1-11 on page 1-4.

Action

Step Action

1 Go to the shelf submap (s

2 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

3 Proceed according to the 

If

you need to add a line car
pre-provisioning
UE9000 DMS 297-8391-302 NA015

4 From the Edit pull-down menu, select Add Object .

The Add Object Palette dialog appears.

—continued—

the card is already installed step 8
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Procedure 1-8 (continued)
Provisioning xDSL multi-circuit line cards

Step Action

5 In the top field of the dialog, click once on the UE9000 symbol class.

The subclasses for the UE9000 symbol class appear in the bottom
field of the dialog.

6 In the bottom field of the dialog, drag the appropriate line card symbol
subclass (i.e. ADSL4+4 LC) to the submap screen using the middle
mouse button (see Figure 1-3 on page 1-9). When the cursor is in the
submap screen, release the middle mouse button.

The Add Object dialog appears.

7 In the Label field, type the name you want to appear under the line
card symbol.

Note: The Label field is optional. If nothing is entered in this field, the
uEMS assigns a label, using the name entered in the Name field (see
step 13).

CAUTION
Risk of database corruption
Do not enter a label that is already in use, or the
uEMS database will become corrupted.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

8 Right click the line card symbol you want to provision. Select
Provision/Edit  from the symbol’s pop-up menu.

The Object Description dialog appears.

9 Double-click UE9000 Map Application in the Object Attributes field.

The Attributes dialog appears.

10 Complete the provisionable fields for the line card. See Table 1-11 on
page 1-43 (default values are in bold type).

11 When you have finished, click the Verify button and follow any
instructions that appear during verification.

12 When verification is complete, click the OK button.

The Object Description dialog appears.

—continued—
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ee Figure 1-4 on page 1-11).

n Name button.

me dialog appears.

k once on the first name in the list.

n dialog appears.

ges color when the equipment is

 equipment that has not been installed,
n the symbol to indicate that there is no
n text and alert bubbles” on page 4-30 for

ult
nt to change the line card default. Do this

click menu, select Change Line Card

p dialog appears.

 of available loads and click OK.

load is changed. The line card will receive
 it is restarted.

 each line card that you want to provision.
Procedure 1-8 (continued)
Provisioning xDSL multi-circuit line cards

Step Action

13 Set the selection name (s

a. Click the Set Selectio

The Set Selection Na

b. In the Name field, clic

c. Click the OK button.

The Object Descriptio

14 Click the OK button.

The line card symbol chan
in-service.

Note: If you pre-provision
annotation text appears o
hardware. See “Annotatio
more information.

Changing the Line Card Load Defa
In rare cases, you may wa
as follows:

15 From the line card’s right-
Provisioned Load .

The Load Selection Popu

16 Select a load from the list

The provisioned line card
the new load the next time

17 Repeat this procedure for

—end—
UE9000 DMS 297-8391-302 NA015
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Table 1-11
ADSL multi-circuit line card fields

Field Parameter values Description

HSTP-Name for the Line
Card

This is not a provisionable field.

Physical slot number (for
reference)

This is not a provisionable field.

Provisioned Card Type This is not a provisionable field.

Actual Card Type This is not a provisionable field.

Logical Line Card Number
of the ADSL MLC

1 to 16 (see Figure 1-5 on page 1-44)

Logical Line Card Number
for UE9000 DMS

0 to 15 (see Figure 1-5 on page 1-44)

Line Card Load Name The provisioned line card software load.

Example: LC4x4FR02.0314

The line card software load is stored in this directory path on the
uEMS workstation:

/etc/opt/OV/share/loads/Nortel/HSTP/
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Initial Administrative State state of the ADSL MLC at start-up

Unset not available

locked out-of-service

unlocked in-service
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 card assignments (MLC numbers) on the

it line cards (MLCs) on a UE9000

UE-1007

UE-1007
12 13 14 15 16 17 18 19 20 21

MLCs 9-16

Line cards 9-16 

TDM core cards
Figure 1-5 shows the logical line
UE9000 shelf.

Figure 1-5
Logical slot numbers for multi-circu
shelf

2 3 4 5 6 7 8 9 10 11
MLCs 1-8

Line cards 1-8 

ATM core cards

MTA
In

Power
I/O

MTA
Out

TB A&B
to

left side

Pwr A&B
to

right side

SI card
UE9000 DMS 297-8391-302 NA015
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Procedure 1-9
Provisioning xDSL subscriber circuits

Use this procedure to provision either full-rate or xDSL subscriber circuits
using the UE9000 element management system (uEMS). When you provision
an xDSL multi-circuit line card (MLC), the uEMS automatically adds the
subscriber circuit symbols on the LC submap. However, you must provision
each circuit manually.

Before you begin
Make sure you have all the information required for the provisioning fields
shown inTable 1-12 on page 1-46. Default values are in bold type.

Action

Step Action

1 Go to the LC submap (see Figure 1-2 on page 1-6).

2 Confirm that [Read-Write] appears in the lower left corner of the
submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

3 Right click the circuit symbol you want to provision. Select
Provision/Edit  from the symbol’s pop-up menu.

The Object Description dialog appears.

4 Double-click UE9000 Map Application  in the Object Attributes field.

The Add Object - Set Attributes dialog appears.

5 Complete the provisionable fields for the circuit you are provisioning.
See Table 1-12  beginning on page 1-46 (default values are in bold
type).

6 When you have finished, click the Verify  button and follow any
instructions that appear during verification.

7 When verification is complete, click the OK button.

The Object Description dialog appears.

—continued—
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re changed.

 each facility that you want to provision.

ription

ield.

r circuit at start-up

available

of-service

ervice

pecific type of ADSL service; indicates the
r premise equipment (CPE) is allowed to
n page 1-55 for more information.

mits the circuit to train up in any of the valid
L modes; the actual link mode is reported
matically to the user when the link is up

rate ADSL (refers to ANSI standard
1413)

ite (splitterless) ADSL (refers to ITU-T
Procedure 1-9 (continued)
Provisioning xDSL subscriber circuits

Step Action

8 Click the OK button.

The facility’s parameters a

9 Repeat this procedure for

—end—

Table 1-12
ADSL subscriber circuit fields

Field Parameter values Desc

HSTP-Name for the
Subscriber Circuit

This is not a provisionable f

Initial Administrative State state of the ADSL subscribe

Unset not 

locked out-

unlocked in-s

ADSL Circuit Enabling allows the user to select a s
mode in which the custome
train. See Procedure 1-11 o

autodetect per
ADS
auto

t1.413ANSI full-
T1.

glite G.L
UE9000 DMS 297-8391-302 NA015

standard G.992.2); uses same modulation
techniques as T1.413

—continued—
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Enable Auto Fast Retrain Enables or disables automatic fast retrains; applies only to G.Lite

enabled allows fast retrains to be performed
automatically when an on- or off-hook
condition occurs

disabled disables fast retrain

Profile Selection
Tolerance (dB)

determines how strictly profiles are selected during a fast retrain; the
delta is to be met with a given profile between measured SNR margin
at the time of fast retrain, target SNR margin, and the stored profile
SNR margin, on a per carrier basis; for G.Lite only.

Note: Changing the profile selection tolerance may result in a full
retrain of the circuit. Range is 0 to 15 dB. Default is 3 dB.

Note: A higher value increases the possibility of a profile match, but
may result in sub-optimal performance. A lower value will decrease the
possibility of a profile match, but may result in more full link retrains
than necessary.

Maximum Downstream
Speed (kb/s)

allows the service provider to limit the maximum data rate delivered to
the subscriber; configurable in 32 kbit/s intervals

Table 1-12
ADSL subscriber circuit fields (continued)

Field Parameter values Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Unset not available

32 to 13380 maximum downstream data rate in kbit/s

Maximum Upstream
Speed (kb/s)

indicates the maximum data rate the subscriber can send data
upstream; configurable in 32 kbit/s intervals

Unset not available

32 to 1440 maximum upstream data rate in kbit/s

Bandwidth
Oversubscription Factor
for CBR

amount by which connections provisioned for constant bit rate (CBR)
may be oversubscribed on a physical link

For example, a value of 2 means that twice the amount of physical
bandwidth may be allocated by the provisioned connections.

1 to 100 see general description and example above

—continued—
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ns provisioned for real-time variable bit
ubscribed on a physical link

eans that twice the amount of physical
 by the provisioned connections.

 general description and example above

s provisioned for unspecified bit rate with
R) may be oversubscribed on a physical

eans that twice the amount of physical
 by the provisioned connections.

 general description and example above

se ratio for downstream data integrity with
the operator to make adjustments based

 tolerance for errors.

igher margin increases the robustness of
signal, but decreases the loop reach.

wer margin decreases the robustness of
signal, but increases the loop reach.

e: The recommended setting for G.Lite is
; the default is not automatically changed
n G.Lite is provisioned.

d by the interleaving of downstream data

easing this parameter provides higher
unity to impulse noise on the subscriber
, but increases data transmission delay.

ription
Bandwidth
Oversubscription Factor
for rt-VBR

amount by which connectio
rates (rt-VBR) may be overs

For example, a value of 2 m
bandwidth may be allocated

1 to 100 see

Bandwidth
Oversubscription Factor
for UBR-MCR

amount by which connection
minimum cell rate (UBR-MC
link

For example, a value of 2 m
bandwidth may be allocated

1 to 100 see

Downstream (central)
Target Signal-to-Noise
Margin (dB)

the acceptable signal-to-noi
minimum power use; allows
on the type of traffic and its

0 to 15 dB

Defaults:

• 6 dB  for full-rate

• 4 dB for G.Lite

A h
the 

A lo
the 

Not
4 dB
whe

Downstream (central)
Maximum Interleave
Delay (ms)

the acceptable delay cause
between frames

0 to 256 ms

Default: 10 ms

Incr
imm
loop

Table 1-12
ADSL subscriber circuit fields (continued)

Field Parameter values Desc
UE9000 DMS 297-8391-302 NA015

Increased delay may result in reduced file
transfer data rates.

—continued—
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Upstream (CPE) Target
Signal-to-Noise Margin
(dB)

the acceptable signal-to-noise ratio for upstream data integrity with
minimum power use; allows the operator to make adjustments based
on the type of traffic and its tolerance for errors.

0 to 15 dB

Defaults:

• 6 dB  for full-rate

• 4 dB for G.Lite

A higher margin increases the robustness of
the signal, but decreases the loop reach.

A lower margin decreases the robustness of
the signal, but increases the loop reach.

Note: The recommended setting for G.Lite is
4 dB; the default is not automatically changed
when G.Lite is provisioned.

Upstream (CPE)
Maximum Interleave
Delay (ms)

the acceptable delay caused by the interleaving of upstream data
between frames

0 to 256 ms

Default: 10 ms

Increasing this parameter provides higher
immunity to impulse noise on the subscriber
loop, but increases data transmission delay.
Increased delay may result in reduced file
transfer data rates.

Table 1-12
ADSL subscriber circuit fields (continued)

Field Parameter values Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

—continued—
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he subscriber circuit with an assigned VCI
ervice Descriptor Name. You can enter up
 on a different line.

n have alphanumeric and symbol
s include slashes, spaces, semicolons, or
ensitive.

 must be provisioned before the
er virtual circuits (VCs), are provisioned.

scriptors, see Procedure 1-23, “Viewing
e 1-81.

up/down],[networkside_VCI],

 string

 unlocked (active)
n = locked (inactive)

nteger from 0 to 65535

e: An entry of 0 causes the uEMS to
matically assign a unique identifier

On = ATM enabled for F5 loopback test
formed by an ATM edge switch
Off = ATM disabled for F5 loopback test

e 1: If blank, this field defaults to oamOff .
e 2: This field must be set to oamOff  for

ription
Cross-connect for VCC 1
... Cross-connect for
VCC 8

cross-connects the PVC of t
in the VP identified by the S
to eight combinations, each

Note 1: This parameter ca
characters. Illegal character
periods. This field is case-s

Note 2: Service descriptors
cross-connects, or subscrib

Note 3: To view service de
service descriptors” on pag

Syntax:
[Service Descriptor Name],[
[oamOn/oamOff]
where

Service Descriptor
Name

text

up/down up =
dow

networkside_VCI an i

Not
auto

oamOn/oamOff oam
per
oam

Not
Not

Table 1-12
ADSL subscriber circuit fields (continued)

Field Parameter values Desc
UE9000 DMS 297-8391-302 NA015

DS1 IMA ATM cards.
Note 3: A limited number of VCs may have
oamOn. See VCC OAM management tool on
page 4-24.

Example: AOL,up,101,oamOff

—continued—
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Expected Tx Cell
Throughput

Range is based on type of circuit being provisioned. This should be set
as close as possible to maximum cell throughput but not over. It is the
actual cell throughput not the link nominal speed.

No limit

Expected Rx Cell
Throughput

Range is based on type of circuit being provisioned. This should be set
as close as possible to maximum cell throughput but not over. It is the
actual cell throughput not the link nominal speed.

No limit

—end—

Table 1-12
ADSL subscriber circuit fields (continued)

Field Parameter values Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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the UE9000 equipment in-service and ready

ee Figure 1-2 on page 1-6).

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

rs are unlocked (active/in service) by
if symbol. If the carrier symbols on the next

iers are unlocked.

e eight carriers. It is possible, though not
e receiving traffic if one of the carriers is
arrier, do the following:

 symbol.

> Unlock -> Normal .

 only one carrier. If the carrier symbol is
r faults and you can proceed. However, if
olor other than green or yellow, you must
ws before proceeding.

 symbol.

.

n the fault explanations(s) that appear in
s dialog.
Procedure 1-10
Verifying data service

Use this procedure to verify that
to send data traffic.

Action

Step Action

1 Go to the Shelf submap (s

2 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

3 Verify that the ATM carrie
double-clicking on the Atm
dialog are green, the carr

In a DS1 system, there ar
recommended, to continu
locked. To unlock a DS1 c

a. Right click the carrier

b. Select Maintenance -

In a DS3 system, there is
yellow, this indicates mino
the carrier symbol is any c
resolve the fault(s) as follo

a. Right click the carrier

b. Select Show -> Fault

c. Troubleshoot based o
the subsequent Alarm
UE9000 DMS 297-8391-302 NA015

—continued—
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Procedure 1-10 (continued)
Verifying data service

Step Action

4 Verify that the ATM core card is unlocked. (If it is locked, the symbol
is tan and the annotation text is “L”). To unlock the ATM core card, do
the following:

a. Right click the ATM symbol.

b. Select Maintenance -> Unlock -> Normal  from the right-click
pop-up menu.

The ATM core card symbol changes color when the equipment is
in-service.

5 Verify that the line card symbol is unlocked. To unlock the line card,
do the following:

a. Right click the line card symbol on the shelf submap.

b. Select Maintenance -> LC -> Unlock -> Normal  from the
right-click pop-up menu.

The line card symbol changes color when the equipment is
in-service.

6 Verify that the subscriber data circuits are unlocked.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

To unlock a specific subscriber circuit , do the following:

a. Right click on the circuit symbol on the LC submap.

b. Select Maintenance -> Circuit -> Unlock -> Normal .

To unlock all subscriber circuits simultaneously , do the following:

c. Right click the line card symbol on the shelf submap.

d. Select Maintenance -> Circuit -> All Unlock from the right-click
pop-up menu.

7 Repeat steps 5 and 6 for each line card in the UE9000 shelf.

—continued—
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 right-click on the CCT symbol to be

m the right-click pop-up menu.

alog appears.

 Application  in the Object Attributes field.

ibutes dialog appears.

ross connect” field and make sure that the
p  (for example, AOL,up,101,oamOff ).

ns unlocked and down  means locked.

follow any instructions that appear during

lete, click the OK button.

ibutes dialog disappears.

appears.

end data traffic.
Procedure 1-10 (continued)
Verifying data service

Step Action

Verify cross-connects are up
8 Go to the LC submap and

activated.

9 Select Provision/Edit  fro

The Object Description di

10 Double-click UE9000 Map

The Add Object - Set Attr

11 Scroll to the appropriate “C
SD name is followed by u

Note: In this field, up  mea

12 Click the Verify button and
verification.

13 When verification is comp

The Add Object - Set Attr

14 Click the OK button.

The Add Object dialog dis

15 The UE9000 is ready to s

—end—
UE9000 DMS 297-8391-302 NA015
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Procedure 1-11
Checking ADSL circuit capabilities

Use this procedure to verify that the provisioning for ADSL circuits matches
the capabilities of the customer premises equipment (CPE). It is important to
perform this procedure during provisioning to avoid unnecessary
communications problems later.

Action

Step Action

1 Go to the LC submap (see Figure 1-2 on page 1-6).

2 Confirm that [Read-Write] appears in the lower left corner of the
submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.

3 Right click the circuit symbol you want to check and select the
following from the symbol’s pop-up menu:

Show -> Circuit Capabilities

The Info dialog box appears, displaying the training capabilities for
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

the circuit and its associated CPE.

—continued—
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SC-10470

formation displayed for the ATUC and the
 item displayed for each?

Then

Go to step 5.

Either:

• replace the CPE (ATUR) to match
the line card capabilities, or
connect the CPE to an LC that
matches the CPE capabilities.

• change the ADSL circuit
Procedure 1-11 (continued)
Checking ADSL circuit capabilities

Step Action

Figure 1-6
Circuit capabilities dialog box

4 Compare the capability in
ATUR. Is there a common

If

Yes

No
UE9000 DMS 297-8391-302 NA015

—continued—

provisioning (ATUC) to match the
CPE capabilities (see
Procedure 1-9 on page 1-45).
The specific parameter is called
“ADSL Circuit Enabling” as shown
in Table 1-12 on page 1-46.
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Procedure 1-11 (continued)
Checking ADSL circuit capabilities

Step Action

5 Compare the “Circuit provisioned as” information to the “Actual
transmission mode” information.

If the Then

Circuit Provisioning is set to
autodetect

communication to the CPE should
work properly. See the UE9000 Data
Testing and Troubleshooting Guide if
communication does not work.

Circuit Provisioning does not
match the Actual
Transmission Mode

change the ADSL circuit
provisioning (ATUC) to match the
CPE capabilities (see Procedure 1-9
on page 1-45). The specific
parameter is called “ADSL Circuit
Enabling” as shown in Table 1-12 on
page 1-46.

Actual Transmission Mode is
Unknown

wiring or provisioning are
incomplete, or the CPE likely has
communication problems. See the
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

—end—

UE9000 Data Testing and
Troubleshooting Guide.
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change a UE9000 component’s provisioning
se.

the software load on the equipment, refer to
ATM and line card loads” on page 3-4.

ation given for a line card without first
take effect until the line card is locked and

iated on the line card. This allows for
be changed without affecting service until a
e new provisioning information will take

terrupted for the duration that the card is

ap (see Figure 1-2 on page 1-6) and right
ent that you want to update. Select
p-up menu.

h
ate the provisioning for a DS1 or DS3, the
tically locks that DS1 or DS3 while uEMS
visioning changes to the ATM core card.
S3 does not pass subscriber traffic while it
state.
Procedure 1-12
Updating provisioning information

Use this procedure to update or
information in the uEMS databa

Note 1: To update or change
Procedure 3-2, “Upgrading 

Note 2: Provisioning inform
locking the line card will not
unlocked, or a retrain is init
provisioning information to
convenient time, at which th
effect and service will be in
locked.

Action

Step Action

1 Go to the appropriate subm
click the UE9000 compon
Provision/Edit from the po

CAUTION
Loss of bandwidt
When you upd
uEMS automa
sends the pro
The DS1 or D
is in a locked 
UE9000 DMS 297-8391-302 NA015

The Object Description dialog appears.

—continued—
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Procedure 1-12 (continued)
Updating provisioning information

Step Action

2 Double-click the UE9000 Map Application  in the Object Attributes
field.

The Add Object - Set Attributes dialog appears.

3 Enter the new information in the appropriate provisionable fields.
When you are finished, click the Verify  button and follow any
instructions that appear during verification.

4 When verification is complete, click the OK button.

The Add Object - Set Attributes dialog disappears.

5 Click OK.

The Object Description dialog disappears.

6 You are finished with this procedure.

—end—
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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n a multi-circuit line card (MLC) to a
ut changing the circuit address and without

ware present in the UE9000 shelf.

tions where the MLC is reprovisioned before

uses the UE9000 equipment to report a “h/w
ars when hardware matching the new

iber circuits on the MLC using
-67.

g Procedure 1-16 on page 1-70.

ee Figure 1-2 on page 1-6).

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.
Procedure 1-13
Force provisioning

Use this procedure to reprovisio
different type of hardware witho
immediately changing the hard

This procedure is useful in situa
the hardware is replaced.

Completion of this procedure ca
mismatch” alarm. The alarm cle
provisioning is installed.

Action

Step Action

1 Unprovision all the subscr
Procedure 1-15 on page 1

2 Unprovision the MLC usin

3 Go to the shelf submap (s

4 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

—continued—
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Procedure 1-13 (continued)
Force provisioning

Step Action

5 Right click the line card symbol you want to reprovision and select the
following from the symbol’s pop-up menu:

Maintenance -> [old MLC type] -> Force Provision -> as [new
MLC type]

The symbol changes to the new type and turns brown. The
annotation text states “h/w mismatch” until the matching MLC is
installed.

6 Provision the subscriber circuits using the appropriate procedure as
described in Table 1-1 on page 1-4.

—end—

where

[old MLC type] is the existing MLC type of the symbol that
you clicked on

[new MLC type] is the type of MLC that will replace the
existing MLC
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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rdware device from the UE9000 shelf, Nortel
 unprovision the device’s database entry
e. Otherwise, alarms will be generated when
e.

on a parent object until you unprovision all

components from the uEMS database in the
ere provisioned. For example, before you can
must unprovision all of the MLCs and ATM

.

 order for unprovisioning UE9000
tabase. Unprovisioning must be done in the

on components in the incorrect order, you
Removing hardware
Before physically removing a ha
Networks recommends that you
(object) from the uEMS databas
you physically remove the devic

Note: You cannot unprovisi
of its children objects.

You must unprovision UE9000 
reverse order from which they w
unprovision a UE9000 shelf, you
core cards provisioned under it

Table 1-13 describes the correct
components from the uEMS da
order specified inTable 1-13.

Note: If you try to unprovisi
will receive an error.
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Table 1-13
UE9000 unprovisioning order

Step Task See

1 Subscriber cross-connects Procedure 1-14 on page 1-64

2 Subscriber circuits Procedure 1-15 on page 1-67

3 xDSL MLCs Procedure 1-16 on page 1-70

4 DS1 carriers

Note: You cannot unprovision
DS1 Carrier 1 because it is the IMA
timing reference. You must
unprovision DS1 carriers in
descending order (for example,
Carrier 8, then Carrier 7, then
Carrier 6, etc.).

Note: In a DS3 configuration, you
do not need to unprovision the DS3
carrier before you unprovision the
ATM core card.

Procedure 1-17 on page 1-73

5 ATM core cards Procedure 1-18 on page 1-75
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

6 UE9000 shelf Procedure 1-19 on page 1-77

7 Network element Procedure 1-20 on page 1-78

8 ATM service descriptors

Note: To unprovision a service
descriptor, every subscriber
cross-connect provisioned against
that service descriptor must be
unprovisioned.

Procedure 1-21 on page 1-79

9 ATM service descriptor groups Procedure 1-22 on page 1-80
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nects

on one or more subscriber cross-connects
er circuit in the uEMS database.

 card (LC) submap (see Figure 1-2 on

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

s are you unprovisioning?

he circuit (CCT) containing the subscriber
 unprovision.

rcuit -> Lock -> Normal  from the pop-up

ppears asking if you are sure you want to
.

Then

go to step 4

 a circuit see Procedure 1-15 on
page 1-67

their
 card

see Procedure 1-16 on
page 1-70
Procedure 1-14
Unprovisioning subscriber cross-con

Use this procedure to unprovisi
(virtual circuits) from a subscrib

Action

Step Action

1 Go to the appropriate line
page 1-6).

2 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

3 How many cross-connect

Unprovisioning one cross-connect
4 Right-click the symbol of t

cross-connect you want to

5 Select Maintenance -> Ci
menu.

A confirmation message a
lock the subscriber circuit

If you are unprovisioning

one cross-connect

all the cross-connects for

all the circuits (including 
cross-connects) for a line
UE9000 DMS 297-8391-302 NA015

6 Click OK.

The confirmation message disappears and the circuit is locked.

7 Select Provision/Edit  from the appropriate circuit (CCT) symbol’s
pop-up menu.

The Object Description dialog appears.

—continued—
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Procedure 1-14 (continued)
Unprovisioning subscriber cross-connects

Step Action

8 Double-click UE9000 Map Application  in the Object Attributes field.

The Add Object - Set Attributes dialog appears.

9 Lock the subscriber cross-connect by doing the following:

a. Scroll to the appropriate “Cross connect” field.

b. Ensure that the service descriptor name is followed by the word
down . If the field is up, then delete the word up  and replace it
with the word down .

Note: In this field, up  means “unlocked” and down  means “locked”.

10 Click Verify  and follow any instructions that appear during
verification.

11 When verification is complete, click OK.

The Object Description dialog appears.

12 Click OK. (This step is necessary to lock the cross connect before it
can be unprovisioned.)

The Object Description dialog disappears.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

13 On the LC submap, right-click on the same CCT symbol. Select
Provision/Edit  from the right-click pop-up menu.

The Object Description dialog appears.

14 Double-click UE9000 Map Application  in the Object Attributes field.

The Add Object - Set Attributes dialog appears.

15 Scroll to the appropriate “Cross connect” field and delete the entire
line of text.

16 Click Verify  and follow any instructions that appear during
verification.

17 When verification is complete, click OK.

The Add Object - Set Attributes dialog disappears.

18 Click OK.

The Object Description dialog disappears. The subscriber
cross-connect for that line card is now unprovisioned.

—continued—
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cuit -> Unlock -> Normal from the pop-up

or a circuit
he circuit (CCT) containing the subscriber
to unprovision.

rcuit -> Lock -> Normal  from the pop-up

ppears asking if you are sure you want to
.

e disappears and the circuit is locked.

rcuit -> Unprovision  from the pop-up

oss-connects are unprovisioned.
Procedure 1-14 (continued)
Unprovisioning subscriber cross-connects

Step Action

19 Select Maintenance -> Cir
menu.

The circuit is unlocked.

Unprovisioning all cross-connects f
20 Right-click the symbol of t

cross-connects you want 

21 Select Maintenance -> Ci
menu.

A confirmation message a
lock the subscriber circuit

22 Click OK.

The confirmation messag

23 Select Maintenance -> Ci
menu.

The circuit and all of its cr

—end—
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Procedure 1-15
Unprovisioning subscriber circuits

Use this procedure to unprovision one or more subscriber circuits and their
associated cross-connect from the uEMS database.

Action

Step Action

1 How many circuits are you unprovisioning?

Unprovisioning one circuit
2 Go to the appropriate line card (LC) submap (see Figure 1-2 on

page 1-6).

3 Confirm that [Read-Write] appears in the lower left corner of the

If you are unprovisioning Then

one circuit go to step 2

all the circuits for a line card go to step 9

all the circuits for a shelf go to step 15
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.

4 Right-click the symbol of the circuit (CCT) you want to unprovision.

5 Select Maintenance -> Circuit -> Lock -> Normal  from the pop-up
menu.

A confirmation message appears asking if you are sure you want to
lock the subscriber circuit.

6 Click OK.

The confirmation message disappears and the circuit is locked.

7 Select Maintenance -> Circuit -> Unprovision  from the pop-up
menu.

The circuit and all of its cross-connects are unprovisioned.

8 Go to step 20.

—continued—
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 card
lf submap (see Figure 1-2 on page 1-6).

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

SL CCT -> All Lock from the symbol’s

y doing the following:

ropriate line card (LC) symbol.

> xDSL CCT -> All Unprovision from the
u.

ppears asking if you are sure you want to
ircuits on the multi-circuit line card MLC.

e disappears. The circuit symbols become
, indicating that they have been

lf
ork element (NE) submap (see Figure 1-2

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

cuit -> All Lock from the symbol’s pop-up
Procedure 1-15 (continued)
Unprovisioning subscriber circuits

Step Action

Unprovisioning all circuits for a line
9 Go to the appropriate she

10 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

11 Select Maintenance -> xD
pop-up menu.

12 Unprovision the circuits b

a. Right-click on the app

b. Select Maintenance -
symbol’s pop-up men

A confirmation message a
delete all the subscriber c

13 Click OK.

The confirmation messag
white (on the LC submap)
unprovisioned.

14 Go to step 20.

Unprovisioning all circuits for a she
15 Go to the appropriate netw

on page 1-6).

16 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

17 Select Maintenance -> Cir
menu.
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Procedure 1-15 (continued)
Unprovisioning subscriber circuits

Step Action

18 Unprovision the circuits by doing the following:

a. Right-click on the appropriate shelf symbol.

b. Select Maintenance -> Circuit -> All Unprovision  from the
symbol’s pop-up menu.

A confirmation message appears asking if you are sure you want to
delete all the subscriber circuits on the shelf.

19 Click OK.

The confirmation message disappears. The circuit symbols become
white (on the LC submap), indicating that they have been
unprovisioned.

20 Update recovery data (for DS3 only) for all ATM DS3 interfaces on the
shelf where circuits were unprovisioned.

a. Click on the Atmif DS3 symbol.

b. On the pop-up menu, select Update Recovery Data -> No
Reboot .

Note: For more information updating the recovery data (DS3 ATM
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

core cards only), see the UE9000 Data Testing and Troubleshooting
Guide.

c. Select OK.

—end—
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e cards

n one or more xDSL multi-circuit line cards
e.

you unprovisioning?

s circuits using Procedure 1-15 on

lf submap (see Figure 1-2 on page 1-6).

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

want to unprovision by doing the following:

ropriate LC symbol.

> LC -> Lock -> Normal from the symbol’s

ppears asking if you are sure you want to

Then

go to step 2

eir circuits
 shelf

go to step 10
Procedure 1-16
Unprovisioning xDSL multi-circuit lin

Use this procedure to unprovisio
(MLCs) from the uEMS databas

Action

Step Action

1 How many line cards are 

Unprovisioning one MLC
2 Unprovision the line card’

page 1-67.

3 Go to the appropriate she

4 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

5 Lock the line card (LC) you

a. Right-click on the app

b. Select Maintenance -
pop-up menu.

A confirmation message a
“lockout” the line card.

6 Click OK.

If you are unprovisioning

one MLC

all the MLCs (including th
and cross-connects) for a
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The confirmation message disappears and the line card is locked.

7 Unprovision the line card by doing the following:

a. Right-click on the appropriate LC symbol.

—continued—
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Procedure 1-16 (continued)
Unprovisioning xDSL multi-circuit line cards

Step Action

b. Select Maintenance -> LC -> Unprovision  from the symbol’s
pop-up menu.

A confirmation message appears asking if you are sure you want to
unprovision the MLC.

8 Click OK.

The confirmation message disappears. The symbol either becomes
white (if the hardware exists) or disappears from the submap (if the
hardware does not exist), indicating that it has been unprovisioned.

9 Update recovery data (for DS3 only) for all ATM DS3 interfaces on the
shelf where circuits were unprovisioned.

a. Click on the Atmif DS3 symbol.

b. On the pop-up menu, select Update Recovery Data -> No
Reboot .

Note: For more information updating the recovery data (DS3 ATM
core cards only), see the UE9000 Data Testing and Troubleshooting
Guide.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

c. Select OK.

Unprovisioning all the MLCs for a shelf
10 Go to the appropriate network element (NE) submap (see Figure 1-2

on page 1-6).

11 Confirm that [Read-Write] appears in the lower left corner of the
submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.

12 Lock all the line cards (LC) on the shelf by doing the following:

a. Right-click on the appropriate shelf symbol.

b. Select Maintenance -> LC -> All Lock from the symbol’s pop-up
menu.

A confirmation message appears asking if you are sure you want to
“lockout” the line cards.

13 Click OK.

The confirmation message disappears and the line cards are locked.

14 Unprovision the line cards by doing the following:

a. Right-click on the same shelf symbol.
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> LC -> All Unprovision  from the
u.

ppears asking if you are sure you want to

e disappears. The symbol either becomes
ts) or disappears from the submap (if the

 indicating that it has been unprovisioned.
DS3 only) for all ATM DS3 interfaces on the
unprovisioned.

3 symbol.

, select Update Recovery Data -> No

n updating the recovery data (DS3 ATM
UE9000 Data Testing and Troubleshooting
b. Select Maintenance -
symbol’s pop-up men

A confirmation message a
unprovision the MLCs.

15 Click OK.

The confirmation messag
white (if the hardware exis
hardware does not exist),

16 Update recovery data (for
shelf where circuits were 

a. Click on the Atmif DS

b. On the pop-up menu
Reboot .

Note: For more informatio
core cards only), see the
Guide.

c. Select OK.

—end—
UE9000 DMS 297-8391-302 NA015



Provisioning data services  1-73

Procedure 1-17
Unprovisioning DS1 carriers

If this is aDS1configuration, use this procedure to unprovision the DS1
carriers from the uEMS database.

Note: You cannot unprovision DS1 Carrier 1 because it is the IMA
timing reference. You must unprovision DS1 carriers in descending order
(for example, Carrier 8, then Carrier 7, then Carrier 6, etc.).

Action

Step Action

1 Go to the DAC submap (see Figure 1-2 on page 1-6).

2 Confirm that [Read-Write] appears in the lower left corner of the
submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.

3 Lock the DS1 carrier by doing the following:

a. Right-click on the appropriate carrier’s symbol.

b. Select Maintenance ->Lock -> Normal  from the symbol’s
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

pop-up menu.

A confirmation message appears asking if you are sure you want to
“lockout” the carrier.

4 Click OK.

The confirmation message disappears and the carrier is locked.

5 Unprovision the carrier by doing the following:

a. Right-click on the appropriate carrier’s symbol.

b. Select Maintenance -> Unprovision from the symbol’s pop-up
menu.

A confirmation message appears asking if you are sure you want to
unprovision the carrier.

—continued—
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e disappears. The symbol either becomes
ts) or disappears from the submap (if the

 indicating that it has been unprovisioned.

ch DS1 carrier you want to unprovision.
Procedure 1-17 (continued)
Unprovisioning DS1 carriers

Step Action

6 Click OK.

The confirmation messag
white (if the hardware exis
hardware does not exist),

7 Repeat these steps for ea

—end—
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Procedure 1-18
Unprovisioning ATM core cards

Use this procedure to unprovision ATM core cards from the uEMS database.

Note 1: In aDS1 configuration, you cannot unprovision an ATM core
card until you unprovision all of its associated DS1 carriers.

Note 2: In aDS3configuration, you do not need to unprovision the DS3
carrier before you unprovision the ATM core card.

Step Action

1 Go to the appropriate shelf submap (see Figure 1-2 on page 1-6).

2 Confirm that [Read-Write] appears in the lower left corner of the
submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.

3 Check the following:

If the UE9000 shelf
is equipped with Then
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

—continued—

a DS1 IMA ATM core
card

go to step 4

one DS3 ATM core
card

go to step 4

two DS3 ATM core
cards

Unprovision the “standby” DS3 ATM card
first. If the DS3 ATM card you want to
unprovision is the “active” card, switch the
card to “standby” (refer to “Performing a
manual swact on the DS3 ATM core cards,”
in the UE9000 Data Testing and
Troubleshooting Guide). Once the switch is
complete, go to step 4
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tmif) you want to unprovision by doing the

ropriate Atmif symbol.

p-up menu, select:

f -> Lock ->Normal  (for ATM DS1)

 -> Normal  (for ATM DS3)

ppears asking if you are sure you want to

e disappears and the ATM core card is

 card by doing the following:

ropriate Atmif symbol.

p-up menu, select:

f -> Unprovision  (for ATM DS1)

ovision  (for ATM DS3)

ppears asking if you are sure you want to

8.

e disappears.

ysically still in the shelf, the symbol
 that it has been unprovisioned.

een removed from the shelf, the Atmif
Procedure 1-18 (continued)
Unprovisioning ATM core cards

Step Action

4 Lock the ATM core card (A
following:

a. Right-click on the app

b. From the symbol’s po

Maintenance -> Atmi

Maintenance -> Lock

A confirmation message a
“lockout” the card.

5 Click OK.

The confirmation messag
locked.

6 Unprovision the ATM core

a. Right-click on the app

b. From the symbol’s po

Maintenance -> Atmi

Maintenance -> Unpr

c. Go to step 7.

A confirmation message a
unprovision the card.

7 Click OK, then go to step

The confirmation messag

If the ATM core card is ph
becomes white, indicating

If the ATM core card has b
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symbol disappears from the submap, indicating that it has been
unprovisioned.

Note: The “configuring” annotation text appears when an ATM core
card is unprovisioned. Usually, the text disappears automatically after
approximately 10 - 20 seconds.

8 Repeat these steps for each ATM core card you want to unprovision.

—end—
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Procedure 1-19
Unprovisioning a UE9000 shelf

Use this procedure to unprovision a UE9000 shelf from the uEMS database.

Step Action

1 Go to the appropriate network element (NE) submap (see Figure 1-2
on page 1-6).

2 Confirm that [Read-Write] appears in the lower left corner of the
submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.

3 Right-click on the appropriate shelf’s symbol.

4 Select Maintenance -> Shelf -> Unprovision  from the symbol’s
pop-up menu.

A confirmation message appears asking if you are sure you want to
unprovision the shelf.

5 Click OK.

The confirmation message disappears. The symbol either becomes
white (if the hardware exists) or disappears from the submap (if the
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

hardware does not exist), indicating that it has been unprovisioned.

6 Repeat these steps for each UE9000 shelf you want to unprovision.

—end—
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on a network element (NE) from the uEMS

TP network submap (see Figure 1-2 on

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

iate NE’s symbol.

-> Unprovision from the symbol’s pop-up

ppears asking if you are sure you want to

e disappears. The symbol either becomes
ts) or disappears from the submap (if the

 indicating that it has been unprovisioned.

ch NE you want to unprovision.
Procedure 1-20
Unprovisioning a network element

Use this procedure to unprovisi
database.

Step Action

1 Go to the appropriate HS
page 1-6).

2 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

3 Right-click on the appropr

4 Select Maintenance -> NE
menu.

A confirmation message a
unprovision the NE.

5 Click OK.

The confirmation messag
white (if the hardware exis
hardware does not exist),

6 Repeat these steps for ea

—end—
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Procedure 1-21
Unprovisioning ATM service descriptors

Use this procedure to unprovision ATM service descriptors from the uEMS
database.

Note: To unprovision a service descriptor, every subscriber
cross-connect provisioned against that service descriptor must be
unprovisioned.

Step Action

1 Go to the appropriate SDG submap (see Figure 1-2 on page 1-6).

2 Confirm that [Read-Write] appears in the lower left corner of the
submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.

3 Right-click on the appropriate service descriptor’s (SD) symbol.

4 Select Unprovision  from the symbol’s pop-up menu.

A confirmation message appears asking if you are sure you want to
unprovision the service descriptor.
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5 Click OK.

The confirmation message disappears. The symbol either becomes
white (if the hardware exists) or disappears from the submap (if the
hardware does not exist), indicating that it has been unprovisioned.

6 Repeat these steps for each service descriptor you want to
unprovision.

—end—
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tor groups

on ATM service descriptor groups from the

 SD Config submap (see Figure 1-2 on

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

iate service descriptor group’s (SDG)

the symbol’s pop-up menu.

ppears asking if you are sure you want to
scriptor group.

e disappears. The symbol either becomes
ts) or disappears from the submap (if the

 indicating that it has been unprovisioned.

ch service descriptor group you want to
Procedure 1-22
Unprovisioning ATM service descrip

Use this procedure to unprovisi
uEMS database.

Step Action

1 Go to the appropriate ATM
page 1-6).

2 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

3 Right-click on the appropr
symbol.

4 Select Unprovision  from 

A confirmation message a
unprovision the service de

5 Click OK.

The confirmation messag
white (if the hardware exis
hardware does not exist),

6 Repeat these steps for ea
unprovision.

—end—
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Procedure 1-23
Viewing service descriptors

Use this procedure to view all service descriptors provisioned in the UE9000
element management system (uEMS) workstation’s database.

Action

Step Action

1 Go to the Root submap (see Figure 1-2 on page 1-6).

2 Right-click the HSTP-Network symbol.

3 Select Show -> Inventory -> Service Descriptors from the pop-up
menu.

4 Select the type of service descriptor that you wish to see.

The Service Descriptor Inventory window appears, listing all
provisioned service descriptors.

5 When you are finished, click the Close  button.

—end—
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p

porary UE9000 element management system
 (GUI) map.

s Read-Write access to the map. If a second
-Only access is the only access allowed. To get
t is already opened by another user, you must

f maps and submaps, seeAppendix A -

ew... from the pull-down menu.

ars.

 name of the temporary map that you are
porary Map 1 ).

ype the reason that you are creating the
This temporary map was created by John
ccess.”

nce
lete the temporary map when finished.
MS performance will be reduced.
Procedure 1-24
Opening a temporary read-write ma

Use this procedure to open a tem
(uEMS) graphical user interface

The first user to open a map ha
user opens the same map, Read
Read-Write access to a map tha
open a temporary map.

Note: For an explanation o
Understanding the uEMS.

Action

Step Action

1 Select Map -> Maps  -> N

The New Map dialog appe

2 In the Name field, type the
creating (for example, Tem

3 In the “Comments” field, t
temporary map, such as “
Doe to obtain read-write a

CAUTION
Loss of performa
Be sure to de
Otherwise, uE
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4 Click the OK button.

A temporary map with Read-Write access is created.

5 When finished using the temporary map, delete it by selecting:

Map -> Maps -> Open/List

The Available Maps dialog appears.

—continued—
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Procedure 1-24 (continued)
Opening a temporary read-write map

Step Action

6 On the Available Maps dialog, select the map and click the Delete
button.

The map is deleted.

—end—
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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2-1

Bulk provisioning data services 2-

This chapter contains information on bulk provisioning of the UE9000
equipment using UNIX scripts containing UE9000 Element Management
System (uEMS) command line user interface (CLUI) commands.

Note 1: The CLUI provides more provisionable parameters than uEMS.

Note 2: This chapter does not contain information on the initial set-up
and commissioning of the UE9000 data network. For this information,
see theUE9000 Data System Setup Guide.

Chapter contents
This chapter contains the following tasks.

Task See
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Provisioning multiple UE9000 components
using a UNIX script

Procedure 2-1 on page 2-29

Scheduling a UNIX script execution Procedure 2-2 on page 2-33
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ion UE9000 equipment, you need to collect
2-1.

formation

 you need this information

ame

ame

irtual path identifier (VPI)

ownstream service class

ownstream peak cell rate

ownstream minimum cell rate (for
BR-MCR service only)

ownstream sustainable cell rate (for
-VBR service only)

ownstream maximum burst size (for
-VBR service only)

ownstream cell delay variation tolerance

ownstream traffic descriptor

pstream service class

pstream peak cell rate

pstream minimum cell rate (for UBR-MCR
ervice only)

pstream sustainable cell rate (for rt-VBR
ervice only)

pstream maximum burst size (for rt-VBR
ervice only)
Overview
Before using the CLUI to provis
the information described inTable

Table 2-1
UE9000 component provisioning in

If you are provisioning this
UE9000 component Then

service descriptor group • n

service descriptor entry • n

• v

• d

• d

• d
U

• d
rt

• d
rt

• d

• d

• u

• u

• u
s

• u
s

• u
s

UE9000 DMS 297-8391-302 NA015

• upstream cell delay variation tolerance

• upstream traffic descriptor

—continued—
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network element (NE) • network element ID

Note: The name for UE9000 equipment is
usually the common language location
identifier (CLLI) of the equipment.

UE9000 shelf • shelf identifier name

• name of service descriptor group

ATM core card (ATM) • logical card number (A, B)

• Internet protocol (IP) address of the ATM
core card

• ATM core card software load name

DS1 carriers

Note: You do not need to
provision DS3 carriers.

• frame format

• line coding

• signal mode

• clock source

Table 2-1
UE9000 component provisioning information (continued)

If you are provisioning this
UE9000 component Then you need this information
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

xDSL multi-circuit line card
(MLC)

• logical card number (1 to 16)

• logical card number for UE9000 DMS
(0-15)

• line card software load name

1-Meg Modem MLC • logical card number (1 to 16)

• line card software load name

UE9000 DMS • logical card number (0 to 15)

• line card software load name

—continued—
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aximum downstream speed (kbs)

aximum upstream speed (kbs)

andwidth oversubscription factor for CBR

andwidth oversubscription factor for
-VBR

andwidth oversubscription factor for
BR-MCR

ownstream (central) target signal/noise
argin (dB)

ownstream (central) maximum interleave
elay (ms)

pstream (central) target signal/noise
argin (dB)

pstream (central) maximum interleave
elay (ms)

—end—

formation (continued)

 you need this information
ADSL subscriber circuit • m

• m

• b

• b
rt

• b
U

• d
m

• d
d

• u
m

• u
d

Table 2-1
UE9000 component provisioning in

If you are provisioning this
UE9000 component Then
UE9000 DMS 297-8391-302 NA015
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Using the CLUI
The CLUI uses the following syntax:

hstpprov [device-type] [operation] [device-name] [options]

where

[device-type] is one of:

config.ue.sdg

config.ue.sd

ne

shelf.ue

dac.ue.atmds1

dac.ue.atmds3

car.ue.ds1

car.ue.ds3

lc.ue.adsl4

cct.ue.adsl

for service descriptor group

for service descriptor

for NE

for shelf

for DS1 IMA ATM core card

for DS3 ATM core card

for DS1 IMA carrier

for DS3 carrier

for ADSL multi-circuit line card

for ADSL subscriber circuit
[operation] is one of:

provision

update

unprovision
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

UseTable 2-2 on page 2-7 to determine the provisioning command for each
of the UE9000 device types.

The uEMS assigns every UE9000 component an HSTP-name that uniquely
identifies it. The HSTP-name is used by uEMS to internally identify the
UE9000 components in its span of control. All CLUI commands require that
UE9000 components are identified by their HSTP-name.

HSTP-names follow the uEMS submap hierarchy. Each level in the hierarchy
is divided by a slash “/” in the HSTP-name. For example, the name of an ATM
core card contains the network element and the UE9000 shelf that the ATM
core card is connected to. HSTP-names can have alphanumeric and symbol
characters. Illegal characters include slashes, spaces, semicolons, or periods.

[device-name] is the unique name for the HSTP device
[options] is one or more options as shown in Table 2-3 through

Table 2-9.
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 device types, type the following at a HPUX

↵

 supported by the hstpprov command is

ionable parameters supported by a specific
device type:

↵

rs supported by the specified device type

inTable 2-2 on a single line. Some
r on multiple lines due to space limitations.
For more information about the
prompt:

cd /opt/OV/bin/Nortel/HSTP/uems

./hstpprov help ↵
An explanation of the device types
displayed.

For information about the provis
device type, type help after the 

cd /opt/OV/bin/Nortel/HSTP/uems

./hstpprov dac.ue.atmds1 help ↵
A list of the provisionable paramete
is displayed.

Note: Type the commands 
commands inTable 2-2appea
UE9000 DMS 297-8391-302 NA015
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Table 2-2
CLUI provisioning command formats

UE9000
component Provisioning command format

service
descriptor
group

./hstpprov config.ue.sdg provision SDG.[sdg_name]

where
[sdg_name] is the name of the service descriptor group

Example command:
./hstpprov config.ue.sdg provision SDG.G1

service
descriptor

./hstpprov config.ue.sd provision SDG.[sdg_name]/SD.[sd_name]
-atmTrafficDescrType_Downstream=[value1] -atmTrafficDescrParam1_Downstr
eam=[value2] -atmTrafficDescrType_Upstream=[value3] -atmTrafficDescrPara
m1_Upstream=[value4] -vpi=[vpi#] [options]

where
[sdg_ name] is the name of the service descriptor group
[sd_name] is the name of the service descriptor, for example, the Internet service
provider
[value1] is atmNoClpTaggingNoScr, atmNoClpNoScrCdvt,
atmClpNoTaggingMcr, atmClpTransparentNoScr, or atmClpTransparentScr
[value2] is an integer from 0 to 28744
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

[value3] is atmNoClpTaggingNoScr, atmNoClpNoScrCdvt,
atmClpNoTaggingMcr, atmClpTransparentNoScr, or atmClpTransparentScr
[value4] is an integer from 0 to 28744
[vpi#] is the virtual path identifier assigned to the service descriptor (0 to 255)
[options] are one or more optional parameters. See Table 2-3 on page 2-13.

Note: See Table 1-4 on page 1-16 for more information on these fields.

Example command:
./hstpprov config.ue.sd provision SDG.G1/SD.ISP2 -atmTrafficDescrType_
Downstream=atmNoClpTaggingNoScr -atmTrafficDescrParam1_Downstre
am=28744 -atmTrafficDescrType_Upstream=atmNoClpTaggingNoScr -atm
TrafficDescrParam1_Upstream=28744 -vpi=3

—continued—
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k element

 more information on this field.

ame]/SHELF.[shelf_name] -sdgroup=

k element

 descriptor group
ameters. See Table 2-4 on page 2-15.

 more information on these fields.

CA01/SHELF.1 -sdgroup=G1
network
element

./hstpprov ne provision NE.[NE_name]

where
[NE_name] is the name of the networ

Note: See Table 1-6 on page 1-24 for

Example command:
./hstpprov ne provision NE.SNFCCA01

UE9000 shelf ./hstpprov shelf.ue provision NE.[NE_n
[sdg_name] [options]

where
[NE_name] is the name of the networ
[shelf_name] is the name of the shelf
[sdg_name] is the name of the service
[options] are one or more optional par

Note: See Table 1-7 on page 1-27 for

Example command:
./hstpprov shelf.ue provision NE.SNFC

—continued—

Table 2-2
CLUI provisioning command formats (continued)

UE9000
component Provisioning command format
UE9000 DMS 297-8391-302 NA015
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ATM core card

DS1 IMA ./hstpprov dac.ue.atmds1 provision NE.[NE_name]/SHELF.[shelf_name]
/DAC.[card_#] -load=[load_name] -ipaddress=[ipaddress] [options]

DS3 ./hstpprov dac.ue.atmds3 provision NE.[NE_name]/SHELF.[shelf_name]
/DAC.[card_#] -load=[load_name] -ipaddress=[ipaddress] [options]

where
[NE_name] is the name of the network element
[shelf_name] is the name of the shelf
[card_#] is the logical card number of the ATM core card (A or B)
[load_name] is the file name of the ATM core card software load
[ipaddress] is the ipaddress of the ATM core card
[options] are one or more optional parameters. See Table 2-4 on page 2-15 and
Table 2-5 on page 2-16.

Note: See Table 1-8 on page 1-31 for more information on these fields.

Example command for DS1 IMA core card:
./hstpprov dac.ue.atmds1 provision NE.SNFCCA01/SHELF.1/DAC.A

Table 2-2
CLUI provisioning command formats (continued)

UE9000
component Provisioning command format
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

-load=HW203bl -ipaddress=193.6.54.81

—continued—
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_name]/SHELF.[shelf_name]
ons]

k element

the ATM core card (A or B)
 carrier (1 to 8)

ameters. See Table 2-6 on page 2-18.

 more information on these fields.

e, always provision the DS1s in sequential
S1 link number 1 must always be the IMA

between the IMA protocol implementation
ol implementation on other ATM devices.

are and software support IMA version 1.0.

FCCA01/SHELF.1/DAC.A/CAR.2

_name]/SHELF.[shelf_name]
ons]

k element

the ATM core card (A or B)
 carrier (1)

ameters. See Table 2-7 on page 2-20.

r more information on these fields.
DS1 IMA
carrier

./hstpprov car.ue.ds1 provision NE.[NE
/DAC.[card_#]/CAR.[DS1_link_#] [opti

where
[NE_name] is the name of the networ
[shelf_name] is the name of the shelf
[card_#] is the logical card number of 
[DS1_link_#] is the number of the DS1
[options] are one or more optional par

Note: See Table 1-9 on page 1-37 for

Note: To avoid loss of or erratic servic
order, starting with DS1 link number 1. D
timing reference link due to differences
on the ATM IF card and the IMA protoc

Note: The current ATM IF card hardw

Example command:
./hstpprov car.ue.ds1 provision NE.SN

DS3 carrier ./hstpprov car.ue.ds3 provision NE.[NE
/DAC.[card_#]/CAR.[DS3_link_#] [opti

where
[NE_name] is the name of the networ
[shelf_name] is the name of the shelf
[card_#] is the logical card number of 
[DS3_link_#] is the number of the DS3
[options] are one or more optional par

Note: See Table 1-10 on page 1-39 fo

Example command:

Table 2-2
CLUI provisioning command formats (continued)

UE9000
component Provisioning command format
UE9000 DMS 297-8391-302 NA015

./hstpprov car.ue.ds3 provision NE.SNFCCA01/SHELF.1/DAC.A/CAR.1

—continued—
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ADSL
multi-circuit
line card

./hstpprov lc.ue.adsl4 provision NE.[NE_name]/SHELF.[shelf_name]
/LC.[card_#] -load=[load_name] [options]

where
[NE_name] is the name of the network element
[shelf_name] is the name of the shelf
[card_#] is the logical card number of the ADSL MLC (1 to 16) or (0 to 15) for
UE9000 DMS
[load_name] is the file name of the line card software load
[options] are one or more optional parameters. See Table 2-8 on page 2-22.

Note: See Table 1-11 on page 1-43 for more information on these fields.

Example command:
./hstpprov lc.ue.adsl4 provision NE.SNFCCA01/SHELF.1/LC.4
-load=LC4X4FR02.0314

ADSL
subscriber
circuit

./hstpprov cct.ue.adsl provision NE.[NE_name]/SHELF.[shelf_name]
/LC.[card_#]/CCT.[circuit_#] [options]

where
[NE_name] is the name of the network element

Table 2-2
CLUI provisioning command formats (continued)

UE9000
component Provisioning command format
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

[shelf_name] is the name of the shelf
[card_#] is the logical card number of the ADSL MLC (1 to 16) or (0 to 15) for
UE9000 DMS
[circuit_#] is number of the subscriber circuit on the ADSL MLC (1 to 4)
[options] are one or more optional parameters. See Table 2-9 on page 2-22.

Note: See Table 1-12 on page 1-46 for more information on these fields.

Example command:
./hstpprov cct.ue.adsl provision NE.SNFCCA01/SHELF.1/LC.4/CCT.3

—continued—
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_name]/SHELF.[shelf_name]
_name],[lock_status],[VCI]

e circuit is already provisioned, substitute
mmand.

k element

the ADSL MLC (1 to 16) or (0 to 15) for

 circuit on the ADSL MLC
 descriptor group
(i.e., unlock)
ger). If you enter zero, a unique number

ameters. See Table 2-9 on page 2-22.

r more information on these fields.

CCs for an ADSL circuit, using # as

CA01/SHELF.1/LC.4/CCT.3
p,0
ADSL Virtual
Cross Connect

./hstpprov cct.ue.adsl provision NE.[NE
/LC.[card_#]/CCT.[circuit_#] -vcc=[sdg

Note: If you want to add a VCC after th
“update” for “provision” in the above co

where
[NE_name] is the name of the networ
[shelf_name] is the name of the shelf
[card_#] is the logical card number of 
UE9000 DMS
[circuit_#] is number of the subscriber
[sdg_name] is the name of the service
[lock_status] is down (i.e., lock) or up 
[VCI] is the virtual circuit identifier (inte
is automatically assigned.
[options] are one or more optional par

Note: See Table 1-12 on page 1-46 fo

Note: You can provision up to eight V
separators.

Example command:
./hstpprov cct.ue.adsl update NE.SNFC
-vcc=AOL,up,0#Sprint,up,0#Freenet,u

—continued—

—end—

Table 2-2
CLUI provisioning command formats (continued)

UE9000
component Provisioning command format
UE9000 DMS 297-8391-302 NA015
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Optional parameters
Note: You do not need to provision optional parameters. If you do not
provision a value, the default value is used.

Table 2-3 lists the provisionable attributes for the config.ue.sd device type.

Note: The DS1 IMA ATM core card supports unspecified bit rate (UBR)
service only. The DS3 ATM core card supports all service categories
listed inTable 2-3.

Table 2-3
Optional provisionable parameters for service descriptors

Parameter
Values (default values
are in bold) Description

-atmServiceCategory_Downstream= service class for the downstream virtual path

ubr unspecified bit rate

ubr-pcr unspecified bit rate with peak cell rate

ubr-mcr unspecified bit rate with minimum cell rate

cbr constant bit rate
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

rt-vbr real-time variable bit rate

-atmTrafficFrameDiscard_Downstream= If set to 'true', the data network will treat data in the
downstream direction, as frames (e.g. AAL5
CPCS_PDU's) rather than as individual cells. The
data network may discard entire frames during
congestion, rather than a few cells from many frames.

true

-atmTrafficDescrParam2_Downstream= downstream cell delay variation tolerance (CDVT)

32 bit integer (0)

-atmTrafficDescrParam3_Downstream= Refer to rfc2514. The Default value depends on the
service.

32 bit integer (0)

-atmTrafficDescrParam4_Downstream= Refer to rfc2514. The Default value depends on the
service.

32 bit integer (0)

—continued—
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s for the upstream virtual path

 bit rate

 bit rate with peak cell rate

 bit rate with minimum cell rate

t rate

riable bit rate

e', the data network will treat data in the
irection, as frames (e.g. AAL5
's) rather than as individual cells. The

rk may discard entire frames during
, rather than a few cells from many frames.

ell delay variation tolerance (CDVT)

2514. The Default value depends on the

2514. The Default value depends on the

2514. The Default value depends on the

s (continued)
-atmTrafficDescrParam5Downstream= Not used.

32 bit integer (0)

-atmServiceCategory_Upstream= service clas

ubr unspecified

ubr-pcr unspecified

ubr-mcr unspecified

cbr constant bi

rt-vbr real-time va

-atmTrafficFrameDiscard_Upstream= If set to 'tru
upstream d
CPCS_PDU
data netwo
congestion

true

-atmTrafficDescrParam2_Upstream= upstream c

32 bit integer (0)

-atmTrafficDescrParam3_Upstream= Refer to rfc
service.

32 bit integer (0)

-atmTrafficDescrParam4_Upstream= Refer to rfc
service.

32 bit integer (0)

-atmTrafficDescrParam5Upstream= Refer to rfc

Table 2-3
Optional provisionable parameters for service descriptor

Parameter
Values (default values
are in bold) Description
UE9000 DMS 297-8391-302 NA015

service.
32 bit integer (0)

—end—
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Table 2-4 lists the provisionable attributes for the dac.ue.atmds1 device type.

Table 2-4
Optional provisionable parameters for DS1 IMA ATM core cards

Parameter
Values (default values
are in bold) Description

-initialAdminState= state of the ATM core card at start-up

locked

unlocked

out-of-service

in-service

-atmInterfaceMaxVpcs= maximum number of virtual path connections (VPC)
supported at this ATM interface. At the ATM
user-network interface (UNI), the number of VPCs
allowed is 0 to 256 only.

0 to 4096 (0)

-atmInterfaceMaxVccs= maximum number of virtual channel connections
(VCC) supported at this ATM interface

0 to 65536 (0)

-atmInterfaceMaxActiveVpiBits= maximum number of active virtual path identifier (VPI)
bits configured for use at the ATM interface. At the
ATM UNI, the number of active VPI bits allowed is 0
to 8 only.

0 to 12 (0)
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

—continued—

-atmInterfaceMaxActiveVciBits= maximum number of active virtual circuit identifier
(VCI) bits configured for use at this ATM interface

0 to 16 (0)

-readcommunity= password for read access to the ATM core card

text string (public )

-writecommunity= password for read-write access to the ATM core card

text string (private )

—end—
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attributes for the dac.ue.atmds3 device type.

rds

 ATM core card at start-up

ice

umber of virtual path connections (VPC)
at this ATM interface. At the ATM
rk interface (UNI), the number of VPCs
0 to 256 only.

umber of virtual channel connections
ported at this ATM interface

umber of active virtual path identifier (VPI)
red for use at the ATM interface. At the
he number of active VPI bits allowed is 0

umber of active virtual circuit identifier
onfigured for use at this ATM interface

 which connections provisioned for
t rate (CBR) may be oversubscribed on a
k

le, a value of 2 means that twice the
physical bandwidth may be allocated by
ned connections.
Table 2-5lists the provisionable

Table 2-5
Optional provisionable parameters for DS3 ATM core ca

Parameter
Values (default values
are in bold) Description

-initialAdminState= state of the

locked

unlocked

out-of-serv

in-service

-atmInterfaceMaxVpcs= maximum n
supported 
user-netwo
allowed is 

0 to 4096 (0)

-atmInterfaceMaxVccs= maximum n
(VCC) sup

0 to 65536 (512)

-atmInterfaceMaxActiveVpiBits= maximum n
bits configu
ATM UNI, t
to 8 only.

0 to 12 (8)

—continued—

-atmInterfaceMaxActiveVciBits= maximum n
(VCI) bits c

0 to 16 (16)

-circuitOvSubsCBR amount by
constant bi
physical lin

For examp
amount of 
the provisio

0 to 100 (1)
UE9000 DMS 297-8391-302 NA015

-circuitOvSubsUBRMCR amount by which connections provisioned for
unspecified bit rate with minimum cell rate
(UBR-MCR) may be oversubscribed on a physical
link

For example, a value of 2 means that twice the
amount of physical bandwidth may be allocated by
the provisioned connections.

0 to 100 (1)
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-circuitOvSubsvtVBR amount by which connections provisioned for
real-time variable bit rate (rt-VBR) may be
oversubscribed on a physical link

For example, a value of 2 means that twice the
amount of physical bandwidth may be allocated by
the provisioned connections.

0 to 100 (1)

-snmpretry The number of retries for SNMP commands (i.e., set,
get...)

0 to 2147483647 (3)

-snmptimeout Timeout between retries for SNMP commands

0 to 2147483647 (1000)

-expectedRxCellThroughout maximum transmit bandwidth configured for this
interface for use with connection admission control
(CAC); measured in cells/second0 to 2147483647

(100000)

—continued—

Table 2-5
Optional provisionable parameters for DS3 ATM core cards (continued)

Parameter
Values (default values
are in bold) Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

-expectedTxCellThroughout maximum receive bandwidth configured for this
interface for use with connection admission control
(CAC); measured in cells/second0 to 2147483647

(100000)

-unitActivity specifies whether the DS3 ATM core card is the
active ATM core card, or the standby ATM core card

[active] [standby]
(active )

-readcommunity= password for read access to the ATM core card

text string (public )

-writecommunity= password for read-write access to the ATM core card

text string (private )

—end—
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attributes for the car.ue.ds1 device type.

 DS1 IMA carrier at start-up

ice

chronization clock for the DS1

eceive clock used as the transmit clock

-running clock used as the transmit clock

eceive clock from another interface used
mit clock

acilities data link (FDL)

mended FDL exchange

uperframe FDL exchange

hange used by the DS1

at of the DS1 path. Frame format affects
of bits per second that the DS1 can carry.

uperframe

rmat framing

coding

 eight zero substitution. Uses a specified
ormal bits and bipolar violations to replace
 of eight zero bits.
Table 2-6 lists the provisionable 

Table 2-6
Optional provisionable parameters for DS1 IMA carriers

Parameter
Values (default values
are in bold) Description

-initialAdminState= state of the

locked

unlocked

out-of-serv

in-service

-dsx1TransmitClockSource= primary syn

loopTiming

localTiming

throughTiming

recovered r

internal free

recovered r
as the trans

-dsx1Fdl= use of the f

dsx1Ansi-T1-403

dsx1Att-54016

dsx1Fd1-none

ANSI recom

extended s

no FDL exc

-dsx1LineType= framing form
the number

dsx1ESF

dsx1D4

extended s

AT&T D4 fo

-dsx1LineCoding= DS1 line en

dsx1B8ZS bipolar with
pattern of n
a sequence
UE9000 DMS 297-8391-302 NA015

dsx1AMI alternate mark inversion. No zero code suppression is
used. The higher layer must provide data which
meets or exceeds the pulse density requirements,
such as inverting HDLC data.

—continued—
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-dsx1SendCode= type of code sent across the DS1 interface

dsx1SendNoCode

dsx1SendLineCode

dsx1SendPayloadCode

dsx1SendResetCode

looped or normal data

line loopback request

payload loopback request

loopback termination request

-dsx1CircuitIdentifier= transmission vendor's circuit identifier. Used to
troubleshoot.

text string (0 to 255)

-dsx1LoopbackConfig= loopback configuration of the DS1 interface

dsx1NoLoop

dsx1PayloadLoop

dsx1LineLoop

not in the loopback state

received signal is looped through the device.
Typically the received signal is looped back for
re-transmission after it has passed through the
device's framing function

received signal does not go through the device

Table 2-6
Optional provisionable parameters for DS1 IMA carriers (continued)

Parameter
Values (default values
are in bold) Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

(minimum penetration) but is looped back out

—end—
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attributes for the car.ue.ds3 device type.

 DS3 carrier at start-up

ice

tion is used to locate the cell boundaries

e transmission on 12 rows of ATM cells
icroseconds

chronization clock for the DS3

eceive clock used as the transmit clock

-running clock used as the transmit clock

eceive clock from another interface used
mit clock

at of the DS3 path. Frame format affects
of bits per second that the DS3 can carry.

.107a-1989

.107-1988

coding

 three zero substitution bits. Uses a
ttern of normal bits and bipolar violations
 sequence of three zero bits.
Table 2-7 lists the provisionable 

Table 2-7
Optional provisionable parameters for DS3 carrier

Parameter
Values (default values
are in bold) Description

-initialAdminState= state of the

locked

unlocked

out-of-serv

in-service

-carrDS3ConvSublayerMap=

direct cell mapping

phylayerConvPr

cell delinea

activates th
every 125 m

-dsx3TransmitClockSource= primary syn

loopTiming

localTiming

throughTiming

recovered r

internal free

recovered r
as the trans

-dsx3LineType= framing form
the number

dsx3CbitParity

dsx3M23

for ANSI T1

for ANSI T1

-dsx3LineCoding= DS3 line en

dsx3B3ZS bipolar with
specified pa
to replace a
UE9000 DMS 297-8391-302 NA015

—continued—
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-dsx3SendCode= type of code sent across the DS1 interface

dsx3SendNoCode

dsx3SendLineCode

dsx3SendPayloadCode

dsx3SendResetCode

looped or normal data

line loopback request

payload loopback request

loopback termination request

-dsx3CircuitIdentifier= transmission vendor's circuit identifier. Used to
troubleshoot.

text string (0 to 255)

—continued—

-dsx3LoopbackConfig= loopback configuration of the DS1 interface

dsx3NoLoop

dsx3PayloadLoop

not in the loopback state

received signal is looped through the device.
Typically the received signal is looped back for
re-transmission after it has passed through the
device's framing function

Table 2-7
Optional provisionable parameters for DS3 carrier (continued)

Parameter
Values (default values
are in bold) Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

dsx3LineLoop received signal does not go through the device
(minimum penetration) but is looped back out

-dsx3PayloadScrambling payload scrambling; removes long strings of 1s and
0s that could be mistaken as error conditions

SCR-ON

SCR-OFF

payload scrambling enabled

payload scrambling disabled

—end—
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attributes for the lc.ue.adsl4 device type.

attributes for the cct.ue.adsl device type.

t line cards

ware load for the line card

oduct Engineering Code (PEC). Use to
between different types of line cards.

 ADSL MLC at start-up

ice

circuits

 ADSL modem at start-up

ice

 ADSL subscriber circuit at start-up

ice

ansmit rate for Interleave channels in bits
Table 2-8 lists the provisionable 

Table 2-9 lists the provisionable 

Table 2-8
Optional provisionable parameters for ADSL multi-circui

Parameter
Values (default values
are in bold) Description

-lcProvSoftware= default soft

text string

-lcProvPec= line card Pr
distinguish 

text string

-initialAdminState= state of the

locked

unlocked

out-of-serv

in-service

Table 2-9
Optional provisionable parameters for ADSL subscriber 

Parameter
Values (default values
are in bold) Description

-initialCctAdminState= state of the

locked

unlocked

out-of-serv

in-service

-initialAdminState= state of the

locked

unlocked

out-of-serv

in-service

-adslAtucChanConfInterleaveMinTxRate= minimum tr
UE9000 DMS 297-8391-302 NA015

per second (bps). See ATUR transmit rate for receive
rates.0 to 13380 bps in

multiples of 32 (32)

—continued—
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-adslAtucChanConfInterleaveMaxTxRate
=

maximum transmit rate for Interleave channels in bps.
See ATUR transmit rate for ATUC receive rates.

0 to 13380 bps in
multiples of 32 (13376)

-adslAtucChanConfMaxInterleaveDelay= maximum Interleave delay for this channel.

Use only on the interleave channel. Defines the
mapping (relative spacing) between subsequent input
bytes at the interleaver input and the byte placement
in the bit stream at the interleaver output. Larger
numbers provide greater separation between
consecutive input bytes in the output bit stream
allowing for improved impulse noise immunity at the
expense of payload latency. Currently not
configurable.

0 to 900(0)

-adslAturConfRateMode= transmit rate adaptation configured on the modem.

fixed

Table 2-9
Optional provisionable parameters for ADSL subscriber circuits (continued)

Parameter
Values (default values
are in bold) Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

adaptAtStartup

adaptAtRuntime

-adslAturConfTargetSnrMgn= target signal/noise margin. Noise margin the modem
must achieve with a BER of 10-7 or better to
successfully complete initialization.

Note: The recommended setting for G.Lite is 4 dB;
the default is not automatically changed when G.Lite
is provisioned.

0 to 15 (6)

-adslAtucConfRateMode= transmit rate adaptation configured on the ADSL
MLC.

fixed

adaptAtStartup

adaptAtRuntime

—continued—
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ansmit rate for Interleave channels in bps.
 transmit rate for ATUR receive rates.

ransmit rate for Interleave channels in bps.
 transmit rate for ATUR receive rates.

nterleave delay for this channel.

 the interleave channel. Defines the
lative spacing) between subsequent input
interleaver input and the byte placement

ream at the interleaver output. Larger
ovide greater separation between
 input bytes in the output bit stream
 improved impulse noise immunity at the
 payload latency.

l/noise margin. Noise margin the ADSL
achieve with a BER of 10-7 or better to
y complete initialization.

 recommended setting for G.Lite is 4 dB;
is not automatically changed when G.Lite
ed.

forward error correction errors which can
e interleaved data stream within a 15
od before a circuitAtucThreshFecITrap is

loss of cell delineation errors which can
e interleaved data stream within a 15
od before a circuitAtucThreshLcdITrap is

circuits (continued)
-adslAturChanConfInterleaveMinTxRate= minimum tr
See ATUC

0 to 1440 bps (32)

-adslAturChanConfInterleaveMaxTxRate= maximum t
See ATUC

0 to 1440 bps (1440)

-adslAturChanConfMaxInterleaveDelay= maximum I

Use only on
mapping (re
bytes at the
in the bit st
numbers pr
consecutive
allowing for
expense of

0 to 256 (10)

-adslAtucConfTargetSnrMgn= target signa
MLC must 
successfull

Note: The
the default
is provision

0 to 15 (6)

-circuitAtuc15MinThreshFecI= number of 
occur on th
minute peri
generated

0 to 2147483647 (900)

-circuitAtuc15MinThreshLcdI= number of 
occur on th
minute peri0 to 2147483647 (25)

Table 2-9
Optional provisionable parameters for ADSL subscriber 

Parameter
Values (default values
are in bold) Description
UE9000 DMS 297-8391-302 NA015

generated

-circuitAtuc15MinThreshCrcI= number of cyclical redundancy check errors which
can occur on the interleaved data stream within a 15
minute period before a circuitAtucThreshCrcITrap is
generated

0 to 2147483647 (500)

—continued—
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-circuitAtuc15MinThreshHecI= number of header error check errors which can occur
on the interleaved data stream within a 15 minute
period before a circuitAtucThreshHecITrap is
generated

0 to 2147483647 (50)

-adslAtucInitFailureTrapEnable= enables and disables the InitFailure trap

enable

disable

-adslAturThresh15MinLofs= number of loss of frame errors, in seconds, which can
occur on the modem ADSL interface within a 15
minute period before an adslAtucPerfLofsThresh trap
is generated.

0 disables the trap.

0 to 900 seconds (25)

-adslAturThresh15MinLoss= number of loss of signal errors, in seconds, which can
occur on the modem ADSL interface within a 15
minute period before an adslAtucPerfLossThresh
trap is generated.

0 to 900 seconds (25)

Table 2-9
Optional provisionable parameters for ADSL subscriber circuits (continued)

Parameter
Values (default values
are in bold) Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

0 disables the trap.

-adslAturThresh15MinLprs= number of loss of power errors, in seconds which can
occur on the modem ADSL interface within a 15
minute period before an adslAtucPerfLprsThresh trap
is generated.

0 disables the trap.

0 to 900 (25)

-adslAturThresh15MinESs= number of errored seconds which can occur on the
modem ADSL interface within a 15 minute period
before an adslAtucPerfESsThresh trap is generated.

0 disables the trap.

0 to 900 (800)

-adslAtucThresh15MinLofs= number of loss of frame errors, in seconds, which can
occur on the ADSL MLC interface within a 15 minute
period before an adslAtucPerfLofsThresh trap is
generated.

0 disables the trap.

0 to 900 (25)

—continued—
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oss of signal errors, in seconds, which can
e ADSL MLC interface within a 15 minute
re an adslAtucPerfLossThresh trap is

the trap.

oss of power errors, in seconds which can
e ADSL MLC interface within a 15 minute
re an adslAtucPerfLprsThresh trap is

the trap.

errored seconds which can occur on the
interface within a 15 minute period before
PerfESsThresh trap is generated.

the trap.

r of failed fast retrains in a 15 minute
t may occur before an
reshold15MinFailedFastRThresh trap is

umber of virtual path connections (VPC)
t this ATM interface. At the ATM

rk interface (UNI), the number of VPCs
 to 256 only.

umber of virtual channel connections
orted at this ATM interface

umber of active virtual path identifier (VPI)
red for use at the ATM interface. At the

circuits (continued)
-adslAtucThresh15MinLoss= number of l
occur on th
period befo
generated.

0 disables 

0 to 900 (25)

-adslAtucThresh15MinLprs= number of l
occur on th
period befo
generated.

0 disables 

0 to 900 (1)

-adslAtucThresh15MinESs= number of 
ADSL MLC
an adslAtuc

0 disables 

0 to 900 (500)

-adslAtucThreshold15MinFailedFastR The numbe
window tha
adslAtucTh
generated.

0 to 900 (0)

-atmInterfaceMaxVpcs= maximum n
supported a
user-netwo
allowed is 0

0 to 4096 (0)

-atmInterfaceMaxVccs= maximum n
(VCC) supp

0 to 65536 (0)

-atmInterfaceMaxActiveVpiBits= maximum n
bits configu

Table 2-9
Optional provisionable parameters for ADSL subscriber 

Parameter
Values (default values
are in bold) Description
UE9000 DMS 297-8391-302 NA015

ATM UNI, the number of active VPI bits allowed is 0
to 8 only.

0 to 12 (0)

-atmInterfaceMaxActiveVciBits= maximum number of active virtual circuit identifier
(VCI) bits configured for use at this ATM interface

0 to 16 (0)

—continued—
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-gLiteAtuFastRetrainEnabling This value allows the fast retrain operation to occur on
a G.Lite circuit. Disabling this setting will inhibit fast
retrain whether or not the circuit has microfilters.

enabled (1)
disabled(2)

-gLiteFastRetrainSNRMargin determines how strictly profiles are selected during a
fast retrain; the delta is to be met with a given profile
between measured SNR margin at the time of fast
retrain, target SNR margin, and the stored profile
SNR margin, on a per carrier basis; for G.Lite only.

Note: Changing the profile selection tolerance may
result in a full retrain of the circuit.

Note: A higher value increases the possibility of a
profile match, but may result in sub-optimal
performance. A lower value will decrease the
possibility of a profile match, but may result in more
full link retrains than necessary.

0 to 15 (3)

Table 2-9
Optional provisionable parameters for ADSL subscriber circuits (continued)

Parameter
Values (default values
are in bold) Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

-vcc= virtual channel connection

0 to 65535 (0) An entry of 0 causes uEMS to automatically assign a
unique identifier.

-transmissionModeEnabling This parameter is valid for any ADSL circuit. It is used
to choose in which services the circuit is allowed to
operate. The service selection parameter allows one
or all services to be enabled on a given circuit.

autodetect (1)

t1413ANSI (2)

glite (3)

gdmtITUT (4)

—end—
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ision a multi-circuit line card (MLC) to a
ut changing the circuit address and without

ware present in the UE9000 shelf.

are not usable until the hardware is replaced
ave been provisioned. SeeProcedure 1-13 on

ature is:

C] forceProvision NE.[NE_name]

on NE.1/SHELF.1/LC.2

 1, shelf 1, slot 2 is provisioned as a ADSL
generates a “h/w mismatch” alarm until the
visioning is installed in that slot.

 the device type for the MLC that will
place the existing MLC (see page 2-5)
 the name of the network element
 the name of the shelf
 the logical card number of the MLC
Force provisioning
You can use the CLUI to reprov
different type of hardware witho
immediately changing the hard

However, the subscriber circuits
and the new subscriber circuits h
page 1-60 for more information.

The command format for this fe

./hstpprov [device type for new ML
/SHELF.[shelf_name]/LC.[card_#]

Example command:

./hstpprov lc.ue.adsl4  forceProvisi

In this example, the MLC in NE
multi-circuit line card. The shelf
hardware matching the new pro

where

[device type for new MLC] is
re

[NE_name] is
[shelf_name] is
[card_#] is
UE9000 DMS 297-8391-302 NA015
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Procedure 2-1
Provisioning multiple UE9000 components using a UNIX
script

Use this procedure to provision a number of Universal Edge 9000 (UE9000)
components in the UE9000 element management system (uEMS) database at
one time. You can provision a UE9000 component before the hardware device
is physically installed.

Before you begin
You need a basic knowledge of UNIX.

You need the information listed inTable 2-1for the UE9000 components you
are provisioning.

Action

Step Action

Open the text editor
1 Log into the workstation and open a text editor window.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Create a script
2 Type in the UE9000 components you want to provision in the uEMS

database. Use the uEMS command line user interface (CLUI)
command format for each UE9000 component entered. See
Table 2-2 on page 2-7 for detailed information on the CLUI command
formats.

To start a new line after each entry, press the Return  key.

Note 1: Include the prefix hstpprov only if you plan to delay the script
file execution (see Procedure 2-2, “Scheduling a UNIX script
execution” on page 2-33).

Note 2: Type these commands on a single line. Some of the
commands below appear on multiple lines due to space limitations.

—continued—
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 UNIX script

P2 -atmTrafficDescrType_Down
TrafficDescrParam1_Downstream=2
=atmNoClpTaggingNoScr -atmTra
pi=3

ELF.1 -sdgroup=G1

01/SHELF.1/DAC.A
1

 SHELF.1/DAC.A/CAR.1

 SHELF.1/DAC.A/CAR.2

 SHELF.1/DAC.A/CAR.3

 SHELF.1/DAC.A/CAR.4

 SHELF.1/DAC.A/CAR.5

 SHELF.1/DAC.A/CAR.6
Procedure 2-1 (continued)
Provisioning multiple UE9000 components using a

Step Action

Example of a script
config.ue.sdg provision SDG.G1

config.ue.sd provision SDG.G1/SD.IS
stream=atmNoClpTaggingNoScr -atm
8744 -atmTrafficDescrType_Upstream
fficDescrParam1_Upstream=28744 -v

ne provision NE.SNFCCA01

shelf.ue provision NE.SNFCCA01/ SH

dac.ue.atmds1 provision NE.SNFCCA
-load=HW203bl -ipaddress=193.6.54.8

car.ue.ds1 provision NE.SNFCCA01/

car.ue.ds1 provision NE.SNFCCA01/

car.ue.ds1 provision NE.SNFCCA01/

car.ue.ds1 provision NE.SNFCCA01/

car.ue.ds1 provision NE.SNFCCA01/

car.ue.ds1 provision NE.SNFCCA01/

—continued—
UE9000 DMS 297-8391-302 NA015
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Procedure 2-1 (continued)
Provisioning multiple UE9000 components using a UNIX script

Step Action

car.ue.ds1 provision NE.SNFCCA01/ SHELF.1/DAC.A/CAR.7

car.ue.ds1 provision NE.SNFCCA01/ SHELF.1/DAC.A/CAR.8

lc.ue.adsl4 provision NE.SNFCCA01/SHELF.1/LC.4 -load=LC4X4FR02.
0314

cct.ue.adsl provision NE.SNFCCA01/SHELF.1/LC.4/CCT.1

cct.ue.adsl provision NE.SNFCCA01/SHELF.1/LC.4/CCT.2

cct.ue.adsl provision NE.SNFCCA01/SHELF.1/LC.4/CCT.3

cct.ue.adsl provision NE.SNFCCA01/SHELF.1/LC.4/CCT.4

cct.ue.adsl update NE.SNFCCA01/SHELF.1/LC.4/CCT.1
-vcc=AOL,up,0#Sprint,up,0

cct.ue.adsl update NE.SNFCCA01/SHELF.1/LC.4/CCT.2
-vcc=AOL,up,0#Sprint,up,0
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

cct.ue.adsl update NE.SNFCCA01/SHELF.1/LC.4/CCT.3
-vcc=AOL,up,0#Sprint,up,0

cct.ue.adsl update NE.SNFCCA01/SHELF.1/LC.4/CCT.4
-vcc=AOL,up,0#Sprint,up,0

3 Save the file and exit the text editor.

—continued—
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 UNIX script

 in the uEMS database
ata immediately, type the following at a

P/uems ↵
e_name] ↵

on page 2-33 for instructions on scheduling
ture time or date.

isioning data
.txt

required special character that tells the
tpprov  command to reference the file
me that follows. Type this character
actly as shown. See the example below.

IX directory path where the text file
ntaining the provisioning data is located

me of the text file
Procedure 2-1 (continued)
Provisioning multiple UE9000 components using a

Step Action

Provision the UE9000 components
4 To input the provisioning d

UNIX prompt:

cd /opt/OV/bin/Nortel/HST

./hstpprov < [directory]/[fil

Note: See Procedure 2-2
the script file to run at a fu

Example of command to input prov
./hstpprov < /tmp/cmds

—end—

where

< a 
hs
na
ex

[directory] UN
co

[file_name] na
UE9000 DMS 297-8391-302 NA015
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Procedure 2-2
Scheduling a UNIX script execution

Use this procedure to schedule a future time for the workstation to execute a
UNIX script. Theat command executes the commands stored in a script file
at a specified time and date.

Requirements
You must create a script file that includes ahstpprov prefix for each
command. For information on creating the script file, seeProcedure 2-1 on
page 2-29.

Action

Step Action

1 Ensure that your user name is in the /var/adm/cron/at.allow  file.

2 Issue the at command at the UNIX prompt using the following format:

at -f [script filename] [time-date]

where
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Note: See the UNIX man pages for more information on using the at
command.

—continued—

[script filename] the path and name of the script file created
in Procedure 2-1 on page 2-29

[time-date] the time that you want the at file to run

Examples:

now + 10 minutes

8:15pm Sep 15

1300 tomorrow

noon 10/31/99

0930 monday
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a DS1 IMA ATM core card at 9:30 a.m. on
at command consists of the following line:

onday

yscript file includes the following line:

uems/hstpprov dac.ue.atmds1
/SHELF.1/DAC.A -load=HW203bl
Procedure 2-2 (continued)
Scheduling a UNIX script execution

Step Action

Example
For example, to provision
the following Monday, the

at -f /tmp/myscript 0930 m

In this example, the /tmp/m

/opt/OV/bin/Nortel/HSTP/
provision NE.SNFCCA01
-ipaddress=193.6.54.81

—end—
UE9000 DMS 297-8391-302 NA015
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Software management 3-

This chapter describes how to manage the software for the
Universal Edge 9000 (UE9000) system.

Note: Some UE9000 data equipment procedures, such as posting
equipment screens for UE9000 data equipment, can be performed using
the access bandwidth manager’s (ABM) network element user interface
(NEUI). For information on these procedures, see theUE9000 Voice
OAM&P User Guide.

Chapter contents
This chapter includes the following topics:

• Software upgrade process on page 3-2
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

• Administering the HP OpenView database on page 3-7

• Network and user security on page 3-13

This chapter contains the following tasks:

Task See

Loading UE9000 software on the uEMS
workstation

Procedure 3-1 on page 3-3

Upgrading ATM and line card loads Procedure 3-2 on page 3-4

Monitoring the /var partition Procedure 3-3 on page 3-8

—continued—
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pgrade process for the Universal Edge 9000

S Procedure 3-4 on page 3-10

Procedure 3-5 on page 3-12

end—

See

e on the uEMS Procedure 3-1 on
page 3-3

card loads Procedure 3-2 on
page 3-4

See
Software upgrade process
Table 3-1outlines the software u
(UE9000) data equipment.

Backing up and restoring the uEM
workstation databases

Upgrading the uEMS software

—

Table 3-1
Software upgrade process

Step Task

1 Loading UE9000 softwar
workstation

2 Upgrading ATM and line 

Task
UE9000 DMS 297-8391-302 NA015
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Procedure 3-1
Loading UE9000 software on the uEMS workstation

Use this procedure to load software for the ATM core card and the xDSL
multi-circuit line card (MLC) on the UE9000 element management system
(uEMS) workstation.

Action

Step Action

1 Read the instructions that accompany the new software load. Follow
those instructions to install the load on the uEMS workstation that
manages the ATM core card and xDSL MLC equipment.

2 Go to Procedure 3-2 on page 3-4.

—end—
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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r change the software load on the UE9000

lineup (version) information for AccessNode
and DS3), and MLCs, selectHelp -> Nortel

 The systems displays software version
nd two previous releases.

u updating?

 of equipment
ee Figure 1-2 on page 1-6).

 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

mponent that you want to update.

are upgrade, all data traffic on the ATM
opped. Traffic cannot be restored until the
ade is finished.

Then

go to step 2

 shelf go to step 7

n NE go to step 13
Procedure 3-2
Upgrading ATM and line card loads

Use this procedure to update o
equipment.

Note: To see software load
release, uEMS, ATMIF (DS1
uEMS-> uEMS Load Lineup .
information for the current a

1 How many devices are yo

Updating provisioning for one piece
2 Go to the shelf submap (s

3 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

4 Right click the UE9000 co

CAUTION
Loss of service
During a softw
core card is dr
software upgr

If you are updating

one piece of equipment

all similar equipment on a

all similar equipment on a
UE9000 DMS 297-8391-302 NA015

5 Select Change [device] Provisioned Load  from the pop-up menu.

The Load Selection Pop-up dialog appears.

—continued—
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Procedure 3-2 (continued)
Upgrading ATM and line card loads

Step Action

6 Select the desired load from the list of available loads and click OK.

The Load Selection Pop-up dialog disappears. The provisioned load
is changed in the uEMS database. The new load will be sent to the
equipment the next time you issue a a restart reload command. See
the UE9000 Data Testing and Troubleshooting Guide for procedures.

Note: If you have two DS3 ATM core cards in the shelf, outage time
during software upgrades can be minimized by loading the new
software version on the “standby” DS3 card, and then performing a
swact (“standby” card will become the “active” card). The new
software version can then be loaded on the other DS3 card. For
information on performing a swact, refer to the UE9000 Data Testing
and Troubleshooting Guide.

Updating provisioning for all similar equipment on a shelf
7 Go to the NE submap (see Figure 1-2 on page 1-6).

8 Confirm that [Read-Write] appears in the lower left corner of the
submap. If you do not have read-write access, see Procedure 1-24,
“Opening a temporary read-write map” on page 1-82.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

9 Right click the appropriate symbol for the shelf that you want to
update.

10 Select Attribute Change -> All [equipment] Loads from the pop-up
menu.

A confirmation message appears asking if you are sure you want to
change the loads of all the equipment you selected.

11 Click OK.

The Load Selection Pop-up dialog appears.

12 Select the desired load from the list of available loads and click OK.

The Load Selection Pop-up dialog disappears. The provisioned load
is changed in the uEMS database. The new load will be sent to the
equipment the next time you issue a a restart reload command. See
the UE9000 Data Testing and Troubleshooting Guide for procedures.

Updating provisioning for all similar equipment on an NE
13 Go to the HSTP-network submap (see Procedure 1-24, “Opening a

temporary read-write map” on page 1-82).

—continued—
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 appears in the lower left corner of the
e read-write access, see Procedure 1-24,
d-write map” on page 1-82.

symbol for the NE that you want to update.

All [equipment] Loads from the pop-up

ppears asking if you are sure you want to
 equipment you selected.

p dialog appears.

m the list of available loads and click OK.

p dialog disappears. The provisioned load
atabase. The new load will be sent to the
ou issue a a restart reload command. See
and Troubleshooting Guide for procedures.
Procedure 3-2 (continued)
Upgrading ATM and line card loads

Step Action

14 Confirm that [Read-Write]
submap. If you do not hav
“Opening a temporary rea

15 Right click the appropriate

16 Select Attribute Change ->
menu.

A confirmation message a
change the loads of all the

17 Click OK.

The Load Selection Pop-u

18 Select the desired load fro

The Load Selection Pop-u
is changed in the uEMS d
equipment the next time y
the UE9000 Data Testing

—end—
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Administering the HP OpenView database
As the Hewlett Packard OpenView (HPOV) OVWDB database increases in
size, the HPOV and uEMS GUI will decrease in performance and respond
slower than usual. In addition, the increasing size of the database increases the
likelihood of database corruptions.

If the OVWDB database becomes corrupted, the workstation’s entire database
must be erased to remove the corruption. Database information for all
applications running on the HPOV workstation will be lost.

To prevent this from happening, a system administrator should be assigned to
manage the HPOV database and keep the database at a proper size. Two ways
to manage the OVWDB database are:

• monitoring the /var partition (seeProcedure 3-3, “Monitoring the /var
partition” on page 3-8)

• performing periodic database backups (seeProcedure 3-4, “Backing up
and restoring the uEMS workstation databases” on page 3-10)
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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he /var partition on the UE9000 element
orkstation.

var partition to log events. Events are logged
 /var partition:

.log
rtain limit, HPOV renames the log file and
w file with the above file name.

l/HSTP

 disk space is almost full is that the Event
than usual.

cleanup utility to remove patch installation
t patch information. Type the following at a

 corruption
 becomes corrupted if the log files in
are/log/Nortel/HSTP exceed the disk
to the /var partition. You can avoid this by

r log files to tape periodically.
Procedure 3-3
Monitoring the /var partition

Use this procedure to monitor t
management system (uEMS) w

Many UNIX processes use the /
to the following UNIX files in the

• /var/opt/OV/share/log/trapd
When this log reaches a ce
continues logging into a ne

• /var/opt/OV/share/log/Norte

One sign that the /var partition’s
Browser window opens slower 

Action

Step Action

1 Periodically run the HPUX
backup files and redundan
terminal window:

cleanup ↵

CAUTION
Risk of database
The database
/var/opt/OV/sh
space allotted
archiving you
UE9000 DMS 297-8391-302 NA015

The cleanup utility executes.

See the HPUX man pages on this utility for more information.

—continued—
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Procedure 3-3 (continued)
Monitoring the /var partition

Step Action

2 To prevent the /var partition’s disk space from filling up, weekly
maintenance must be performed. This includes:

• checking the available space of the /var partition (see step 3)

• reducing the files in the /var partition, if necessary (see step 4)

3 Check the size of the /var partition by opening a terminal window on
the uEMS workstation. At the UNIX prompt, type:

bdf ↵

Output similar to the following appears.

Filesystem kbytes used avail %used Mounted on
/dev/vg00/lvo13 131072 35494 89605 28% /
/dev/vg00/lvo13 47829 13717 29329 32% /stand
/dev/vg00/lvo18 409600 276012 123579 69% /var
/dev/vg00/lvo17 409600 326502 77457 81% /usr
/dev/vg00/lvo15 409600 278431 122470 69% /opt
/dev/vg00/lvo11 1024000 184095 787382 19% /opt/nortel

4 If the /var partition is more than 95 percent full, call your system
administrator to archive and delete unused files.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

The system administrator should concentrate first on directories that
experience high disk usage.

—end—
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workstation databases

nd restore the databases on the UE9000
uEMS) workstation.

superuser privileges.

n the uEMS workstation and back up the

uems/uemsbackup ↵
s are backed up in the /opt/uEMSbackup/
ilar to backup.13Jul1999_1730:00.

, Nortel recommends that you periodically
up file to tape or CD.

and reports that it fails to do a backup
 busy, type the following then go to step 1:

uems/uemsbackup ↵

nitoring
itoring of the full network takes place
owing procedure. Events/alarms
 raised only once the procedure is
Procedure 3-4
Backing up and restoring the uEMS 

Use this procedure to back up a
element management system (

Action

Step Action

Back up the databases
1 Make sure that you have 

2 Open a terminal window o
databases by typing:

/opt/OV/bin/Nortel/HSTP/

The workstation database
directory with a name sim

Note: To prevent data loss
copy the most recent back

3 If the uemsbackup comm
because the system is too

/opt/OV/bin/ovstop ↵
/opt/OV/bin/Nortel/HSTP/

CAUTION
Loss of alarm mo
No alarm mon
during the foll
occurring are
completed.
UE9000 DMS 297-8391-302 NA015

/opt/OV/bin/ovstart ↵
—continued—
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Procedure 3-4 (continued)
Backing up and restoring the uEMS workstation databases

Step Action

Restore backed up databases
4 Open a terminal window on the workstation and log in as root. At the

prompt, type:

/opt/OV/bin/Nortel/HSTP/uems/uemsrestore [backup file] ↵

The workstation databases are restored.

—end—

where

[backup file] is the name of the backed-up file, such as
backup.13Jul1999_1730:00
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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the UE9000 element management system
after it has been installed on the HPOV

accompany the new uEMS software load.
o install the load on the uEMS workstation.
Procedure 3-5
Upgrading the uEMS software

Use this procedure to upgrade 
(uEMS) software, if necessary, 
workstation.

Action

Step Action

1 Read the instructions that
Follow those instructions t

—end—
UE9000 DMS 297-8391-302 NA015
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Network and user security
The Universal Edge 9000 element management system (uEMS) provides
three types of security:

• UNIX/Solaris workstation login passwords

• file permissions

• simple network management protocol (SNMP) community strings

SeeTable 3-2 for a description of each security feature.

Table 3-2
uEMS security features

Security
feature Platform Type of security provided

UNIX/Solaris
workstation log
in passwords

UNIX/Solaris UNIX/Solaris provides the following
security:

• workstation user name and password

• read, write, and executable permissions
on executables and files

file
permissions

HP
OpenView

HPOV security is based off of the security
provided by UNIX/Solaris. Every HPOV
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

(HPOV) pull-down and pop-up menu item has an
associated UNIX/Solaris file.

If users have read permissions on the
UNIX/Solaris file associated with a particular
HPOV menu item, they can access that
menu item. If the user does not have read
permission, then the menu item is hidden
and not accessible.

—continued—
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rious uEMS commands based on their
ment.

es the permissions for the various user

ery SNMP message includes a
mmunity string. This community string
ts as a password.

 SNMP agent accepts only the SNMP
quests sent to it that contain a community
ring known by the SNMP agent. All SNMP
quests with unknown community strings
e rejected.

the community string is known, the SNMP
ent checks the community string
rmission against the permission required

 perform the requested operation. If the
rmissions match, the operation is
rformed by the SNMP agent. If the
rmissions do not match, the request is
nied.

te: The SNMP community strings in
MS are read-only and cannot be
anged.

—end—

)

e of security provided
User permissions
You can give users access to va
UNIX/Solaris user-group assign

Table 3-3 on page 3-15 summariz
levels.

SNMP
community
strings

SNMP Ev
co
ac

An
re
st
re
ar

If
ag
pe
to
pe
pe
pe
de

No
uE
ch

Table 3-2
uEMS security features (continued

Security
feature Platform Typ
UE9000 DMS 297-8391-302 NA015



Software management  3-15

Assigning user permissions
Use the /opt/OV/bin/Nortel/HSTP/uems/tools/uems_admin tool to assign
users to the UNIX/Solaris user-groups (on the local machine only). You can
launch this script from the main menu bar by selectingConfiguration ->
Nortel UEMS-> User Accounts.

Table 3-3
Permissions for user levels

UNIX/Solaris group uEMS operations

Access
Level

UNIX/Solaris
Group ID

Lock and
unlock

Provision,
unprovision,
update Test, restart

root — Yes Yes Yes

admin adm Yes Yes Yes

provisioning prov Yes Yes No

maintenance maint Yes No Yes

surveillance surv No No No

Others — No No No
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

To configure a username globally on several machines (for example, to
support OVW client sessions), you must add the username on the NIS server.
See your UNIX/Solaris administrator about using NIS services to configure
the username globally.

Workstation security
For information on creating user groups, associating command restrictions
with user groups, assigning individual user names and passwords, and
assigning users to user groups on the uEMS workstation, see the operating
system documentation.
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Appendix A - Understanding the uEMS 4-

This chapter describes the functionality of the Universal Edge 9000 element
management system (uEMS) user interface.

Chapter contents
This chapter contains the following topics:

• Terms on page 4-2

• uEMS screen on page 4-4

• Pop-up menus on page 4-6

• Maps and submaps on page 4-6

• Visual indicators in uEMS on page 4-26
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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ay be new to some operating company
scribes some of these terms.

box. A dialog box displays information on
nd allows you to change or enter

at requires user notification. uEMS events
ple network management protocol

are some conditions that generate uEMS

exceeded

 node changed

hanged

t occurred on a node

atabase which is used to represent the
omponent in the UE9000 network. An
l entity, such as a hardware device, or a
 group of hardware devices.

elect to perform tasks. A menu can be a
nu.

strative condition of the UE9000
 of a UE9000 component is represented

 GUI symbol

n its uEMS GUI symbol

its uEMS GUI symbol

tion of the UE9000 network

ion on the uEMS submap screen of a
the uEMS database. A symbol can be an
mbol. An icon symbol represents a single
he uEMS database, such as an ATM core
Terms
This chapter uses terms that m
personnel. The following list de

Dialog
box

an interactive message
a UE9000 component a
information.

Event

a system occurrence th
are generated using sim
(SNMP). The following
events:

• a threshold limit was 

• the configuration of a

• the status of a node c

• a warm or cold restar

Object

an entry in the uEMS d
attributes of a specific c
object can be a physica
logical entity, such as a

Menu
a list of items that you s
pull-down or pop-up me

Status

the operating or admini
component. The status
by:

• the color of its uEMS

• any annotation text o

• any alert bubbles on 

Submap a view of a specific sec

a graphical representat
UE9000 component in 
icon or a connection sy
UE9000 component in t
UE9000 297-8391-302 NA015

Symbol

card. A connection symbol represents the connection between
two UE9000 components, such as the ADSL subscriber circuit
connecting a UE9000 customer premise equipment (CPE)
modem and an ADSL multi-circuit line card.
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Overview
The uEMS GUI provides operation, maintenance, administration, and
provisioning (OAM&P) functions. It is based on Hewlett Packard OpenView
and operates on a UNIX or Solaris workstation. The uEMS GUI uses symbols
and menus to represent components of the UE9000 network.

From the uEMS GUI, you can perform the following operations on the
UE9000 network:

• provision, remove, and update UE9000 components

• perform maintenance on and test UE9000 components

• monitor the UE9000 network

The uEMS also supports a command line user interface (CLUI) as described
in Chapter 2, “Bulk provisioning data services.”
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01



4-4   Appendix A - Understanding the uEMS

ts of a uEMS GUI screen.

UE-1016

ave a three-button mouse. SeeProcedure 1-1
w to use the middle button.

UE-1016

Fault Misc HelpOptionsration

 Config

[Auto- layout]

p 
uEMS screen
Figure 4-1 shows the componen

Figure 4-1
Submap components

Three-button mouse
In order to use uEMS you must h
on page 1-7 for an example of ho

Submap name

b

Root
Map Edit Locate Configu

ATM SD

Default [Read-Write]

PerformanceView

HSTP - Network Internet

Subma
name

Menu
bar

Tool
bar

Viewing
area

Status
bar
UE9000 297-8391-302 NA015

The name of the submap appears at the top of the submap window. The name
of the submap inFigure 4-1 is Root.

Menu bar
Each submap has a menu bar near the top of the submap window. The menu
bar contains pull-down menus organized by functionality.
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Pull-down menu
To open a pull-down menu, position the cursor over the name of the menu and
press the left mouse button.

If a letter is underlined in the name of the menu, you can use the keyboard to
open a menu. Press theAlt key and the underlined letter to open the menu. For
example, pressAlt M to open the Map menu.

Each pull-down menu displays additional selections. The availability of each
selection varies according to the submap. If the uEMS GUI displays the
selection in white type, the selection is available for the current submap. If the
uEMS displays the selection in gray type, the selection is not available for the
current submap.

Tool bar
Each submap has a tool bar below the menu bar. The tool bar contains several
buttons with graphic icons. These buttons allow you to perform quick actions.

To perform an action, position the cursor over the tool bar button and press the
left mouse button.

For more information on the tool bar buttons and the actions they perform, see
the Hewlett Packard OpenView (HPOV) documentation or the HPOV on-line
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

help.

Viewing area
The viewing area contains the symbols for the submap. The Internet and
HSTP-Network symbols are in the viewing area of the submap inFigure 4-1
on page 4-4.

Status bar
The status bar displays the following information:

• the name of the open view (map)

• the read access available on the open map

• the status of the automatic layout for the submap (enabled or disabled)

• the status of the submap overlay (on or off)

In Figure 4-1 on page 4-4, the name of the view is default, the read access of
the submap is read-write, and automatic layout is enabled.
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pop-up menu that allows you to perform one
s:

elected UE9000 component represented by

bol or UE9000 component

e selected UE9000 component

n on the selected UE9000 component and its

f submaps that are used to view the UE9000
 be viewed in its entirety.

c section of the UE9000 network.

ctivities from most submaps in the uEMS

ny) of symbols on the submap you are in

00 components

nts

nents from the UE9000 network

9000 components

nts

iagnostic activities on UE9000 components

rite map when changing anything in uEMS.
 yield inaccurate results. A read-write map
Pop-up menus
Each symbol in a submap has a
or more of the following function

• display information on the s
the symbol

• configure the selected sym

• perform maintenance on th

• navigate between submaps

• display inventory informatio
child UE9000 components

Maps and submaps
A map consists of a collection o
network. A map cannot typically

A submap is a view of a specifi

You can perform the following a
GUI:

• open the child submap (if a

• monitor the status of UE90

• provision UE9000 compone

• unprovision UE9000 compo

• update the attributes of UE

• inventory UE9000 compone

• perform maintenance and d

• show faults

Note: Always use a read-w
Using a read-only map may
UE9000 297-8391-302 NA015

displays [Read-Write] in the lower left corner. To open a read-write map,
seeProcedure 1-24, “Opening a temporary read-write map” on page
1-82.
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The uEMS arranges submaps in a hierarchy. With this hierarchy, operating
system personnel can move between submaps to isolate a component or
function.Figure 4-2 shows the submap hierarchy for the uEMS. Also see
Figure 1-2 on page 1-6.

Figure 4-2
uEMS submap hierarchy

UE-1014

Root

Internet HSTP Network

NE NE

Shelf Shelf

ATM SD Config 

SDGIP

Segment

SD

UE-1014
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

DAC A DAC B

Carrier(s) Carrier(s)

LC 1 LC 16

Subscriber
Loop 1

Subscriber
Loop n
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submap for the uEMS GUI. The Root submap

provides access to all IP devices on the data
e symbols

 which provides access to all UE9000

 of the UE9000 network through these
oot submap.

SC-10399
SC-10399
Root submap
The Root submap is the default
displays the following symbols:

• the Internet symbol, which 
network and their respectiv

• the HSTP-Network symbol,
components and symbols

You can access all components
symbols.Figure 4-3 shows the R

Figure 4-3
Root submap
UE9000 297-8391-302 NA015

Symbols
This submap uses symbols in the Network symbol class. The HSTP-Network
symbol is a default symbol that uEMS creates when the first uEMS map is
opened.
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HSTP-Network submap
The HSTP-Network submap displays each network element (NE) in the
UE9000 network. Double-click the HSTP-Network symbol at the Root
submap to open the HSTP-Network submap.

Figure 4-4 shows the HSTP-Network submap.

Figure 4-4
HSTP-Network submap

SC-10464SC-10464
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Symbols
This submap uses the NE symbol in the UE9000 class.
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E9000 shelf in the selected NE. Double-click
work submap to open an NE submap.

p.

SC-10465

bol in the UE9000 symbol class.

SC-10465
NE submap
The NE submap displays each U
an NE symbol at the HSTP-Net

Figure 4-5 shows the NE subma

Figure 4-5
NE submap

Symbols
This submap uses the shelf sym
UE9000 297-8391-302 NA015



Appendix A - Understanding the uEMS  4-11

Shelf submap
The shelf submap (seeFigure 4-6)displays each ATM core card and line card
in the selected shelf. Double click the shelf symbol at the NE submap to open
the shelf submap.

Note: Although uEMS displays symbols for voice-only line cards, you
cannot move, provision, or delete voice-only line cards in uEMS.

Figure 4-6
Shelf submap

SC-10468SC-10468
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Functions
You can perform the following activities from the shelf submap:

• monitor the traffic of each ATM core card and multi-circuit line card

• open the IP submap of each ATM core card

• perform maintenance activities on each ATM core card or line card

Symbols
This submap uses the ATMIF and Line Card symbols in the UE9000 class.



4-12   Appendix A - Understanding the uEMS

ps:

 each DS1 IMA carrier in the selected DS1
k the ATM DS1 core card symbol at the
DAC submap.

the DS3 carrier in the selected DS3 ATM core
 core card symbol at the shelf submap to

submap.

SC-10394SC 10394
DAC submap
The uEMS has two DAC subma

• DS1 DAC submap

• DS3 DAC submap

The DS1 DAC submap displays
IMA ATM core card. Double-clic
shelf submap to open the DS1 

The DS3 DAC submap displays
card. Double-click the ATM DS3
open the DS3 DAC submap.

Figure 4-7 shows the DS1 DAC 

Figure 4-7
DS1 DAC submap
UE9000 297-8391-302 NA015
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Figure 4-8 shows the DS3 DAC submap.

Figure 4-8
DS3 DAC submap

SC-10463
SC-10463
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Functions
You can monitor the state of each DS1 or DS3 carrier from the appropriate
DAC submap.

Symbols
The DS1 DAC submap uses the DS1 Link symbol in the UE9000 class. The
DS3 DAC submap uses the DS3 Link symbol in the UE9000 class.
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subscriber circuit in the selected LC.
he shelf submap to open the LC submap.

p for an ADSL line card.

SC-10397

ch subscriber circuit from the LC submap.

ymbol in the UE9000 class.

SC-10397
LC submap
The LC submap displays each 
Double-click the LC symbol at t

Figure 4-9 shows the LC subma

Figure 4-9
LC submap

Functions
You can monitor the traffic of ea

Symbols
This submap uses the Circuit s
UE9000 297-8391-302 NA015
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Subscriber loop submap
The Subscriber loop submap displays the subscriber loop for the selected
subscriber circuit. Double-click the subscriber circuit at the LC submap to
open the Subscriber loop submap.Figure 4-10 shows the Subscriber loop
submap.

Figure 4-10
Subscriber loop submap

SC-10469
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Symbols
This submap uses the ATMIF, Line Card, Circuit, and CPE symbols in the
UE9000 symbol class. The submap also shows the data throughput between
the circuit and the CPE. The downstream synch rate is the left pair of
numbers, and it represents data flow from the central office toward the
subscriber. The upstream synch rate is the right pair of numbers, and it
represents the data flow from the subscriber to the central office.

The downstream and upstream figures are separated by a colon. Each figure
is displayed as: provisioned maximum data rate / actual data rate.
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bmap displays the default service descriptor
scriptor groups that have been provisioned.
tton to open the service descriptor group

escriptor group submap.

SC-10405
Service descriptor group submap
The service descriptor group su
group and any other service de
Click on the ATM SD Config bu
submap.

Figure 4-11 shows the service d

Figure 4-11
Service descriptor group submap

Symbols
UE9000 297-8391-302 NA015

This submap uses the service descriptor group symbol in the UE9000 class.
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Service descriptor submap
The service descriptor submap displays each service descriptor that has been
provisioned for a specific service descriptor group. Double-click a service
descriptor group symbol at the service descriptor group submap to open the
service descriptor submap.

Figure 4-12 shows the service descriptor submap.

Figure 4-12
Service descriptor submap

SC-10467
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Symbols
This submap uses the service descriptor symbol in the UE9000 class.
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MS displays events, which are
at are usually less important than alarms. To
rtel uEMS Events from the Event
13). For more information about events, see
roubleshooting Guide.

SC-10402

use the Root submap to perform OAM&P
nts. The Event Categories window provides
record OAM&P activities performed by the
personnel.
Event Browser
The event browser is where uE
single-occurrence messages th
access the event browser, clickNo
Categories window (seeFigure 4-
theUE9000 Data Testing and T

Figure 4-13
Event Categories window

Operating company personnel 
functions on UE9000 compone
quick access to event logs that 
switch and operating company 
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Figure 4-14 shows the event browser window.

Figure 4-14
Event browser window

SC-10403

You can perform the following functions on the event browser:

• To display help about an event, click the event and select:

SC-10403
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

View -> Describe Event

The Describe Event window appears, displaying specific information
about the selected event.

• To view the entire message for an event, click and hold the right mouse
button on the event.

A pop-up window appears, displaying the entire event message text.

Release the right mouse to return to the event browser.
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MS displays alarms, which are messages that
roblem exists, and again when the problem is
bout specific alarms, see theUE9000 Voice
ide. To access the alarm browser, use one of

 JRE ver. 1.1.8 and Swing ver. 1.1.1 before
ser. See the uEMS CD for installation

ing the alarm browser, or if the alarm counts
tch the alarm counts displayed on uEMS
mand:

ynchronize Alarm Browser

e alarm database with the uEMS database. If
this command causes uEMS to rebuild it.

Then

press the Alarm Browser  button on
the alarm banner

double-click an object’s alert bubble

right-click an object’s alert bubble, and
select Show alarms for this device
from the pop-up menu

OR

select an object; then select Show ->
Fault
Alarm browser
The alarm browser is where uE
occur once when an important p
cleared. For more information a
Testing and Troubleshooting Gu
the following methods.

Note: You must install Java
you can use the alarm brow
instructions.

If you are having trouble access
in the alarm browser do not ma
symbols, use the following com

Misc -> Nortel uEMS -> S

This command synchronizes th
the alarm database is missing, 

Table 4-1
Accessing the alarm browser

To see

all alarms managed by the uEMS

all alarms for a device and all its
subcomponents
UE9000 297-8391-302 NA015

The alarm browser can be either open or closed when this command is issued.
However, if it is open, you must press the refresh button or wait 60 seconds
for an automatic refresh to occur.

This command is not service affecting and can be issued at any time.
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Figure 4-15 shows the alarm browser window.

Figure 4-15
Alarm browser window

SC-10462

The alarm browser displays the following information about each alarm:

• acknowledgement status • cleared time

• alarm status • source

• alarm severity • alarm text/reason
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Note: To avoid slow system response time, do not open more than one
alarm browser per user.

Acknowledging alarms
You can acknowledge alarms by clicking the box to the extreme left of each
alarm entry. If you acknowledge an alarm by mistake, then you can
unacknowledged the alarm to correct your error. Symbols reflect the
acknowledged and unacknowledged status of alarms as shown inTable 4-11
on page 4-32.

• raised time
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ion by column as described inTable 4-2.

r the alarm browser to either automatic refresh
 inTable 4-3 on page 4-22.

 hide alarms from the alarm browser display
 set more than one filter at a time.Table 4-4
ble:

then

click a column heading

press Shift and click a column heading

he display

seconds

 press the Refresh  button

 change the filter settings

 press the Refresh  button

 change the filter settings
Sorting
You can sort the alarm informat

Refresh mode
You can set the refresh mode fo
or manual refresh, as described

Filter settings
The filters allow you to show or
based on their status. You may
shows the filters that are availa

Table 4-2
Sorting alarm information

To sort in

descending order

ascending order

Table 4-3
Alarm browser refresh modes

This refresh mode refreshes t

automatic every 60 

when you

when you

manual when you

when you

Table 4-4
Alarm browser filters
UE9000 297-8391-302 NA015

This filter displays

critical only alarms of a critical severity

major only alarms of a major severity

minor only alarms of a minor severity

warning only alarms of a warning severity
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history all alarms in the database

Note: The alarm browser removes from its
database cleared alarms that are older than 30
days. For information on changing this value, see
Procedure 5-8 on page 5-11.

acknowledged only acknowledged alarms with the active alarms

Note: Active, unacknowledged alarms are always displayed unless their
severity filter has been disabled.

Table 4-4
Alarm browser filters

This filter displays
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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ol is where uEMS displays settings for OAM
1-12 on page 1-46). These parameters are
ucted from an ATM edge switch. Buttons on

anaging these parameters in the uEMS
seeTable 4-5 on page 4-24).

 management tool:

SC-10466

ol has the following buttons:

s

VCC OAM management tool
The VCC OAM management to
monitoring parameters (seeTable
used for F5 loopback tests cond
the tool provide functions for m
database and in the ATM card (

Figure 4-16 shows the VCC OAM

Figure 4-16
VCC OAM management tool

The VCC OAM management to

Table 4-5
VCC OAM management tool button
UE9000 297-8391-302 NA015

Button Description

Stop All clears the OAM monitoring parameters in both
the uEMS database and in the ATM card
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Update VCC compares the OAM monitoring parameters
between the uEMS database and the ATM card.
If the number of enabled VCCs does not match,
the tool asks if you want to re-sync the
parameters in the ATM card. This action clears
the OAM bits in the ATM card and then sends to
the ATM card provisioning data for circuits with
enabled VCCs contained in the uEMS database.

Note: A config failure alarm will prevent a
re-sync. See the UE9000 Data Testing and
Troubleshooting Guide for fault information.

—continued—

Reprov VCC clears the OAM bits in the ATM card and then
re-syncs the ATM card provisioning data for
circuits with enabled VCCs contained in the
uEMS database.

Note: A config failure alarm will prevent a
re-sync. See the UE9000 Data Testing and
Troubleshooting Guide

Table 4-5
VCC OAM management tool buttons

Button Description
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

To launch the VCC OAM management tool, open the ATM card’s pop-up
menu and select:

Maintenance -> ATM OAM

The oamGUI window appears, displaying a list of all the circuits that are
provisioned in the uEMS database with the OAM parameter enabled.

 for fault information.

Close closes the tool

—end—
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S uses visual aids to inform you of the

and tests UE9000 components. A change in
an change the operations of that component

ols to monitor the network and help with
 tools are:

bbles on a symbol

 company personnel of specific conditions

 the status of the symbol’s UE9000
bol also reflects the most severe
 the symbol’s UE9000 component. As you
ol, the following changes occur:

he highest unacknowledged alarm

s a status summary of all the alarms

es previous colors on a symbol, including

o a symbol in the parent submap. The uEMS
 for the shelf symbol than for the

 below it use this rule:

are red, orange, yellow, or cyan, then uEMS
Visual indicators in uEMS
This section explains how uEM
equipment status.

Overview
The uEMS continually monitors
the condition of a component c
and the UE9000.

The uEMS GUI uses several to
troubleshooting. Some of these

• symbol colors

• annotation text and alert bu

• events that notify operating

Color indicators in uEMS
The color of a symbol indicates
component. The color of a sym
unacknowledged alarm raised by
acknowledge alarms for a symb

• the symbol color indicates t

• the alert bubble text display

Note: The tan color overrid
colors that indicate faults.

Colors can propagate upward t
uses different propagation rules
HSTP-Network symbols.

The NE symbol and all devices

• If any of the children devices
UE9000 297-8391-302 NA015

propagates the color for the most critical severity to the parent.

The HSTP-Network and NE symbols use the compound status feature of
Hewlett Packard OpenView. The default rule for this feature is shown in
Table 4-6 on page 4-27. For more information see the Hewlett Packard
OpenView documentation.
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Color and status legend
Table 4-7 describes each symbol status color. To view this information from
the uEMS GUI, selectDisplay Legendfrom the Help pull-down menu of any
submap. Use the pull-down menu in the Legend window to select a legend to
view.

Note: Other colors are available in Hewlett Packard OpenView, but
uEMS does not use them.

Table 4-6
Default compound status

Status of symbols in the child submap
Status propagated to the
parent symbol

all normal normal

one abnormal and all others normal warning

multiple abnormal and multiple normal minor

one normal and all others abnormal major

all abnormal critical

Table 4-7
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Symbol color legend

Symbol
color

Level of
severity Status of UE9000 component Action

red critical • the equipment has failed and no longer
supports traffic

• a critical event is raised by the
equipment

Select Show -> Fault  to
display alarms raised
against the object and its
children. Resolve the critical
alarms immediately.

orange major • normal service is affected and
performance has degraded

• a major event is raised by the
equipment

• the equipment requires immediate
attention

Select Show -> Fault  to
display alarms raised
against the object and its
children. Resolve the major
alarms immediately.
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d, but

e

y escalate

Select Show -> Fault  to
display alarms raised
against the object and its
children. Resolve the minor
alarms at the next
opportunity.

n that may

d and
graded

 the

Select Show -> Fault  to
display alarms raised
against the object and its
children. Resolve the
warning alarms at the next
opportunity.

operational No action is required.

Double-click the object’s
alert bubble to display
alarms raised against the
object. Resolve the alarms at
the next opportunity.

ine the

and the NE
es. If all
ne exist,
re blue, the
elf is blue if
isioned.

No action is required.

Action
yellow minor • normal service is not affecte
performance has degraded

• a minor event is raised by th
equipment

• indicates a problem that ma

light blue
(cyan)

warning • the equipment has a conditio
escalate in severity

• normal service is not affecte
performance has not yet de

• a warning event is raised by
equipment

green normal The equipment is in a normal
state.

pink — All existing alarms have been
acknowledged.

blue — The uEMS GUI cannot determ
status of the equipment.

The color of the HSTP network
are propagated from the shelv
shelves are blue, locked, or no
then the NE is blue. If all NEs a
HSTP network is blue. The sh
the ATM core card is not prov

Table 4-7
Symbol color legend (continued)

Symbol
color

Level of
severity Status of UE9000 component
UE9000 297-8391-302 NA015

off-white — The equipment represented by the symbol
is not provisioned.

Provision the equipment.

(No action is required.)

—continued—
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Viewing alarm information
The uEMS GUI provides several methods for viewing alarm-type
information, such as events, faults, and alarms. Events are single-occurrence
messages of an informational nature. Alarms (and faults), however, are more
important and are reported when a problem occurs and when the problem
clears.

Table 4-8 describes how to view alarm information in uEMS.

tan — The equipment represented by the symbol
has been locked by a craftperson (to
perform maintenance, for example). The
device has stopped sending subscriber
traffic.

Unlock the equipment when
the maintenance is
complete.

Note: The tan color
overrides previous colors on
a symbol, including colors
that indicate faults.

—end—

Table 4-7
Symbol color legend (continued)

Symbol
color

Level of
severity Status of UE9000 component Action
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

ISO 9000 colors
The uEMS GUI uses the International Standards Organization (ISO) states
defined in International Standard ISO10164.Table 4-9 maps uEMS GUI
symbol colors to their corresponding ISO states.

Table 4-8
How uEMS reports alarm information

To view Then

events launch the event browser as described in “Event Browser”
on page 4-18.

alarms select an object, then select Show -> Fault  to display
alarms raised against the object and its children

OR

launch the alarm browser as described in “Alarm browser”
on page 4-20.
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circuit symbol with annotation text and an
sumes the same color as the symbol unless the
is tan.

ubble
SC-10461

, disabled

, enabled

, enabled

, enabled

, enabled

Alert bubble

notation text
Annotation text and alert bubbles
Figure 4-17 shows a subscriber 
alert bubble. The alert bubble as
object is locked; then the color 

Figure 4-17
Annotation text and symbol Alert b

Table 4-9
ISO/Symbol color mapping

Symbol Color ISO state

red unlocked

orange unlocked

yellow unlocked

light blue (cyan) unlocked

green unlocked

blue none

off-white none

tan locked

 

 An
UE9000 297-8391-302 NA015
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Table 4-10 lists the symbol annotation texts and the conditions each text
indicates. For troubleshooting information, see theUE9000 Data Testing and
Troubleshooting Guide.

Table 4-10
Annotation texts for uEMS GUI symbols

Symbol
annotation text Condition

? The state of this object is unknown. This is typically shown
when uEMS loses communication with the UE9000 shelf.

L The element is locked (manually busy). The device was
explicitly put into this state (e.g. by a craftperson or a
program) to stop this device from passing subscriber
traffic. The device continues to generate faults with the
exception of DS1 and DS3 carriers.

P The parent symbol for this device is incapable of passing
subscriber traffic. The parent device may be locked, for
example.

X The device is incapable of passing subscriber traffic. This
is typically preceeded by a critical fault.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

S Designates which ATM core card (in systems with two
ATM core cards in the UE9000 shelf) is the “Standby”
card.

ATUC download The line card is downloading dsp firmware to the circuits.

cold restart The element is performing a cold restart.

config fail An attempt by uEMS to send information to a device has
failed.

configuring The UE9000 component is in the process of synching with
the uEMS database provisioning, OR

The uEMS is in the process of unprovisioning the data
access card (DAC).

h/w mismatch The provisioned hardware does not match the existing
hardware. For example, a DS1 IMA ATM card is
provisioned, but a DS3 ATM card is installed.

—continued—
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bubble texts and a description for each.

ommunicate with the ATM. The network or
wn.

mponent’s hardware is not present.

mponent is not provisioned in the uEMS
abase.

 performing a loopback test.

 performing a restart reload force.

 performing a restart reload normal.

 performing a restart reload.

 performing a test.

—end—

mbols

d severity of alarms summary. The
cribed as follows:

lt on this device

lt on this device

lt on this device

bols (continued)
Table 4-11 lists the symbol alert 

no comm uEMS cannot c
the device is do

no hw The UE9000 co

not prov The UE9000 co
workstation dat

loopback The element is

reload force The element is

reload normal The element is

restart - No
comms

The element is

testing The element is

Table 4-11
Alert bubble texts for uEMS GUI sy

Alert bubble Condition

1M The number an
summary is des

“C” - critical fau

“M” - major fau

“m” - minor fau

Table 4-10
Annotation texts for uEMS GUI sym

Symbol
annotation text Condition
UE9000 297-8391-302 NA015

“w” - warning fault on this device

“+” - other faults of lower severity exist on this device. For
example, “1C+” means there is one critical fault and other
faults of lower severity.

Ack:1C The number and severity of alarms that have been
acknowledged.
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Appendix B - Using the uEMS GUI 5-

This chapter describes the functionality of the Universal Edge 9000 (UE9000)
element management system (uEMS) graphical user interface (GUI).

Chapter contents
This chapter contains the following tasks.

Task See

Starting the uEMS graphical user interface Procedure 5-1 on page 5-2

Installing the HPOV/uEMS icon on the
desktop

Procedure 5-2 on page 5-4

Removing the HPOV/uEMS icon from the Procedure 5-3 on page 5-5
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

desktop

Opening a pop-up menu Procedure 5-4 on page 5-6

Searching for an object Procedure 5-5 on page 5-8

Adding a shortcut to a submap Procedure 5-6 on page 5-9

Deleting a shortcut to a submap Procedure 5-7 on page 5-10

Changing the cleared alarm default Procedure 5-8 on page 5-11

Viewing equipment details Procedure 5-9 on page 5-12

Viewing equipment inventory Procedure 5-10 on page 5-15
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terface

Hewlett Packard OpenView (HPOV) and the
system (uEMS) graphical user interfaces.

MS icon on your desktop (as described in
4)?

rkstation, open a terminal window. At the
nd press Enter to see if you are in the

ng which directory you are in.

press Enter to change directories.

s Enter to see if all processes are running.

e icon. You are finished with this

Then

irectory, Go to step 3.

ry, Go to step 4.

Then
Procedure 5-1
Starting the uEMS graphical user in

Use this procedure to start the 
UE9000 element management 

Action

Step Action

1 Do you have an HPOV/uE
Procedure 5-2 on page 5-

2 From the UNIX/Solaris wo
command line type pwd  a
/opt/OV/bin directory.

A prompt appears indicati

3 Type cd /opt/OV/bin  and 

4 Type ./ovstatus  and pres

If Then

yes double-click th
procedure.

no go to step 2.

If you are

NOT in the /opt/OV/bin d

in the /opt/OV/bin directo

If
UE9000 297-8391-302 NA015

5 Type ./ovstart -v  and press Enter to start all processes.

—continued—

one or more processes are NOT running, Go to step 5.

all processes are running, Go to step 6.
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Procedure 5-1 (continued)
Starting the uEMS graphical user interface

Step Action

6 Type ./ovw &  and press Enter.

The HPOV NNM and uEMS GUIs start. After a moment, the Root
submap and Event Categories window appear on the screen.

Note: You can also launch HPOV/uEMS by clicking on an icon. See
Installing the HPOV/uEMS icon on the desktop on page 5-4.

7 Use the Root submap to access UE9000 components (see
Figure 1-2 on page 1-6). Use the Event Categories window to display
uEMS and HPOV events.

—end—
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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he desktop

 HPOV/uEMS icon on the desktop. This
S by clicking on an icon instead of using the

d DeskTop icon to launch uEMS from
n menu.

on on the desktop.
Procedure 5-2
Installing the HPOV/uEMS icon on t

Use this procedure to install the
allows you to launch HPOV/uEM
UNIX/Solaris command line.

Action

Step Action

1 Select Nortel uEMS -> Ad
the Configuration pull-dow

The system installs the ic

—end—
UE9000 297-8391-302 NA015
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Procedure 5-3
Removing the HPOV/uEMS icon from the desktop

Use this procedure to remove the HPOV/uEMS icon from the desktop.

Action

Step Action

1 Select Nortel uEMS -> Remove DeskTop uEMS launcher icon
from the Configuration pull-down menu.

The system removes the icon from the desktop.

—end—
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01



5-6   Appendix B - Using the uEMS GUI

op-up menu in any UE9000 element
raphical user interface (GUI) submap.

e symbol whose pop-up menu you want to

ouse button.

object appears.

nd your selection.

sition the cursor over the selection and
e right mouse button.

 three dots (...) the selection displays a
ormation.

n arrow, move the cursor across the arrow
selection.
Procedure 5-4
Opening a pop-up menu

Use this procedure to open a p
management system (uEMS) g

Action

Step Action

1 Position the cursor over th
open.

2 Press and hold the right m

The pop-up menu for the 

3 Scroll down the menu to fi

To activate a selection, po
remove your finger from th

Note 1: If a selection has
window with additional inf

Note 2: If a selection has a
to display options for that 

—continued—
UE9000 297-8391-302 NA015
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Procedure 5-4 (continued)
Opening a pop-up menu

Step Action

4 Certain selections are common to all uEMS GUI pop-up menus in all
submaps. Table 5-1 describes the selections available from all uEMS
GUI pop-up menus.

Table 5-1
Pop-up menu selections common to all submaps

Select To

Open Symbol open the UE9000 component’s submap or executes
the action related to the symbol

Describe/Modify
Symbol

open the Symbol Description dialog box for the
symbol and allows you to change the attributes of the
symbol.

Use this option only to change the symbol label.

Provision/Edit open the Object Description dialog box and allows
you to view or change the attributes of the selected
UE9000 component
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Note: Selections appearing below the common selections are
specific to uEMS.

—end—
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r an object in the Hewlett Packard OpenView
r database.

 any submap by the following categories:

ol colors, seeTable 4-7 on page 4-27.
ailable in Hewlett Packard OpenView, uEMS
re, search results can be misleading.

ocate pull-down menu and select the type

ears.

ter the criteria you want to search for.

atch the criteria you indicated appears in
ed field.

u want to view in the Located and
Procedure 5-5
Searching for an object

Use this procedure to search fo
(HPOV) Network Node Manage

You can search for any object in

• selection name

• attribute

• comment

• symbol status

• symbol type

• symbol label

Note: For a legend of symb
Although other colors are av
does not use them. Therefo

Step Action

1 Select Objects from the L
of search you want.

The Locate by dialog app

2 In the appropriate field, en

3 Click the Apply  button.

A list of the objects that m
the Located and Highlight

4 Double-click the object yo
Highlighted field.
UE9000 297-8391-302 NA015

The submap containing the object appears.

5 To close the Locate by dialog, click the Close  button.

—end—
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Procedure 5-6
Adding a shortcut to a submap

Use this procedure to add a shortcut to a submap in the Quick Navigator.

Action

Step Action

1 Open the submap you want to make a shortcut to.

2 Select Add to Quick Navigator  from the Edit pull-down menu.

The shortcut is added.

—end—
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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hortcut to a submap from the Quick Navigator.

by clicking on the fifth button from the left

ow appears.

with the third mouse button.

 appears.

m the pop-up menu.

ears.

by selecting Close submap from the Map
Procedure 5-7
Deleting a shortcut to a submap

Use this procedure to delete a s

Action

Step Action

1 Open the Quick Navigator
in the tool bar.

The Quick Navigator wind

2 Click the submap symbol 

The symbol pop-up menu

3 Select Delete Symbol  fro

A confirmation dialog app

4 Click the OK button.

The shortcut is deleted.

5 Close the Quick Navigator
pull-down menu.

—end—
UE9000 297-8391-302 NA015
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Procedure 5-8
Changing the cleared alarm default

Each night, the alarm browser removes from its database cleared alarms that
are older than the default of 30 days. To change this value, use the following
procedure.

Action

Step Action

1 Log in to the UNIX/Solaris workstation with root access.

2 At the prompt, issue the following command to edit the crontab file:

crontab -e

3 Set the number of days to keep cleared alarms in the database with
this command:

03***/opt/OV/bin/Nortel/HSTP/uems/tools/clean_alarmDB [days]

where

[days] is 0 to 90
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Example:
03***/opt/OV/bin/Nortel/HSTP/uems/tools/clean_alarmDB 20

This example would cause uEMS to remove cleared alarms that are
older than 20 days from its database.

4 Log out.

—end—
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iled information about the ATM core card,
customer premises equipment (CPE) in

yed:

ber or PEC code

e load

 for the card

he ATM core card

r the card (IfIndex)

ber or PEC code

e load

 for the card

available for transmission or reception of
s

allocated for transmission or reception of
e services

allocated for transmission or reception of
 services

allocated for transmission or reception of
 rate services

he ATM core card
Procedure 5-9
Viewing equipment details

Use this procedure to view deta
multi-circuit line card (MLC), or 
uEMS.

The following details are displa

Table 5-2
Viewing equipment details

Equipment Details

DS1 ATM • Nortel part num

• current softwar

• system up-time

• IP address of t

• MIB instance fo

DS3 ATM • Nortel part num

• current softwar

• system up-time

• total bandwidth
all QoS service

• total bandwidth
constant bit rat

• total bandwidth
variable bit rate

• total bandwidth
unspecified bit

• IP address of t
UE9000 297-8391-302 NA015

—continued—

• MIB instance for the card (IfIndex)

—continued—
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Procedure 5-9 (continued)
Viewing equipment details

Table 5-2 (continued)
Viewing equipment details

Equipment Details

MLC • Nortel part number or PEC code

• current software load

• card serial number

• card vendor ID

• IP address of the ATM core card

• MIB instance for the card (IfIndex)

CPE • serial number

• vendor number

• version number

• IP address of the ATM core card

• MIB instance for the CPE/circuit (IfIndex)

—end—
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Note: The MIB instance information is included to aid navigation within
the MIB browser.

—continued—

CAUTION
Database corruption
Do not use the MIB browser to change provisioning or
state information in uEMS. The MIB browser, which is
a part of HP OpenView, can only be used to view MIB
information in uEMS.
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e symbol whose details you want to view.

ouse button.

object appears.

nd from the pop-up menu:

rs.

click Restart . To close the details window,

 [equipment] Details

quipment] is the type of card, such as
M, ADSL4 LC, etc.

etails
Procedure 5-9 (continued)
Viewing equipment details

Action

Step Action

1 Position the cursor over th

2 Press and hold the right m

The pop-up menu for the 

3 Click the following comma

The details screen appea

4 To restart the equipment,
click Close .

—end—

For this equipment Select

ATM, MLC Show ->

where [e
DS3 AT

CPE Show D
UE9000 297-8391-302 NA015
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Procedure 5-10
Viewing equipment inventory

Use this procedure to inventory UE9000 components using the UE9000
element management system (uEMS) graphical user interface (GUI).

The inventory command inventories only those components hierarchically
beneath the UE9000 component where the inventory command was selected.

For example, if you are in the Root submap and use the HSTP-Network
symbol’s pop-up menu to select inventory, all UE9000 components in the data
network will be inventoried. If you are in the Shelf submap and use the ATM
core card symbol’s pop-up menu to select inventory, then only the ATM card
and the carriers associated with it are inventoried.

Action

Step Action

1 Go to any uEMS GUI submap (see the UE9000 Data OAM&P User
Guide). From any symbol’s pop-up menu, select Show -> Inventory ,
then the UE9000 component you want to inventory.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Note: If you want to inventory all UE9000 components, select Show
-> Inventory  -> All  from the HSTP network symbol pop-up menu.

The Inventory dialog appears listing all UE9000 components.

2 When you are finished with the Inventory dialog, click the Close
button.

—end—
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Appendix C - Connecting to the Preside
Applications Platform (AP) 6-

This chapter provides the procedure for connecting to the Preside
Applications Platform (AP) from the Universal Edge 9000 (UE9000) element
management system (uEMS). Connecting to Preside allows the user to access
UE9000 voice network elements at the same time the user is accessing
UE9000 data network elements.

This chapter also provides procedures to establish a remote connection to the
uEMS from the Preside AP.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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the Preside Applications Platform (AP) from

applications (e.g., Netscape) on the uEMS

inal window.

nter  to allow other displays to appear on

g that access control is disabled and that
ny host.

and is not desirable for security reasons,
n be used instead:

s>  (for example, xhost 192.1.2.199)

y typing telnet <Preside AP address> and
 telnet 192.1.2.199)

.

ss Enter .

ears.

ord and press Enter .

MS IP Address:0.0> and press Enter (for
 10.1.2.2:0.0)
Procedure 6-1
Connecting to Preside from uEMS

Use this procedure to connect to
the uEMS.

Action

Step Action

1 Close any color-intensive
workstation.

2 Open a UNIX/Solaris term

3 Type xhost +  and press E
the uEMS workstation:

A message appears statin
clients can connect from a

Note: If the xhost +  comm
the following command ca
xhost <Preside IP addres

4 Telnet to the Preside AP b
press Enter  (for example,

The login prompt appears

5 Type your user id and pre

The password prompt app

6 Type your network passw

A prompt appears.

7 Type setenv DISPLAY <uE
example, setenv DISPLAY
UE9000 DMS 297-8391-302 NA015

A prompt appears.

Note: If the above command is not found on the workstation, type
export DISPLAY=<uEMS IP address:0.0>  (for example, export
DISPLAY=10.1.2.2:0.0.

—continued—
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Procedure 6-1 (continued)
Connecting to Preside from uEMS

Step Action

8 To open the Preside AP Browser, type gnbrowse  and press Enter .
Or, to open the Preside AP Editor, type gnconfig  and press Enter .

Note: If an error message appears indicating a problem with the
allocation of colors, make sure that all color-intensive applications are
closed on the uEMS workstation.

—end—
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01
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e — Remote

remote login session into the uEMS from the
AP) workstation.

hical network browser is running on your
have a view of the AccessNode NEs with

IP address of the workstation running the

E that contains a UE9000 shelf.

ode icon.

nder Login on the tool menu. This is the
 window.

re you enter the IP address of the uEMS.

f the uEMS workstation.

s with the UEMS IP address along the top;
side the terminal window.

ssword for the uEMS.

pears, followed by the root level window of
Procedure 6-2
Connecting to the uEMS from Presid

Use this procedure to launch a 
Preside Applications Platform (

Action

Step Action

1 Make certain that the grap
workstation, and that you 
UE9000 shelves.

Note: You must have the 
uEMS.

2 Select any AccessNode N

Left click on the AccessN

3 Select Login to UEMS:  u
menu along the top of the

A dialog box appears whe

4 Enter the <IP address> o

5 Click OK.

A terminal window appear
a login prompt appears in

6 Enter your user id and pa

A HP OpenView screen ap
the uEMS.

—end—
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Procedure 6-3
Connecting to the uEMS from Preside — Manual

Use this procedure to manually launch the uEMS from the Preside
Applications Platform (AP) workstation.

Note: This procedure is an alternate procedure to Procedure 6-2.

Action

Step Action

1 Open a UNIX/Solaris window on the Preside AP workstation.

2 Telnet from Preside to uEMS by typing the following command at the
prompt:

telnet <uEMS IP address> (Example: telnet 10.1.2.2)

3 Provide the proper user id and password to gain access to the uEMS
workstation.

4 From the prompt, type the following command:

setenv DISPLAY <Preside IP Address: 0.0> (for example: setenv
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

DISPLAY 192.1.2.199:0.0)

Note: If you do not find the above command on the workstation you
are using, type the following command:

export DISPLAY=<Preside IP address: 0.0>  (for example: export
DISPLAY=192.1.2.199:0.0)

5 Start the uEMS database by typing the following command:

/opt/OV/bin/ovstart -v

Wait until the prompt reappears.

—continued—
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following:

uthorized to connect to the server, or the
, type the following at the Preside

tabase is running. To do this, type the

ning?

Then

Repeat steps 5 and 6. If you do this
and are still unable to start uEMS,
please contact Nortel Technical
Assistance.

You are finished with this procedure.
Procedure 6-3 (continued)
Connecting to the uEMS from Preside — Manual

Step Action

6 Start uEMS by typing the 

/opt/OV/bin/ovw

Note: If the client is not a
client cannot open display
workstation:

xhost +

Retype the command:

/opt/OV/bin/ovw

7 Ensure that the uEMS da
following command:

/opt/OV/bin/ovstatus

8 Is the uEMS database run

—end—

If

No

Yes
UE9000 DMS 297-8391-302 NA015
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Appendix D - MIBs 7-

This chapter provides an overview of MIBs, along with lists of the MIBs that
the UE9000 supports.

Overview
The Simple Network Management Protocol (SNMP) is an application-level
protocol that is part of the User Datagram Protocol (UDP) suite. The SNMP
is a request-and-reply protocol. A network management application, such as
uEMS, requests performance data from its server agents. Each server agent
replies with the data. The SNMP then stores that data in a management
information base (MIB).

The SNMP arranges MIB variables in a tree hierarchy. Each branch of the tree
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

has a unique name and number identifier, following the standard Abstract
Syntax Notation One (ASN.1). Each MIB is defined in an ASN.1 file that is
delivered with the UE9000 software.

CAUTION
Database corruption
Do not use the MIB browser to change provisioning or
state information in uEMS. The MIB browser, which is
a part of HP OpenView, can only be used to view MIB
information in uEMS.
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 variables that the UE9000 supports:

on page 7-4
jects for the management of a pair of ADSL
 ADSL line.

7-2 on page 7-7
ntal ADSL on the UE9000.

le 7-3 on page 7-7
 G.Lite on the UE9000.

age 7-8

age 7-9

-6 on page 7-11
extensions to RFC 2515 for ATM OAM&P

7-7 on page 7-14
M&P on the UE9000.

7-8 on page 7-16
ier OAM&P on the UE9000.

7-9 on page 7-17
M&P on the UE9000. This MIB is intended
 MIBs such as the ADSL Line MIB, by
M&P.

able 7-10 on page 7-18
bjects that support the authentication and
he UE9000 platform.

7-11 on page 7-19
bjects that support the control and status of
Supported MIBs
The following tables list the MIB

•  adslLineMIBs in Table 7-1 
The MIB module defining ob
modems at each end of the

•  adslExtensionMIBsin Table
This MIB defines suppleme

•  G.LiteExtensionMIBsin Tab
This MIB defines enterprise

•  sdsl MIBs in Table 7-4 on p

•  ImaMIBs in Table 7-5 on p

•  ue9000AtmMIBs in Table 7
This enterprise MIB defines
on the UE9000.

•  ue9000CarrierMIBs in Table
This MIB defines Carrier OA

•  ue9000CarrierMIBs in Table
This MIB defines DS3 Carr

•  ue9000CircuitMIBs in Table
This MIB defines Circuit OA
to augment service specific
providing generic circuit OA

•  ue9000FrameworkMIBs in T
This MIB module defines o
enhanced trap features of t

•  ue9000nvStoreMIBs inTable
This MIB module defines o
Non-Volatile Store.
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•  IANAifTypeMIB  in Table 7-12 on page 7-20

•  ifMIBs in Table 7-13 on page 7-20
The MIB module to describe generic objects for network interface
sub-layers. This MIB is an updated version of MIB-IIs ifTable, and
incorporates the extensions defined in RFC 1229.

•  UE9000LinecardMIBs in Table 7-14 on page 7-21
This MIB defines Line Card OAM&P on the UE9000.
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•  ue9000NodeMIBs in Table 7-15 on page 7-22
This MIB module defines objects that implement the Node OAM&P
functionality of the UE9000 platform. A node refers to the UE9000 shelf
and its component ATM, TDM, and line cards.

•  perfHistTCMIBs in Table 7-16 on page 7-23
This MIB Module provides Textual Conventions to be used by systems
supporting 15-minute based performance history counts.

•  RFC1213MIBs in Table 7-17 on page 7-23
This MIB module uses the extended OBJECT-TYPE macro as defined in
[14].

•  RFC1406MIBs in Table 7-18 on page 7-27
This MIB module uses the extended OBJECT-TYPE macro as defined in
RFC 1212. This is the MIB module for the DS1 objects.

•  atmMIBs in Table 7-19 on page 7-28

•  atmTCMIBs in Table 7-20 on page 7-29

•  ue9000ModulesMIBs in Table 7-21 on page 7-30
This MIB module defines objects and textual conventions that are
common to all of the OAM&P subsystem MIBs.

•  ue9000UnitMIBs in Table 7-22 on page 7-30
This MIB module defines objects which implement the Unit OAM&P
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

functionality of the UE9000 platform. A unit refers to an ATM controller
card.

•  snmpFrameworkMIBs in Table 7-23 on page 7-31

•  onemeglcMIBs in Table 7-24 on page 7-31
This MIB module describes the 1-Meg Modem (1MM) UE9000 line
card. It contains specific extensions to the line card MIB for managing
1-Meg Modem (1MM) switching functions.

•  onemegctMIBs in Table 7-25 on page 7-32
This MIB module describes the 1-Meg Modem (1MM) line card circuits.
It contains a tables for managing each modem port and each CPE on the
1MM line card.
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ucChanConfInterleaveMinTxRate

ucChanCorrectedBlks

ucChanCurrTxRate

ucChanIntervalCorrectedBlks

ucChanIntervalReceivedBlks

ucChanIntervalUncorrectBlks

ucChanPerfCurr15MinReceivedBlks

ucChanPerfCurr15MinTransmittedBlks

ucChanPerfCurr1DayCorrectedBlks

ucChanPerfCurr1DayTimeElapsed

ucChanPerfCurr1DayUncorrectBlks

ucChanPerfPrev1DayMoniSecs

ucChanPerfPrev1DayTransmittedBlks

ucChanReceivedBlks

ucChanUncorrectBlks

ucConfTargetSnrMgn

ucCurrAttainableRate

ucCurrSnrMgn

ucInitFailureTrapEnable

ucIntervalInits
Table 7-1
adslLineMIBs

adslAtucChanConfInterleaveMaxTxRate adslAt

adslAtucChanConfMaxInterleaveDelay adslAt

adslAtucChanCrcBlockLength adslAt

adslAtucChanInterleaveDelay adslAt

adslAtucChanIntervalNumber adslAt

adslAtucChanIntervalTransmittedBlks adslAt

adslAtucChanPerfCurr15MinCorrectedBlks adslAt

adslAtucChanPerfCurr15MinTimeElapsed adslAt

adslAtucChanPerfCurr15MinUncorrectBlks adslAt

adslAtucChanPerfCurr1DayReceivedBlks adslAt

adslAtucChanPerfCurr1DayTransmittedBlks adslAt

adslAtucChanPerfPrev1DayCorrectedBlks adslAt

adslAtucChanPerfPrev1DayReceivedBlks adslAt

adslAtucChanPerfPrev1DayUncorrectBlks adslAt

adslAtucChanTransmittedBlks adslAt

adslAtucConfRateMode adslAt

adslAtucCurrAtn adslAt

adslAtucCurrOutputPwr adslAt

adslAtucCurrStatus adslAt

adslAtucIntervalESs adslAt
UE9000 DMS 297-8391-302 NA015

adslAtucIntervalLofs adslAtucIntervalLoss

adslAtucIntervalLprs adslAtucIntervalNumber

adslAtucInvSerialNumber adslAtucInvVendorID

adslAtucInvVersionNumber adslAtucPerfCurr15MinESs

—continued—
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adslAtucPerfCurr15MinInits adslAtucPerfCurr15MinLofs

adslAtucPerfCurr15MinLoss adslAtucPerfCurr15MinLprs

adslAtucPerfCurr15MinTimeElapsed adslAtucPerfCurr1DayESs

adslAtucPerfCurr1DayInits adslAtucPerfCurr1DayLofs

adslAtucPerfCurr1DayLoss adslAtucPerfCurr1DayLprs

adslAtucPerfCurr1DayTimeElapsed adslAtucPerfESs

adslAtucPerfInits adslAtucPerfLofs

adslAtucPerfPrev1DayESs adslAtucPerfPrev1DayInits

adslAtucPerfPrev1DayLofs adslAtucPerfPrev1DayLoss

adslAtucPerfPrev1DayLprs adslAtucThresh15MinESs

adslAtucThresh15MinLofs adslAtucThresh15MinLols

adslAtucThresh15MinLoss adslAtucThresh15MinLprs

adslAtucTraps adslAturChanConfInterleaveMaxTxRate

Table 7-1 (continued)
adslLineMIBs
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

adslAturChanConfInterleaveMinTxRate adslAturChanConfMaxInterleaveDelay

adslAturChanCorrectedBlks adslAturChanCrcBlockLength

adslAturChanCurrTxRate adslAturChanInterleaveDelay

adslAturChanIntervalCorrectedBlks adslAturChanIntervalNumber

adslAturChanIntervalReceivedBlks adslAturChanIntervalTransmittedBlks

adslAturChanIntervalUncorrectBlks adslAturChanPerfCurr15MinCorrectedBlks

adslAturChanPerfCurr15MinReceivedBlks adslAturChanPerfCurr15MinTimeElapsed

adslAturChanPerfCurr15MinTransmittedBlks adslAturChanPerfCurr15MinUncorrectBlks

adslAturChanPerfCurr1DayCorrectedBlks adslAturChanPerfCurr1DayReceivedBlks

adslAturChanPerfCurr1DayTimeElapsed adslAturChanPerfCurr1DayTransmittedBlks

adslAturChanPerfCurr1DayUncorrectBlks adslAturChanPerfPrev1DayCorrectedBlks

—continued—
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urChanPerfPrev1DayReceivedBlks

urChanPerfPrev1DayUncorrectBlks

urChanTransmittedBlks

urConfRateMode

urCurrAtn

urCurrSnrMgn

urIntervalESs

urIntervalLoss

urIntervalNumber

urInvVendorID

urPerfCurr15MinESs

urPerfCurr15MinLoss

urPerfCurr15MinTimeElapsed

urPerfCurr1DayLofs

urPerfCurr1DayLprs

urPerfESs

urPerfLoss

urPerfPrev1DayESs

urPerfPrev1DayLoss

urThresh15MinESs

urThresh15MinLoss
adslAturChanPerfPrev1DayMoniSecs adslAt

adslAturChanPerfPrev1DayTransmittedBlks adslAt

adslAturChanReceivedBlks adslAt

adslAturChanUncorrectBlks adslAt

adslAturConfTargetSnrMgn adslAt

adslAturCurrAttainableRate adslAt

adslAturCurrStatus adslAt

adslAturIntervalLofs adslAt

adslAturIntervalLprs adslAt

adslAturInvSerialNumber adslAt

adslAturInvVersionNumber adslAt

adslAturPerfCurr15MinLofs adslAt

adslAturPerfCurr15MinLprs adslAt

adslAturPerfCurr1DayESs adslAt

adslAturPerfCurr1DayLoss adslAt

adslAturPerfCurr1DayTimeElapsed adslAt

adslAturPerfLofs adslAt

adslAturPerfLprs adslAt

adslAturPerfPrev1DayLofs adslAt

adslAturPerfPrev1DayLprs adslAt

adslAturThresh15MinLofs adslAt

Table 7-1 (continued)
adslLineMIBs
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adslAturThresh15MinLprs adslCompliances

adslConformance adslGroups

adslLineAlarmConfProfile adslLineCoding

—continued—
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adslLineConfProfile adslLineMib

adslLineMibAturCompliance adslLineMibCompliance

adslLineProfileName adslLineSpecific

adslLineType adslMibObjects

adslTraps

—end—

Table 7-2
adslExtensionMIBs

adslAtucPerfCurr15FailedFastR adslAtucPerfCurr15FastR

adslAtucPerfCurr1DayFailedFastR adslAtucPerfCurr1DayFastR

adslAtucPerfPrev1DayFailedFastR adslAtucPerfPrev1DayFastR

adslAtucThreshold15MinFailedFastR adslLineTransAtucCap

adslLineTransAturCap

Table 7-1 (continued)
adslLineMIBs
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Table 7-3
G.LiteExtensionMIBs

gLiteAtuFastRetrainEnabling gliteCapacity

gLiteCurrentRxProfile gLiteCurrentTxProfile

gliteDirectionTxRx gLiteFastRetrainControl

gLiteFastRetrainSNRMargin gliteProfile

gliteProfileUse transmissionModeEnabling
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ircuitAlarmSeverity

ircuitFaultType

ircuitTestDescr

ircuitTestResult

ircuitTestTimeStamp

AlarmNotif

CircuitDsBufferOvStatus

FaultStatus

Id

neConfProfileRowStatus

rfCurrDCLvl

rfCurrSummary

rfIntervalCrc

rfIntervalFarEndBitErrors

rfIntervalNumber

rfIntervalValidData

ucActualRate

ucCurrSnrMgn

ucDesiredRate
Table 7-4
sdsl MIBs

sdslCircuitAlarmNotif sdslC

sdslCircuitFaultStatus sdslC

sdslCircuitId sdslC

sdslCircuitTestErrCode sdslC

sdslCircuitTestStatus sdslC

sdslCircuitTestType sdslLc

sdslLcAlarmSeverity sdslLc

sdslLcCircuitFaultStatus sdslLc

sdslLcFaultType sdslLc

sdslLineConfProfileName sdslLi

sdslPerfCurrAAGCValue sdslPe

sdslPerfCurrInputSigLvl sdslPe

sdslPerfCurrTxGain sdslPe

sdslPerfIntervalErroredSeconds sdslPe

sdslPerfIntervalHec sdslPe

sdslPerfIntervalRecvBlocks sdslPe

sdslPerfIntervalXmitBlocks sdslSt

sdslStucCurrAtn sdslSt

sdslStucCurrStatus sdslSt
UE9000 DMS 297-8391-302 NA015

sdslStucInvSerialNumber sdslStucInvVersionNumber

sdslStucPerfCrc sdslStucPerfCurr1DayCrc

sdslStucPerfCurr1DayErrSecs sdslStucPerfCurr1DayFEBE

sdslStucPerfCurr1DayHec sdslStucPerfCurr1DayRecvBlocks

—continued—



Appendix D - MIBs  7-9

sdslStucPerfCurr1DayXmitBlocks sdslStucPerfCurr15MinCrc

sdslStucPerfCurr15MinErrSecs sdslStucPerfCurr15MinFEBE

sdslStucPerfCurr15MinHec sdslStucPerfCurr15MinRecvBlocks

sdslStucPerfCurr15MinXmitBlocks sdslStucPerfErrSecs

sdslStucPerfFEBE sdslStucPerfHec

sdslStucPerfInvalidInterval sdslStucPerfPrev1DayCrc

sdslStucPerfPrev1DayErrSecs sdslStucPerfPrev1DayFEBE

sdslStucPerfPrev1DayHec sdslStucPerfPrev1DayRecvBlocks

sdslStucPerfPrev1DayXmitBlocks sdslStucPerfRecvBlocks

sdslStucPerfValidInterval sdslStucPerfXmitBlocks

sdslSturCurrStatus

—end—

Table 7-4 (continued)
sdsl MIBs
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

Table 7-5
ImaMIBs

atmfImaMib atmfImaMibObjects

atmForum atmForumNetworkManagement

imaAlarmStatus imaAlarmType

imaFrameLength imaGroupAlphaValue

imaGroupBetaValue imaGroupDiffDelayMax

imaGroupDiffDelayMaxObs imaGroupFailureStatus

imaGroupFeNumFailures imaGroupFeState

imaGroupFeTxClkMode imaGroupGammaValue

imaGroupIfIndex imaGroupIndex

—continued—
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upLeastDelayLink

upMinNumRxLinks

upNeNumFailures

upNeTxClkMode

upNumRxCfgLnks

upNumTxCfgLnks

upRunningSecs

upRxFrameLength

upRxTimingRefLink

upSymmetry

upTestPattern

upTxAvailCellRate

upTxFrameLength

upTxTimingRefLink

kFailureStatus

kFeRxNumFailures

kFeRxUnusableSec

kFeTxNumFailures

kFeTxUnusableSec

kGroupIndex

kImaViolations
imaGroupLastChange imaGro

imaGroupMappingIndex imaGro

imaGroupMinNumTxLinks imaGro

imaGroupNeState imaGro

imaGroupNumRxActLnks imaGro

imaGroupNumTxActLnks imaGro

imaGroupRowStatus imaGro

imaGroupRxAvailCellRate imaGro

imaGroupRxImaId imaGro

imaGroupState imaGro

imaGroupTestLinkIfIndex imaGro

imaGroupTestProcStatus imaGro

imaGroupTxClkMode imaGro

imaGroupTxImaId imaGro

imaGroupUnavailSecs imaLin

imaLinkFeRxFailureStatus imaLin

imaLinkFeRxState imaLin

imaLinkFeSevErroredSec imaLin

imaLinkFeTxState imaLin

imaLinkFeUnavailSec imaLin

imaLinkIfIndex imaLin

Table 7-5 (continued)
ImaMIBs
UE9000 DMS 297-8391-302 NA015

imaLinkNeRxFailureStatus imaLinkNeRxNumFailures

imaLinkNeRxState imaLinkNeRxUnusableSec

imaLinkNeSevErroredSec imaLinkNeTxNumFailures

—continued—
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imaLinkNeTxState imaLinkNeTxUnusableSec

imaLinkNeUnavailSec imaLinkOifAnomalies

imaLinkRelDelay imaLinkRowStatus

imaLinkRxLid imaLinkRxStuffs

imaLinkRxTestPattern ImaLinkState

imaLinkTestProcStatus imaLinkTxLid

imaLinkTxStuffs ImaTestProcStatus

milliSeconds

—end—

Table 7-6
ue9000AtmMIBs

atmAlarmEntry atmAlarmNotify

atmAlarmSeverity atmAlarmTable

Table 7-5 (continued)
ImaMIBs
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atmAlarmType atmConfigCurrentOAM

atmConfigEmsInterface atmConfigEmsVci

atmConfigEmsVpi atmConfigEpdHi

atmConfigEpdLo atmConfigIfEntry

atmConfigIfInterface atmConfigIfSegmentId

atmConfigIfTable atmConfigMaxOAM

atmConfigPpd atmConfigStopAllOAM

atmConfigVcContinuityStatus atmConfigVcControl

atmConfigVcEntry atmConfigVcFaultStatus

atmConfigVcInterface atmConfigVcTable

atmConfigVcTestStatus atmConfigVcVci

—continued—
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nfigVpEntry

nfigVpInterface

nfigVpVpi

tsCounter

tsIfConfigHistory

tsIfConfigTable

tsIfDataEntry

tsIfDataInterval

tsIfInDiscarded

tsIfInDiscardedClp1

tsIfInNonCompliantClp0

tsIfInOam

tsIfInTagged

tsIfInTotalClp0

tsIfOutOam

tsIfOutTotalClp0

tsIfThreshCounter

tsIfThreshInterface

tsIfThreshTable

tsIfThreshValue

tsInterval
atmConfigVcVpi amtCo

atmConfigVpFaultStatus atmCo

atmConfigVpTable atmCo

atmFaultType atmSta

atmStatsIfConfigEntry atmSta

atmStatsIfConfigInterface atmSta

atmStatsIfConfigZero atmSta

atmStatsIfDataInterface atmSta

atmStatsIfDataTable atmSta

atmStatsIfInDiscardedClp0 atmSta

atmStatsIfInNonCompliant atmSta

atmStatsIfInNonCompliantClp1 atmSta

atmStatsIfInProtocolError atmSta

atmStatsIfInTotal atmSta

atmStatsIfInTotalClp1 atmSta

atmStatsIfOutTotal atmSta

atmStatsIfOutTotalClp1 atmSta

atmStatsIfThreshEntry atmSta

atmStatsIfThreshNotify atmSta

atmStatsIfThreshTrap atmSta

atmStatsIfValidity atmSta

Table 7-6 (continued)
ue9000AtmMIBs
UE9000 DMS 297-8391-302 NA015

atmStatsVcConfigEntry atmStatsVcConfigHistory

atmStatsVcConfigInterface atmStatsVcConfigTable

atmStatsVcConfigVci atmStatsVcConfigVpi

—continued—
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atmStatsVcConfigZero atmStatsVcDataEntry

atmStatsVcDataInterface atmStatsVcDataInterval

atmStatsVcDataTable atmStatsVcDataVci

atmStatsVcDataVpi atmStatsVcInDiscarded

atmStatsVcInDiscardedClp0 atmStatsVcInDiscardedClp1

atmStatsVcInNonCompliant atmStatsVcInNonCompliantClp0

atmStatsVcInNonCompliantClp1 atmStatsVcInOam

atmStatsVcInProtocolError atmStatsVcInTagged

atmStatsVcInTotal atmStatsVcInTotalClp0

atmStatsVcInTotalClp1 atmStatsVcOutOam

atmStatsVcOutTotal atmStatsVcOutTotalClp0

atmStatsVcOutTotalClp1 atmStatsVcThreshCounter

atmStatsVcThreshEntry atmStatsVcThreshInterface

Table 7-6 (continued)
ue9000AtmMIBs
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atmStatsVcThreshNotify atmStatsVcThreshTable

atmStatsVcThreshTrap atmStatsVcThreshValue

atmStatsVcThreshVci atmStatsVcThreshVpi

atmStatsVcValidity atmStatsVpConfigEntry

atmStatsVpConfigHistory atmStatsVpConfigInterface

atmStatsVpConfigTable atmStatsVpConfigVpi

atmStatsVpConfigZero atmStatsVpDataEntry

atmStatsVpDataInterface atmStatsVpDataInterval

atmStatsVpDataTable atmStatsVpDataVpi

atmStatsVpInDiscarded atmStatsVpInDiscardedClp0

atmStatsVpInDiscardedClp1 atmStatsVpInNonCompliant

—continued—
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tsVpInNonCompliantClp1

tsVpInProtocolError

tsVpInTotal

tsVpInTotalClp1

tsVpOutTotal

tsVpOutTotalClp1

tsVpThreshEntry

tsVpThreshNotify

tsVpThresh

tsVpThreshVpi

stVcContinuityMode

stVcDesc

stVcInterface

stVcParm

stVcTable

stVcType

stVcVpi
atmStatsVpInNonCompliantClp0 atmSta

atmStatsVpInOam atmSta

atmStatsVpInTagged atmSta

atmStatsVpInTotalClp0 atmSta

atmStatsVpOutOam atmSta

atmStatsVpOutTotalClp0 atmSta

atmStatsVpThreshCounter atmSta

atmStatsVpThreshInterface atmSta

atmStatsVpThreshTable atmSta

atmStatsVpThreshValue atmSta

atmStatsVpValidity atmTe

atmTestVcCode atmTe

atmTestVcEntry atmTe

atmTestVcMode atmTe

atmTestVcResult atmTe

atmTestVcTimeStamp atmTe

atmTestVcVci atmTe

—end—

Table 7-7
ue9000CarrierMIBs

Table 7-6 (continued)
ue9000AtmMIBs
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carrierAdminState carrierAlarmEntry

carrierAlarmNotif carrierAlarmSeverity

carrierAlarmStatus carrierAlarmTable

carrierAvailStatus carrierConfigStatus

—continued—
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carrierControlStatus carrierCurrentEntry

carrierCurrentFarEndIDF carrierCurrentNearEndIDF

carrierCurrentTable carrierEntry

carrierFaultStatus carrierFaultType

carrierId carrierIntervalEntry

carrierIntervalFarEndIDF carrierIntervalNearEndIDF

carrierIntervalTable carrierName

carrierOperState carrierPerfMon

carrierProcStatus carrierProtSwitch

carrierStandbyStatus carrierTable

carrierTestDescr carrierTestEntry

carrierTestErrCode carrierTestResult

carrierTestTable carrierTestTimeStamp

Table 7-7 (continued)
ue9000CarrierMIBs
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carrierTestType carrierThreshold15Min

carrierThreshold24Hr carrierThresholdEntry

carrierThresholdNotif carrierThresholdTable

carrierThresholdType carrierTotalEntry

carrierTotalFarEndIDF carrierTotalNearEndIDF

carrierTotalTable carrierUnknownStatus

carrierUsageState

—end—
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3AlarmEntry

3AlarmSeverity

3AlarmTable

3CellScrambling

3ConvSublayerMapp

3CurrentFarEndIDF

3rCurrentTable

3FaultStatus

3FaultType

3IntervalEntry

3IntervalNearEndIDF

3Name

3PerfMon

3Table

3TestEntry

3TestResult

3TestTimeStamp

3Threshold15Min

3ThresholdEntry

3ThresholdTable
Table 7-8
ue9000CarrDS3MIBs

CarrDS3AdminState CarrDS

CarrDS3AlarmNotif CarrDS

CarrDS3AlarmStatus CarrDS

CarrDS3AvailStatus CarrDS

CarrDS3ConfigRowStatus CarrDS

CarrDS3CurrentEntry CarrDS

CarrDS3CurrentNearEndIDF CarrDS

CarrDS3Entry CarrDS

CarrDS3FaultStatusBitMapp CarrDS

CarrDS3Id CarrDS

CarrDS3IntervalFarEndIDF CarrDS

CarrDS3IntervalTable CarrDS

CarrDS3OperState CarrDS

CarrDS3ProcStatus CarrDS

CarrDS3TestDescr CarrDS

CarrDS3TestErrCode CarrDS

CarrDS3TestTable CarrDS

CarrDS3TestType CarrDS

CarrDS3Threshold24Hr CarrDS

CarrDS3ThresholdNotif CarrDS
UE9000 DMS 297-8391-302 NA015

CarrDS3ThresholdType CarrDS3TotalEntry

CarrDS3TotalFarEndIDF CarrDS3TotalNearEndIDF

CarrDS3TotalTable
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Table 7-9
ue9000CircuitMIBs

circuit15MinThreshold circuitAdminState

circuitAlarmNotif circuitAlarmSeverity

circuitAlarmStatus circuitAtuc15MinThreshCrcI

circuitAtuc15MinThreshFecI circuitAtuc15MinThreshHecI

circuitAtuc15MinThreshLcdI circuitAtuc15MinThresholdTable

circuitAtucPerfCrcI circuitAtucPerfCurr15MinCrcI

circuitAtucPerfCurr15MinFecI circuitAtucPerfCurr15MinHecI

circuitAtucPerfCurr15MinLcdI circuitAtucPerfCurr1DayCrcI

circuitAtucPerfCurr1DayFecI circuitAtucPerfCurr1DayHecI

circuitAtucPerfCurr1DayLcdI circuitAtucPerfFecI

circuitAtucPerfHecI circuitAtucPerfLcdI

circuitAtucPerfPrev1DayCrcI circuitAtucPerfPrev1DayFecI

circuitAtucPerfPrev1DayHecI circuitAtucPerfPrev1DayLcdI
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

circuitAturPerfBlockErrorI circuitAturPerfCurr15MinBlockErrorI

circuitAturPerfCurr15MinFecI circuitAturPerfCurr15MinHecI

circuitAturPerfCurr15MinLcdI circuitAturPerfCurr1DayBlockErrorI

circuitAturPerfCurr1DayFecI circuitAturPerfCurr1DayLcdI

circuitAturPerfFecI circuitAturPerfHecI

circuitAturPerfInvalidInterval circuitAturPerfLcdI

circuitAturPerfPrev1DayBlockErrorI circuitAturPerfPrev1DayFecI

circuitAturPerfPrev1DayHecI circuitAturPerfPrev1DayLcdI

circuitAturPerfValidInterval circuitAvailStatus

circuitBin circuitConfigStatus

circuitControlStatus circuitFaultStatus

—continued—
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d

perState

rocStatus

estDescr

estInProgress

estTimeStamp

nknownStatus

adCommunity

MinThreshTrap

minState

rmStatus

fferOverflow

scr

wnloadComplete

ultClear

ultStatus
circuitFaultType circuitI

circuitName circuitO

circuitPower circuitP

circuitStandbyStatus circuitT

circuitTestErrCode circuitT

circuitTestResult circuitT

circuitTestType circuitU

circuitUsageState

—end—

Table 7-10
ue9000FrameworkMIBs

authAdminCommunity authRe

authWriteCommunity trap15

trap24HrThreshTrap trapAd

trapAlarmSeverity trapAla

trapAvailStatus trapBu

trapControlStatus trapDe

trapDownloadBegin trapDo

trapDownloadType trapFa

trapFaultOccur trapFa

Table 7-9 (continued)
ue9000CircuitMIBs
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trapFaultType trapInterfaceId

trapInventoryFlag trapInventoryPec

trapInventoryShelf trapInventorySlot

trapLoadBegin trapOperState

—continued—
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trapProcStatus trapQualifier

trapRestartBegin trapRestartComplete

trapRestartType trapSeqNo

trapStandbyStatus trapStateChange

trapStatusChange trapTestBegin

trapTestComplete trapTestDescr

trapTestErrCode trapTestResult

trapTestType trapThreshold15Min

trapThreshold24Hr trapThresholdType

trapTimeStamp trapUemsInterval

trapUemsIpAddress trapUemsLastAck

trapUemsMode trapUemsRowStatus

trapUemsSeqNo trapUemsTimeout

Table 7-10 (continued)
ue9000FrameworkMIBs
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trapUnknownStatus trapUsageState

trapVci trapVpi

—end—

Table 7-11
ue9000nvStoreMIBs

nvStoreCfgActiveBank nvStoreCfgCount

nvStoreCfgErrorMessage nvStoreCfgErrorsDetected

nvStoreCfgFirstErrorDetected nvStoreCfgFirstErroredOID

nvStoreCfgStatus nvStoreCfgTIme

nvStoreCfgVersion nvStoreDldControl

nvStoreDldFile nvStoreDldResult

—continued—
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eDldStatus

StoreCfgComplete

StoreDldComplete

liance

r

ralGroup

BroadcastPkts

Octets

tBroadcastPkts

tOctets

cketGroup

adcastPkts

cards

ticastPkts
nvStoreDldSize nvStor

nvStoreDldVersion trapNV

trapNVStoreCfgError trapNV

—end—

Table 7-12
IANAifTypeMIB

IANAifType

Table 7-13
ifMIBs

ifAdminStatus ifComp

ifConnectorPresent ifDesc

ifFixedLengthGroup ifGene

ifHCFixedLengthGroup ifHCIn

ifHCInMulticastPkts ifHCIn

ifHCInUcastPkts ifHCOu

ifHCOutMulticastPkts ifHCOu

ifHCOutUcastPkts ifHCPa

ifHighSpeed ifInBro

ifIndex ifInDis

ifInErrors ifInMul

Table 7-11 (continued)
ue9000nvStoreMIBs
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ifInOctets ifInUcastPkts

ifInUnknownProtos ifLastChange

ifLinkUpDownTrapEnable ifMIBObjects

ifMtu ifName

—continued—
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ifNumber ifOperStatus

ifOutBroadcastPkts ifOutDiscards

ifOutErrors ifOutMulticastPkts

ifOutOctets ifOutUcastPkts

ifPacketGroup ifPhysAddress

ifPromiscuousMode ifRcvAddressAddress

ifRcvAddressGroup ifRcvAddressStatus

ifRcvAddressType ifSpeed

ifStackGroup ifStackHigherLayer

ifStackLowerLayer ifStackStatus

ifTestCode ifTestGroup

ifTestId ifTestOwner

ifTestResult ifTestStatus

Table 7-13 (continued)
ifMIBs
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ifTestType ifType

ifVHCPacketGroup interfaceIndex

ownerString

—end—

Table 7-14
UE9000LinecardMIBs

lcAdminState lcAlarmNotif

lcAlarmSeverity lcAlarmStatus

lcAtucDownload lcAvailStatus

lcConfigStatus lcControlStatus

lcFaultStatus lcFaultType

—continued—
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e

Software

artTimeStamp

tor

dbyStatus

rrCode

imeStamp

ownStatus

larmCardType

larmMajor

larmNone

larmWarning

lock

ventoryBitMap

ventoryChangeTrap
lcId lcNam

lcOperState lcPec

lcProcStatus lcProv

lcRestartSoftware lcRest

lcRestartType lcSelec

lcSoftware lcStan

lcTestDescr lcTestE

lcTestResult lcTestT

lcTestType lcUnkn

lcUsageState

—end—

Table 7-15
ue9000NodeMIBs

nodeAdminState nodeA

nodeAlarmCritical nodeA

nodeAlarmMinor nodeA

nodeAlarmStatus nodeA

nodeAvailStatus nodeC

nodeControlStatus nodeIn

nodeInventoryBitMapShelf nodeIn

Table 7-14 (continued)
UE9000LinecardMIBs
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nodeInventoryPec nodeInventoryShelf

nodeInventorySlot nodeMode

nodeName nodeOperState

nodeProcStatus nodeRestartTimeStamp

—continued—



Appendix D - MIBs  7-23

nodeRestartType nodeStandbyStatus

nodeUnknownStatus nodeUsageState

—end—

Table 7-16
perfHistTCMIBs

perfCurrentCount perfIntervalCount

perfTotalCount xyzInvalidIntervals

xyzTimeElapsed xyzValidIntervals

Table 7-17
RFC1213MIBs

egpAs egpInErrors

egpInMsgs egpNeighAddr

egpNeighAs egpNeighEventTrigger

Table 7-15 (continued)
ue9000NodeMIBs
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egpNeighInErrMsgs egpNeighInErrs

egpNeighInMsgs egpNeighIntervalHello

egpNeighIntervalPoll egpNeighMode

egpNeighOutErrMsgs egpNeighOutErrs

egpNeighOutMsgs egpNeighState

egpNeighStateDowns egpNeighStateUps

egpOutErrors egpOutMsgs

icmpInAddrMaskReps icmpInAddrMasks

icmpInDestUnreachs icmpInEchoReps

icmpInEchos icmpInErrors

icmpInMsgs icmpInParmProbs

—continued—
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SrcQuenchs

TimestampReps

utAddrMaskReps

utDestUnreachs

utEchos

utMsgs

utRedirects

utTimeExcds

utTimestamps

r

cards

castPkts

stPkts

hange

er

iscards

UcastPkts

Len

ddress

d

icmpInRedirects icmpIn

icmpInTimeExcds icmpIn

icmpInTimestamps icmpO

icmpOutAddrMasks icmpO

icmpOutEchoReps icmpO

icmpOutErrors icmpO

icmpOutParmProbs icmpO

icmpOutSrcQuenchs icmpO

icmpOutTimestampReps icmpO

ifAdminStatus ifDesc

ifIndex ifInDis

ifInErrors ifInNU

ifInOctets ifInUca

ifInUnknownProtos ifLastC

ifMtu ifNumb

ifOperStatus ifOutD

ifOutErrors ifOutN

ifOutOctets ifOutQ

ifOutUcastPkts ifPhysA

ifSpecific ifSpee

—continued—

Table 7-17 (continued)
RFC1213MIBs
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ifType ipAdEntAddr

ipAdEntBcastAddr ipAdEntIfIndex

ipAdEntNetMask ipAdEntReasmMaxSize

ipDefaultTTL ipForwarding
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ipForwDatagrams ipFragCreates

ipFragFails ipFragOKs

ipInAddrErrors ipInDelivers

ipInDiscards ipInHdrErrors

ipInReceives ipInUnknownProtos

ipNetToMediaIfIndex ipNetToMediaNetAddress

ipNetToMediaPhysAddress ipNetToMediaType

ipOutDiscards ipOutNoRoutes

ipOutRequests ipReasmFails

ipReasmOKs ipReasmReqds

ipReasmTimeout ipRouteAge

ipRouteDest ipRouteIfIndex

ipRouteInfo ipRouteMask

ipRouteMetric1 ipRouteMetric2

Table 7-17 (continued)
RFC1213MIBs
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ipRouteMetric3 ipRouteMetric4

ipRouteMetric5 ipRouteNextHop

ipRouteProto ipRouteType

ipRoutingDiscards snmpEnableAuthenTraps

snmpInASNParseErrs snmpInBadCommunityNames

snmpInBadCommunityUses snmpInBadValues

snmpInBadVersions snmpInGenErrs

snmpInGetNexts snmpInGetRequests

snmpInGetResponses snmpInNoSuchNames

snmpInPkts snmpInReadOnlys

—continued—



7-26   Appendix D - MIBs

TooBigs

TotalSetVars

utBadValues

utGetNexts

utGetResponses

utPkts

utTooBigs

ntact

ation

jectID

Time

mptFails

nLocalPort

nRemPort

rEstab

rrs

Conn

siveOpens

Algorithm

Min

rrors
snmpInSetRequests snmpIn

snmpInTotalReqVars snmpIn

snmpInTraps snmpO

snmpOutGenErrs snmpO

snmpOutGetRequests snmpO

snmpOutNoSuchNames snmpO

snmpOutSetRequests snmpO

snmpOutTraps sysCo

sysDescr sysLoc

sysName sysOb

sysServices sysUp

tcpActiveOpens tcpAtte

tcpConnLocalAddress tcpCon

tcpConnRemAddress tcpCon

tcpConnState tcpCur

tcpEstabResets tcpInE

tcpInSegs tcpMax

tcpOutSegs tcpPas

tcpRetransSegs tcpRto

tcpRtoMax tcpRto

udpInDatagrams udpInE

Table 7-17 (continued)
RFC1213MIBs
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udpLocalAddress udpLocalPort

udpNoPorts udpOutDatagrams

—end—
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Table 7-18
RFC1406MIBs

dsx1CircuitIdentifier dsx1CurrentESs

dsx1CurrentIndex dsx1CurrentLCVs

dsx1CurrentLESs dsx1CurrentPCVs

dsx1CurrentSEFSs dsx1CurrentSESs

dsx1CurrentUASs dsx1FarEndCurrentESs

dsx1FarEndCurrentIndex dsx1FarEndCurrentLESs

dsx1FarEndCurrentPCVs dsx1FarEndCurrentSEFSs

dsx1FarEndCurrentSESs dsx1FarEndCurrentUASs

dsx1FarEndIntervalESs dsx1FarEndIntervalIndex

dsx1FarEndIntervalLESs dsx1FarEndIntervalNumber

dsx1FarEndIntervalPCVs dsx1FarEndIntervalSEFSs

dsx1FarEndIntervalSESs dsx1FarEndIntervalUASs

dsx1FarEndTimeElapsed dsx1FarEndTotalESs
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dsx1FarEndTotalIndex dsx1FarEndTotalLESs

dsx1FarEndTotalPCVs dsx1FarEndTotalSEFSs

dsx1FarEndTotalSESs dsx1FarEndTotalUASs

dsx1FarEndValidIntervals dsx1Fdl

dsx1IfIndex dsx1IntervalESs

dsx1IntervalIndex dsx1IntervalLCVs

dsx1IntervalLESs dsx1IntervalNumber

dsx1IntervalPCVs dsx1IntervalSEFSs

dsx1IntervalSESs dsx1IntervalUASs

dsx1LineCoding dsx1LineIndex

dsx1LineStatus dsx1LineType

—continued—
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endCode

talESs

talLCVs

talPCVs

talSESs

ansmitClockSource

erfaceConfVpcs

erfaceCurrentMaxVpiBits

erfaceMaxActiveVpiBits

erfaceMaxVpcs

fficDescrParam1

fficDescrParamIndex

fficDescrRowStatus

fficFrameDiscard

CrossConnectH2LLastChange

CrossConnectHighIfIndex
dsx1LoopbackConfig dsx1S

dsx1TimeElapsed dsx1To

dsx1TotalIndex dsx1To

dsx1TotalLESs dsx1To

dsx1TotalSEFSs dsx1To

dsx1TotalUASs dsx1Tr

dsx1ValidIntervals

—end—

Table 7-19
atmMIBs

atmInterfaceConfVccs atmInt

atmInterfaceCurrentMaxVciBits atmInt

atmInterfaceMaxActiveVciBits atmInt

atmInterfaceMaxVccs atmInt

atmServiceCategory atmTra

atmTrafficDescrParam2 atmTra

atmTrafficDescrParamIndexNext atmTra

atmTrafficDescrType atmTra

atmVcCrossConnectAdminStatus atmVc

atmVcCrossConnectH2LOperStatus atmVc

Table 7-18 (continued)
RFC1406MIBs
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atmVcCrossConnectHighVci atmVcCrossConnectHighVpi

atmVcCrossConnectIndex atmVcCrossConnectIndexNext

atmVcCrossConnectL2HLastChange atmVcCrossConnectL2HOperStatus

—continued—
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atmVcCrossConnectLowIfIndex atmVcCrossConnectLowVci

atmVcCrossConnectLowVpi atmVcCrossConnectRowStatus

atmVclAdminStatus atmVclCastType

atmVclConnKind atmVclCrossConnectIdentifier

atmVclLastChange atmVclOperStatus

atmVclReceiveTrafficDescrIndex atmVclRowStatus

atmVclTransmitTrafficDescrIndex atmVclVci

atmVclVpi

—end—

Table 7-20
atmTCMIBs

atmAddr atmClpNoTaggingMcr

atmClpNoTaggingScr atmClpNoTaggingScrCdvt

Table 7-19 (continued)
atmMIBs
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atmClpTaggingScr atmClpTaggingScrCdvt

atmClpTransparentNoScr atmClpTransparentScr

atmConnCastType atmConnKind

atmIlmiNetworkPrefix atmInterfaceType

atmNoClpNoScr atmNoClpNoScrCdvt

atmNoClpScr atmNoClpScrCdvt

atmNoClpTaggingNoScr atmServiceCategory

atmSigDescrParamIndex atmTrafficDescriptorTypes

atmTrafficDescrParamIndex atmVcIdentifier

atmVorXAdminStatus atmVorXLastChange

atmVorXOperStatus atmVpIdentifier



7-30   Appendix D - MIBs

inistrativeState

ilabilityStatus

rationalState

ndbyStatus

geState

r

y

minState

rmSeverity

ailStatus

ntrolStatus

ultType

lation

erState

cStatus

startTimeStamp

ftware
Table 7-21
ue9000ModulesMIBs

activity card

identifier isoAdm

isoAlarmStatus isoAva

isoControlStatus isoOpe

isoProceduralStatus isoSta

isoUnknownStatus isoUsa

notification qualifie

restart severit

testResult

Table 7-22
ue9000UnitMIBs

unitActivity unitAd

unitAlarmNotif unitAla

unitAlarmStatus unitAv

unitConfigStatus unitCo

unitFaultStatus unitFa

unitId unitIso

unitName unitOp

unitPec unitPro

unitRestartSoftware unitRe

unitRestartType unitSo
UE9000 DMS 297-8391-302 NA015

unitSoftwareLoadTrap unitStandbyStatus

unitSwactTrap unitTestDescr

unitTestErrCode unitTestResult

unitTestTimeStamp unitTestType

unitUnknownStatus unitUsageState
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Table 7-23
snmpFrameworkMIBs

snmpAdminString snmpAuthProtocols

snmpEngineBoots snmpEngineGroup

snmpEngineID snmpEngineMaxMessageSize

snmpEngineTime snmpFrameworkAdmin

snmpFrameworkMIBCompliance snmpFrameworkMIBCompliances

snmpFrameworkMIBConformance snmpFrameworkMIBGroups

snmpFrameworkMIBObjects snmpMessageProcessingModel

snmpPrivProtocols snmpSecurityLevel

snmpSecurityModel

Table 7-24
onemeglcMIBs

onemeglcConfigTable onemeglcSwitchingTimeActivated

onemeglcConfigEntry onemeglcDeviceIndex
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onemeglcEthernetLocalSwitching onemeglcTestTable

onemeglcBroadcastFiltering onemeglcTestEntry

onemeglcProviderMacLearning onemeglcTestType

onemeglcSwitchingTableTimeout onemeglcTestResult

onemeglcArpThroughput onemeglcTestErrCode

onemeglcCpeDownloadFile onemeglcTestTimeStamp

onemeglcStatusTable onemeglcTestTimeStamp

onemeglcStatusEntry onemeglcTestInProgress

onemeglcDevicesPerInterface onemeglcSysLogTable

onemeglcDiscardsDS onemeglcSysLogEntry

onemeglcFilteredARPsDS onemeglcSysLogPage

—continued—
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eglcDatapathLogTable

eglcDatapathLogEntry

eglcDatapathLogPage

eglcCurrentLogLine

eglcLineLogTable

eglcLineLogEntry

eglcLineLogPage

egctEnergyValue

egctTimePeek

egctXlBusSyncFound

egctOffHookStatus

egctTxPower

egctJTag

egctSpareI

egctCpeStatusTable

egctCpeStatusEntry

egctCpeIdentification
onemeglcFilteredARPsUS onem

onemeglcFilteredNUPktsDS onem

onemeglcFilteredNUPktsUS onem

onemeglcSwitchingTable onem

onemeglcSwitchingEntry onem

onemeglcLearnedMac onem

onemeglcSwitchingValid onem

onemeglcSwitchingTimeLearned

Table 7-25
onemegctMIBs

onemegctConfigTable onem

onemegctConfigEntry onem

onemegctMaxSpeedDown onem

onemegctMaxSpeedUp onem

onemegctOffHookControl onem

onemegctCpeMaxOffHookPowerLevel onem

onemegctLoopDevices onem

onemegctCpeReset onem

onemegctCpeDownloadControl onem

onemegctStatusTable onem

Table 7-24 (continued)
onemeglcMIBs
UE9000 DMS 297-8391-302 NA015

onemegctStatusEntry onemegctCpeProductCode

onemegctStatusRx onemegctCpeState

onemegctStatusTx onemegctCpeEthInSyncDetect

onemegctSpeedDownstream onemegctCpeErrorPower

—continued—
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onemegctSpeedUpstream onemegctCpeLoopback

onemegctProviderValid onemegctCpeEthInOctets

onemegctLearnedProviderMac onemegctCpeEthInUcastPkts

onemegctLoopDeviceCount onemegctCpeEthInErrors

onemegctInOctets onemegctCpeEthInFCSErrors

onemegctInUcastPkts onemegctCpeEthInFrameTooLongs

onemegctInNUcastPkts onemegctCpeEthOutExcessiveCollisions

onemegctInDiscards onemegctCpeEthOutOctets

onemegctInErrors onemegctCpeLoopInFrames

onemegctInUnknownProtos onemegctCpeLoopInCRC8

onemegctOutOctets onemegctCpeLoopInCRC32

onemegctOutUcastPkts onemegctCpeLoopInErrors

onemegctOutNUcastPkts onemegctCpeLoopSyncFound

onemegctOutDiscards onemegctCpeTxPower

Table 7-25 (continued)
onemegctMIBs
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

onemegctOutErrors onemegctCpeRxCorrections

onemegctOutQLen onemegctCpeLoadFile  (not implemented in
AD3.0)

onemegctDSLoopErrorRate onemegctCpeDownloadStatus  (not
implemented in AD3.0)

onemegctUSLoopErrorRate onemegctTestTable

onemegctRxCRC8 onemegctTestEntry

onemegctRxCRC32 onemegctTestType

onemegctRxSyncFound onemegctTestResult

onemegctRxCorrections onemegctTestErrCode

onemegctRxErrors onemegctTestTimeStamp

—continued—
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egctTestDescr

egctTestInProgress
onemegctErrorPower onem

onemegctAGCIn onem

—end—

Table 7-25 (continued)
onemegctMIBs
UE9000 DMS 297-8391-302 NA015
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List of terms 8-

This chapter defines many of the acronyms and terms used in this user guide.

10Base-T
An Ethernet standard that allows Ethernet encoded data to be transported over
unshielded twisted pair telephone wire. 10Base-T provides an operating rate
of 10 megabits per second.

ADSL
asymmetric digital subscriber line. It is modem technology that enables the
UE9000 CPE to send both data and voice over existing twisted pair copper
wires to and from the end user. The data and voice signals are sent using
different spectrums, which allow both signals to be sent over the same wire
simultaneously. ADSL technology is asymmetric, which means more

ARP

ATU-C

ATU-R
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

information can be sent one way than the other on the wire.

address resolution protocol, which is a protocol in the TCP/IP suite of
protocols. ARP sends out a broadcast message to all the nodes on a network
with a logical address (such as an IP address). The node that matches that
logical address responds back with its hardware address (such as a MAC
address). In this way, ARP locates the devices on a network.

ADSL transceiver unit, central office end. Traffic from the ATU-R to the
ATU-C is considered to be upstream. Traffic from the ATU-C to the ATU-R
is considered to be downstream.

ADSL transceiver unit, remote end. Traffic from the ATU-R to the ATU-C is
considered to be upstream. Traffic from the ATU-C to the ATU-R is
considered to be downstream.
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st unit of information that a computer can

th which is used to represent a value, such as
bol, and so on. A byte is usually 8 bits long.

remise equipment, which is the modem in the
UE9000 CPE routes voice traffic from a
affic from one computer to the ANX and

e card is currently the only type of DAC that

res user notification. uEMS events are
llowing are some conditions that generate

ded

 changed
bit
binary digit, which is the smalle
process. A bit is either a 0 or 1.

byte
a group of bits of a defined leng
a letter, punctuation mark, sym

CO
central office

CPE
Universal Edge 9000 customer p
end-user’s home or office. The 
standard telephone and data tr
vice-versa.

DAC
data access card. The ATM cor
uEMS supports.

DLC
digital loop carrier

DMS
digital multiplex switch

event
a system occurrence that requi
generated using SNMP. The fo
uEMS events:

• a threshold limit was excee

• the configuration of a node
UE9000 DMS 297-8391-302 NA015

• the status of a node changed

• a warm or cold restart occurred on a node

gateway
a device that connects two separate networks together. A gateway allows
devices on one network to access a second network.
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GUI
graphical user interface

HEC
header error check

HPOV NNM
Hewlett Packard OpenView Network Node Manager. This is an Internet
protocol (IP) network manager application. It is also used to provide a
common manager platform for multiple applications such as uEMS.

HSTP
high speed twisted pair

IMA
inverse multiplexing over asynchronous transfer mode

IP
Internet protocol, a protocol in the TCP/IP suite of protocols

LAN
local area network

MAC address
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media access control address, used by Ethernet to identify the physical
address of a device (such as a circuit card)

map
consists of a collection of submaps that are used to view the UE9000 network.
A map cannot typically be viewed in its entirety.

MDF
main distribution frame

MIB
management information base. A MIB is a collection of standard information
about a device. Each managed device on the UE9000 network has a MIB that
is accessed using SNMP.

MLC
multi-circuit line card
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ntenance, & provisioning

atabase which is used to represent the
the UE9000 network. An object can be a
are device, or a logical entity, such as a group

e byte (8 bits long)

module for the common-equipment shelf or
he OPC provides OAM&P to the access

lves, host digital terminals (HDT), and other
 control.

achines having similar functions to
NIC
network interface card

NNM
Network Node Manager

OAM&P
operations, administration, mai

object
is an entry in the HPOV NNM d
attributes of a specific entity in 
physical entity, such as a hardw
of hardware devices.

octet
a frame of information that is on

OPC
operations controller. A plug-in 
an operations controller shelf. T
bandwidth manager (ABM) she
network elements in its span of

POTS
plain old telephone service

PPP
point-to-point protocol

protocol
a set of rules that enables two m
communicate with each other

PSTN
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public switched telephone network
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selection name
HP OpenView and uEMS software identify objects by their selection name
and unique name. No two objects in the same network can have the same
selection name. The selection name must be unique for each object in the
uEMS database. The selection name can be sixteen characters long. Do not
use spaces. It can consist of alphanumeric and symbol characters.

SNMP
simple network management protocol, a network management service in the
TCP/IP protocol suite. SNMP uses four basic commands: GET, GET-NEXT,
SET, and TRAP. SNMP is supported by most IP devices and nodes.

• A GET request retrieves information from a device or node.

• A SET request changes a parameter on a device or node.

• A TRAP request contains information that is sent by a device or node to
its management station.

submap
a view of a specific section of the UE9000 network

subnet mask
a number used to identify a subnetwork. Subnet masks allow a number of
different subnetworks in a LAN to share the same IP address. These
subnetworks can be physically independent from each other.
UE9000 DMS Data OAM&P User Guide 297-8391-302 Standard 01.01

symbol
a graphical representation on the uEMS submap screen of a UE9000
component in the uEMS database. A symbol can be an icon or a connection
symbol. An icon symbol represents a single UE9000 component in the uEMS
database, such as an ATM interface circuit card. A connection symbol
represents the connection between two UE9000 components, such as the
ADSL subscriber circuit connecting a Universal Edge 9000 customer premise
equipment modem (CPE) and an ADSL multi-circuit line card.

TCP
transmission control protocol, which is a protocol in the TCP/IP suite of
protocols. It provides reliable end-to-end data transmission.

TFTP
trivial file transfer protocol
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anagement System, which is a graphical user
 for UE9000 data service. uEMS runs on a
tion or a Sun Microsystems Solaris

. uEMS communicates with the data

ic name for digital subscriber line equipment
 line technologies provide high-speed digital
used for analog connection. Some DSL
SL, Nortel Networks proprietary 1-Meg
.ee also ADSL.

 this document that refer to xDSL line cards
Modem, and SDSL multi-circuit line cards.
uEMS
Universal Edge 9000 Element M
interface that provides OAM&P
Hewlett-Packard UNIX worksta
workstation running HPOV NNM
processor using SNMP.

VF
voice frequency

VLAN
virtual local area network

xDSL
x digital subscriber line. A gener
and services. Digital subscriber
bit stream over the same wires 
technologies are asymmetric D
Modem, and synchronous DSLS

Procedures and descriptions in
apply to the ADSL 4+4, 1-Meg 
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A
Abstract Syntax Notation7-1
ADSL line card on UE9000,

provisioning 1-43
ADSL subscriber circuit on UE9000,

provisioning 1-46
adslExtensionMIBS 7-7
adslExtensionMIBs 7-7
Alarm Browser 4-20
ASN 7-1
Asynchronous transfer mode. See ATM
ATM circuit card

OAM testing 4
ATM core card

provisioning 1
software upgra

C
Circuit card

software upgra
Colors, in uEMS

D
Database

administering U
backing up 3-
HP OpenView
monitoring par
restoring 3-10
var partition 3

DS1 facility on UE9000, provisioning1-37
DS3 facility on UE9000, provisioning1-39

E
Equipment

provisioning order 1-4
status of 4-2
updating information 1-58

Event 4-2
Event Browser 4-18
Event Categories window4-18
severity 4-27
UE9000 D

-24

-31
de3-2, 3-4

de3-2, 3-4
4-27

E90003-7
10
3-7

tition sizes3

-8
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description of 4-6

-8

G
G.LiteExtensionMIBs 7-7

H
Hewlett Packard OpenView, starting5-2, 2,

3

L
Line card

xDSL line card
software upgrade3-2

M
Management information base7-1
Map
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rce provisioning 1-60, 2-28
der 1-4
rvice descriptor1-16, 1-18
rvice descriptor group1-7, 1-12

E9000 equipment
ADSL line card 1-43
ADSL subscriber circuit 1-46
ATM core card 1-31
HSTP-Name 2-5
network element 1-24
network name 2-5
shelf 1-27

E9000 facility
DS1 facility 1-37
DS3 facility 1-39

NIX scripts
at command 2-33
scheduling 2-33
using 2-29
dating information 1-58

rtual paths 1-13

IBs 7-8
rity

POV file permissions 3-13
twork 3-13

NMP community strings3-14
E9000 data service3-13
NIX/Solaris log in passwords3-13
er 3-13
ice descriptor
ovisioning 1-16, 1-18
UE9000CarrierMIBs 7-14
UE9000CircuitMIBs 7-17
UE9000FrameworkMIBs 7-18
UE9000LinecardMIBs 7-21
UE9000ModulesMIBs 7-30
UE9000NodeMIBs 7-22
UE9000UnitMIBs 7-30

MIBs 7-1

N
Navigation, in uEMS 1-5
Network element, provisioning1-24

O
onemegctMIBs 7-32
onemegicMIBs 7-31

up
vi

S
sdslM
Secu

H
ne
S
U
U
us

Serv
pr
opening a temporary map1-82
MIB

adslExtensionMIBs 7-7
adslLineMIBs 7-4
atmMIBs 7-28
atmTCMIBs 7-29
G.LiteExtensionMIBs 7-7
IANAifTypeMIB 7-20
ifMIBs 7-20
ImaMIBs 7-9
perfHistTCMIBs 7-23
RFC1213MIBs 7-23
RFC1406MIBs 7-27
snmpFrameworkMIBs 7-31
UE9000AtmMIBs 7-11
UE9000CarrDS3MIBs 7-16

fo
or
se
se
U

U

U
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P
Preside Applications Platform1
Provisioning

bulk provisioning 2-29
CLUI, getting help 2-6
CLUI, using 2-29
for F5 loopback tests4-24

submap 4-17
viewing 1-81

Service descriptor group
provisioning 1-7, 1-12
submap 4-16

Severity, of events in uEMS4-27
Shelf, provisioning 1-27
Simple Network Management Protocol7-1



Index  9-3

community strings 3-14
SNMP 7-1
SNMP. See Simple Network Management

Protocol
Submap

description of 4-6
hierarchy of uEMS 4-6
menu

pop-up 4-6
pop-up, common selections5-7
pop-up, opening 5-6
pull-down 4-5

menu bar 4-4
name 4-4
navigation chart 1-6
shortcuts, adding5-9
shortcuts, deleting5-10
status bar 4-5
tool bar 4-5

submap screen4-4
Symbol

alert bubbles 4-30
annotation text 4-30

uEMS 4-26
alert bubbles 4-30
annotation text 4-30
ISO states 4-30
symbol colors 4-27

U
UDP 7-1
UE9000

Alarm Browser 4-20
UE9000 element management system

Alarm Browser 4-20
at command 2-33
bulk provisioning 2-29
command line, getting help2-6
commands

ovstart 3-10, 3-11
ovstop 3-11

database 3-7
backing up 3-10
monitoring partition sizes3-8
restoring 3-10

dialog box 4-2
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Event Categories window4-18
status of UE9000 equipment4-2

DS3 facility 1-39
network element 1-24
ATMIF 4-11, 4-15
Circuit 4-14, 4-15
colors 4-27

ISO states 4-30
CPE 4-15
DS1 Link 4-13
DS3 Link 4-13
Line Card 4-11, 4-15
NE 4-9
Shelf 4-10
uEMS 4-2

T
Troubleshooting

alarms 4-20
events

Event Categories window4-18
events

Event Categories window4-18
severity 4-27

GUI 4-3
HSTP-Name 2-5
keyboard shortcuts4-5
map 4-6
map, opening 1-82
menu 4-2
network name 2-5
provisioning 1-4

ADSL line card 1-43
ADSL subscriber circuit 1-46
ATM core card 1-31
DS1 facility 1-37
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DS1 Link 4-13
DS3 Link 4-13
HSTP-Network 4-8
Internet 4-8
Line Card 4-11, 4-15
NE 4-9
Shelf 4-10
ubleshooting 4-26
alert bubbles 4-30
annotation text 4-30
ISO states 4-30
symbol colors 4-27

NIX scripts, scheduling 2-33
grading 3-12

sual indicators 4-26
000 shelf
ovisioning 1-27
000nvStoreMIBs 7-19
S GUI
ol bar 1-5
rade
M core card software3-2, 3-4

ircuit card software 3-2
ading software on workstation3-3
ftware upgrade process3-2

E9000 software 3-4
MS software 3-12
SL MLC software 3-2

rading the circuit card software3-2
 Datagram Protocol7-1
 interface
POV
installing desktop icon 5-4
HSTP-Network 4-9
illustration 4-4
LC 4-14
menu bar 4-4
menu, opening pop-up5-6
menu, pop-up 4-6
menu, pull-down 4-5
name 4-4
NE 4-10
permissions, read-write4-5
pop-up menu common selections5-7
Root 4-8
Shelf 4-11
shortcuts, adding5-9
shortcuts, deleting5-10
status bar 4-5
Subscriber Loop 4-15

pr
UE9
uEM

to
Upg

AT
C
lo
so
U
uE
xD

Upg
User
User

H

service descriptor1-16, 1-18
service descriptor group1-7, 1-12
shelf 1-27
updating information 1-58
virtual paths 1-13

screen 4-4
searching 5-8
service descriptor

viewing 1-81
software upgrade

loading software on workstation3-3
starting 5-2, 2, 3
status 4-26
submap 4-6

Atmif 4-12
description of 4-6

tro

U
up
vi

UE9
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tool bar 4-5
submaps

shortcut, adding 5-9
shortcut, deleting 5-10

symbol 4-2
ATMIF 4-11, 4-15
Circuit 4-14, 4-15
CPE 4-15

removing desktop icon5-5
starting 5-2, 2, 3

UE9000
searching 5-8

uEMS 4-4
at command 2-33
bulk provisioning 2-29
command line, getting help2-6
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GUI 4-3
map, opening 1-82
screen 4-4
shortcut, adding 5-9
shortcut, deleting 5-10
starting 5-2, 2, 3
UNIX scripts, scheduling 2-33

V
Virtual path identifier, provisioning1-16, 1-18
Virtual path, provisioning 1-13
VP. See Virtual path
VPI. See Virtual path identifier
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